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2����%� GENTRAN:Director  for Windows  provides you with the tools you need 
to electronically exchange data with your trading partners. These tool 
include the following:

! Data translation
! Process control
! Communications system 
We believe that you will find this software, and its supporting materials, easy 
to use and beneficial to your business.
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(��
�������� This manual supports the online Help by assisting you with various tasks in 
GENTRAN:Director. This task-oriented approach provides step-by-step 
instructions to answer any questions you might have about 
GENTRAN:Director.

(�������
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This manual is intended for the staff responsible for the following:

! Implementing EDI
! Setting up trading partner relationships
! Creating and using EDI documents
! Sending and receiving documents
! Acknowledging documents
! Tracking document flow
! Using accum tracking

!
�
�4������
+��,�����

This manual assumes that you are familiar with using a PC and with 
Microsoft® Windows functions.
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The following typeface conventions are used in this manual:

Sending a Document This typeface is used for emphasis or to indicate a 
chapter or section in this manual.

NEW This typeface indicates a button in the program. 
Click the button with your mouse, or press TAB 
until the button is highlighted, and then press 
ENTER.

F1 This typeface indicates a key that you need to press 
on your keyboard. A plus sign (+) between key 
names indicates a combination of keys to be 
pressed together. For example, CTRL + C.

$���
��������6
��������

The User�s Guide is organized into chapters. A brief description of each 
chapter is outlined below. 

! Chapter 1, Getting Started explains the content, organization, and 
conventions in this manual. This chapter also describes how to get 
technical support, and provides an introduction to EDI and 
GENTRAN:Director for Windows.

! Chapter 2, Using Translation Objects explains how to register (install), 
delete, and view translation objects.

! Chapter 3, Using Partners explains how to set up a complete partner 
profile. This chapter describes how to import or export a partner profile 
and partner tables, and describes how to copy a partner profile.

! Chapter 4, Using Documents explains all the facets of managing your 
documents.

! Chapter 5, Using Communications explains how to send, receive, and 
resend documents, and how to view the Send Queue.

! Chapter 6, Using Interchanges explains how to view interchanges and 
the documents within interchanges, how to filter the display of 
interchanges, and how to attach (link) an interchange to a partner.

! Chapter 7, Using Acknowledgements explains how to manually set a 
document to �acknowledged,� and how to define inbound and outbound 
acknowledgement criteria for document reconciliation.

! Chapter 8, Using the Tracking and Audit Systems explains how to view 
and print document tracking and audit log information.

! Chapter 9, Using the Accum Tracking Extension defines the Accum 
Tracking Extension and explains how to use accum tracking.
� � % ���������������������������������������������������������������������	
��
�
���
��	���������
�����	��



��������������� 2	
�3������	��� 
��
�
! Chapter 10, Daily Processing describes an example of the operational 
activities that may be executed as part of your daily processing.

! The Glossary contains definitions of EDI and GENTRAN:Director 
terms and concepts.

! The Index provides you with a page listing of terms, concepts, 
functions, and processes to enable you to quickly find them in this 
manual.

�������7���
�.���%

The majority of the documentation for GENTRAN:Director is contained in 
the online Help system. This includes dialog box element definitions, 
detailed processing information, and all the how to information that is 
contained in this manual.
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(��
�������� Sterling Commerce�s GENTRAN:Director software is supported by trained 
customer support personnel who are available to help you with product 
questions or concerns.

0�%
���
��
��� If you have questions or concerns with your software, you can send an 
e-mail to Sterling Commerce Customer Support at the following address: 
customer_support@stercomm.com. 

!	������%��
 For assistance, refer to the Getting Started Guide to determine which support 
phone number you should use.

8�6�
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To help us provide prompt service, we ask that you do the following before 
calling Customer Support:

! Attempt to recreate any problem that you encounter and record the exact 
sequence of events. 

! Be prepared to provide us with the following information:

1. Mailbox number:
A mailbox number is assigned to customers who have a mailbox on 
the Sterling Commerce network.

2. System Configuration
Information about the primary system controller and all machines 
experiencing problems, including the computer manufacturer and 
model number, Windows version, amount of memory, available 
disk space, and the network adapter type.

3. Error Messages 
Record the exact wording of any error messages you receive and 
where the error occurred in the software.

4. Attempted Solutions 
Record any steps you performed to resolve the problem and note all 
the outcomes.
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The Support on Demand Web site provides access to tools that allow you to 
gain up-to-the-minute information specific to your company. It also allows 
you to access additional tools for troubleshooting or getting assistance and 
information about your Sterling Commerce software.

The following table discusses the features offered by the Support on 
Demand Web site.

Feature Description

Personal Profile ! Lists your personal profile and allows you to 
modify your profile information.

! Allows you to change your Support on 
Demand password

Problem Reports Provides detail about all technical support cases 
reported in the last 30 days.

Report a Case Enables you to submit a technical support 
request for any problem or error that you might 
be experiencing with the product (s).

Knowledge Base Enables you to troubleshoot problems and error 
messages.

Solution Subscriber Allows you to register your e-mail address in 
order to receive notifications about solution-
specific issues.

Educational Services Allows you to view course descriptions and 
register online for training provided by the 
Sterling Commerce Educational Services team.
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To access Support on Demand, complete the following steps: 

1. Open your Internet browser.

2. On the address line, type: www.sterlingcommerce.com.

The Sterling Commerce home page is displayed.

3. In the Customer Support section located near the center of the page, 
select Support on Demand.

The Support On Demand login page is displayed.

4. Do one of the following:

! If you would like to register to use the Support on Demand 
Web site, click the link under New to the Site? After 
completing registration, a user name and password is assigned 
and sent to your e-mail address. The e-mail is sent to you from 
vantive_admin@stercomm.com.

! If you do not want to register, but would like to demo the 
Support on Demand Web site, click Site Demo to log in as a 
guest user.

5. Log in to the site using your user name and password.

The Support on Demand home page appears, displaying your user 
profile and any problems you have reported.
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�5�
5��, Electronic Data Interchange (EDI) is the paperless exchange of data between 
business partners in a standardized, computer-processible format. This 
business data includes invoices, purchase orders, and advance shipping 
notices.

In today�s fast-paced business environment, EDI is a necessity. This need is 
driven by just-in-time (JIT) manufacturing schedules, customer-service 
demands, �partnering� with another company or sharing information 
systems, increasingly competitive business environments, and the need to 
establish and maintain the competitive advantage.

������0$( The key to EDI is standardized data. EDI extracts information from your 
application and converts it into a standardized format that can be transmitted 
to your business partner. Transmitting information between two computer 
systems requires that the data and its format be expected, meaning it is an 
established format. Non-standard data or formats can introduce errors and 
confusion.

EDI standards regulate the syntax, structure, and content of the transaction 
data. EDI translators convert the data from your application format to a 
standard format such as ANSI X12, TDCC, VICS, EDIFACT, or 
TRADACOMS. At the receiving end, the standard format allows your 
trading partner�s computer system to read the data so it can be automatically 
processed and interfaced with their internal applications. 

The entire process can be accomplished in minutes, without the rekeying 
involved with manual document processing.

Continued on next page
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The following diagram illustrates the EDI process:
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EDI structure can be divided into the following levels: 

! Envelopes
! Transaction sets (documents) 
! Segments
! Elements

!�
�	
�����

*�����
����

*�����
�����

9��+

:
����*����

;��,�
+

0$(��

���
��


�
��
�0��
.�

*�����
����

*�����
�����

9��+

0$(��

���
��


<�.

0��
.

��%%����
���� ��%%����
����
� � �- ���������������������������������������������������������������������	
��
�
���
��	���������
�����	��



��������������� (��
��������0����
�����$
�
�(���
�	
���
$�
�

% The following figure illustrates the enveloping and EDI structure.
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0�5������ EDI envelopes function in the same way as paper envelopes. They separate 
different types of data and carry address information. Each envelope 
contains a header segment and a trailer segment. These segments separate 
the envelope from other envelopes and provide information about the 
contents of the envelope.

The three levels of envelopes are as follows:

(���
�	
���

Interchange is the outermost level of the envelope structure, and contains all 
the data sent from one sender to one receiver in the same transmission. 

=�������
���
���

Functional group is the next level of envelope structure, and is contained 
inside the interchange. The functional group surrounds a group of 
transaction sets of the same type. 

�

��
���������

Transaction sets are the final level of enveloping inside the functional group. 

�

��
���������� Transaction sets represent the paper documents that EDI replaces. For 
example, a purchase order corresponds to a transaction set. The standards 
define each transaction set in terms of the segments and elements that make 
up the document, the order in which they appear, and the relationships 
among them. Transaction sets are known as �messages� in Europe.

���%���� Segments are like sentences, and they are equivalent to the records in your 
application file. In the structure of EDI, the segments are groups of data 
elements that combine to communicate useful data. For example, a single 
data element may contain the number �4.� Though meaningless by itself, in 
the proper place in a segment, �4� indicates quantity.
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0��%���� Elements are the smallest piece of usable information defined by the 
standards, including a quantity, unit price, or description. An individual 
element can have different meanings depending on context, and therefore are 
normally not considered to have useful meaning until they are combined into 
segments. 
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�5�
5��, GENTRAN:Director for Windows is a combined system made up of data 
translation, process control, and communication. It is designed primarily for 
the translation and communication of EDI, and other similar types of data.

!
����������
�� Through the process control system, you can integrate GENTRAN:Director 
with a wide variety of business applications. It acts as an extension of the 
application, rather than a cumbersome add-on.

GENTRAN:Director also operates in an unattended mode. Audit trails and 
message tracking enable you to know precisely where a message is in the 
process, at any time.

�0;�"*;
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GENTRAN:Director uses the GENTRAN Director Service, which controls 
the execution of communication and translation functions.

$
�
�
�� The database is the Microsoft Access relational database that 
GENTRAN:Director uses to store system data. The database tables contain 
indicators that point to actual data located in the system data store. The 
system data store is the repository of all shared GENTRAN:Director data. 
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The four main components of the GENTRAN:Director user interface are 
listed in the following table:

��%������ $���
������

Electronic Commerce (EC) 
Manager

A data management component that serves as a high-level 
navigation tool and document management tool. It contains 
many windows, browsers, and dialog boxes for viewing and 
maintaining documents, interchange, audit, reporting, process 
control, communications, and translation object information.

The EC Manager also provides access to the Partner Editor and 
Document Editor.

Partner Editor Allows you to define, edit, and delete all partner information 
for your company and for your trading partners.

Document Editor A data entry tool that allows you to create, modify, and view 
documents.

System Configuration Enables you to modify system-wide configuration parameters 
after GENTRAN:Director is installed, including the following:
! System directories
! System import specifications
! Splitter options 
! Users
! Stop and start the GENTRAN Director service
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��%������� The following table lists additional components that can be purchased. These 

components can be accessed through the EC Manager:

��%������ $���
������

Application Integration Enables you to generate import, export, and 
document turnaround translation objects.

Note
When the Application Integration translation 
objects are registered with 
GENTRAN:Director and selected as part of a 
trading relationship, they allow you to do the 
following:
! Outbound mapping - translate your 

application files to EDI standard formats 
for documents that you send your 
partners. 

! Inbound mapping - translate EDI 
standard formats to your application 
format for documents that you receive 
from your partners.

Forms Integration Enables you to generate screen entry and 
print translation objects.

Note
When the Forms Integration translation 
objects are registered with 
GENTRAN:Director and selected as part of a 
trading relationship, they allow you to 
facilitate the keying and printing of EDI 
documents that you send or receive.

Accum Tracking Extension Enables you to do the following:
! Define and maintain trackable items
! Maintain the associated counts
! Report on trackable items

Continued on next page
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EDI message standards

The Integration components also allow you to access EDI message standards 
to use for creating new translation objects. The EDI message standards files 
can be accessed from Compact Disc (CD) or transferred to a hard drive on 
your machine.

Transaction Data File (TDF) 
Integration

Enables you to do the following:
! Create an import or export translation 

object so you can use TDF with 
GENTRAN:Director. TDF is a flat file 
representation of an EDI standard 
document.

! Print a detailed report of the TDF layout 
of any EDI standard.
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�5�
5��, You can access functionality on the GENTRAN:Director EC Manager 
window in the following ways:

! Clicking a menu option from the Main Menu Bar
! Clicking a button on the Main Toolbar
! Clicking a on the Browser Toolbar
! Clicking a part of The Desk
! Clicking a button within the chosen browser window
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���,����, The GENTRAN:Director EC Manager window is displayed as follows:
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��%������� The main components of the GENTRAN:Director window include the 
following:

! Control menu
! Title bar
! Minimize and maximize buttons
! Main menu bar
! Main toolbar
! Browser toolbar
! The Desk
! Status bar

����
���%���

The Control Menu contains the following commands: Restore, Move, Size, 
Minimize, Maximize, and Close.

�������



The Title Bar contains the name of the application. Clicking on the title bar 
and dragging allows you to move the GENTRAN:Director EC Manager 
window on your desktop.

 ���%�A�B 
1�%�A���������

The Minimize button reduces the window to an icon. The Maximize button 
enlarges the window to its maximum size.
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The Main Menu Bar contains the drop-down menus. Unavailable items are 
dimmed. For a detailed description of the commands contained in each 
menu, refer to the online Help. 
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The Main Toolbar provides access to some of the most common browsers 
and functions in GENTRAN:Director. Unavailable items are dimmed. The 
Main Toolbar is illustrated below:
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The Browser Toolbar provides access to functions that are available from 
browsers in GENTRAN:Director. Unavailable items are dimmed. The 
Browser Toolbar is illustrated below:

.������'��
�

�
-�/"��

0.������'��
�

.���
"��


1�
�����'��
�

01�
�����'��
�

1�
��
"��


.�
�
�,"� ��

2����

���	
�3� 

!����"�� 4
�����

#$���

����	5�

4
�����	� 

!���
�
"��$"
	��

#���	 �
"
	��

�//$	�"
	��
.�
� 
"
	��

.�
� 
"
	��
6�
'�

#��

�$

!7�
�'

1+8��
 4"

��

�	("
�

����'��
"�-	� 

.'/�



��$�
�
�*/�



4
	�


�	��

#�/7

#�/7

%�5��
�

4��


���/���

!�

)6	$
�


�

"�,

�
"��$"
�
���/�



�"
"

��-���$�� �

��  $�
.�
�
�,"� �
!
"
��

���

1/��

����'��


.���
"��

���������	
��
�
���
��	���������
�����	�� ��������� � � ��



;
5��
������0;�"*;@$�
����
 ���������������
�	��$��+

The Desk is a graphical representation of the GENTRAN:Director 
components and document locations. It provides you with a quick and easy 
way to access some of the most commonly used browsers, functions, and 
subsystems of GENTRAN:Director. Click the appropriate part of The Desk 
any time you need to access a browser, function, or subsystem represented 
on The Desk.

Some of the browser icons display a graphical representation of paper if the 
document location contains documents. The Desk also allows you to access 
the Partner Editor subsystem, the online Help system, the Process Control 
function (clock icon), and the Send/Receive functions (phone icon). Click 
the Exit/Door icon to quit GENTRAN:Director.

��
�����



The Status Bar does the following:

! Displays status information about a selection, command, or process.
! Defines menu items as you highlight each item in the menu.
! Indicates any current keyboard-initiated modes for typing. For example, 

CAP is used to represent the �Caps Lock� key, and NUM for the �Num 
Lock� key.
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 This chapter describes how to use translation objects with 
GENTRAN:Director.

�
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����
���������6�������

A translation object is a set of definitions, links, and rules that combine to 
provide the translator with all the information necessary to convert data from 
one format to another. Translation objects are used in GENTRAN:Director 
to control the processing of the translator subsystem.

�
�
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�
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Translation objects are created by compiling an application map or a form 
definition using the Application or Forms Integration subsystem in 
GENTRAN:Director. For more information, see the Application Integration 
User�s Guide and Forms Integration User�s Guide.

�.�����6
�
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There are two types of translation objects: system translation objects and 
user translation objects.

�.���%��

���
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System translation objects control the creation and separation of 
interchanges, functional groups, and transaction sets. They are also used to 
generate and reconcile functional acknowledgments. All the required system 
translation objects are automatically installed with the GENTRAN:Director 
system.

���
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User translation objects control screen entry, importing, exporting, and 
creating printed reports. 
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(��
�������� The Register Translation Object function enables you to register your 
translation object file with GENTRAN:Director so the system can use the 
translation object to translate data.

!
�����
� To register a translation object, complete the following steps:

���� *�����

1 From the View menu, select TRANSLATION OBJECTS.

System Response
The EDI Translation Objects browser is displayed.

Continued on next page
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2 Click NEW.

System Response
The Register Translation Object dialog box is displayed.

3 Select the translation object file that you want to register 
with the system from the list, or type it in the File name box.

Note
To highlight a group of translation objects, click on the first 
translation object, press the SHIFT key, and then click on 
the last translation object in the group. To highlight several 
translation objects that are not adjacent to each other, press 
and hold the CTRL key while clicking on each translation 
object.

4 Click OPEN.

System Response
The translation object files are registered and the Register 
Translation Object dialog box is closed.

Notes
! If the selected file is invalid, you receive a warning 

message. Only valid GENTRAN:Director translation 
object files can be installed.

! If the translation object is a duplicate, you are prompted 
with a message asking whether or not you want to 
overwrite the existing translation object.
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(��
�������� You can delete old or unused translation objects from the system only if they 
are not currently associated with an Inbound or Outbound Partner 
Relationship. Translations objects shown with �No� in the Used column are 
not associated. The system also prevents you from deleting translation 
objects that are designated as �system translation objects.� These are shown 
as �SYS*� or �SYS.�

!
�����
� To delete a translation object, complete the following steps:

���� *�����

1 From the View menu, select Translation Objects.

System Response
The EDI Translation Objects browser is displayed.

2 Select the translation object or objects you want to delete.

3 Click DELETE.

System Response
The Delete confirmation dialog box is displayed.

Continued on next page
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4 Click YES to confirm the deletion.
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Sorting Translation Objects

�5�
5��, You can use the Sort function on the EDI Translation Objects dialog box to 
arrange the columns of the translation objects into one of the following 
sequences:

! Group by Type - Sorts the translation objects alphabetically by type
! Sort by Description - Sorts the translation objects alphabetically by 

description

!
�����
� To sort translation objects, complete the following steps:

���� *�����

1 From the View menu, select Translation Objects.

System Response
The EDI Translation Objects browser is displayed.

Continued on next page
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2 Click SORT.

System Response
The Sort Translation Objects dialog box is displayed.

3 Click the radio button for the appropriate sort order.

4 Deselect the Hide System Templates check box to display 
system translation objects. The system translation objects are 
hidden by default.

5 Click OK to sort the list of translation object(s) into the 
specified sort order.
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 This chapter describes the following tasks for creating and maintaining 
partner relationships:

! Defining partner defaults
! Using the Partner Wizard
! Setting up partner profiles
! Routing partner profiles
! Using partner tables 
! Using partner locations
Partner relationships are based on how you and your trading partner 
exchange EDI data. GENTRAN:Director enables you to install custom data 
to simplify the process. To create partner relationships, two tools are 
provided: the Partner Wizard and Partner Editor.

C���+�!

���
 The Quick Partner function enables you to establish default values to be used 
when adding new partner profiles or relationships using the Partner Wizard 
or Partner Editor. This function significantly simplifies and quickens the 
creation of partner profiles and relationships.

!

���
�2�A

� The Partner Wizard is an easy-to-use method for adding new partners and 
new partner relationships to the system, and is designed for the novice EDI 
user. This tool walks you through the creation of new partner profiles, 
inbound relationships, and outbound relationships. Partner Wizard also 
automatically creates the appropriate acknowledgment for inbound and 
outbound documents.

!

���
�0����
 Partner relationships allow you to send and receive data to and from your 
trading partners.The Partner Editor allows you to define, edit, and delete all 
partner relationship information for your company and your trading partners. 

The Partner Editor also allows you to use an internal system partner 
(<Internal System User>) to define your company to the system.
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(��
�������� You can set up your partner profiles by using one of  three methods: 
importing, copying, or creating them yourself. The method you use depends 
on whether you have a partner profile to use as a starting point. Use the 
following table to decide which method to use:

!
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Import existing profile Use this method if you receive partner profiles 
from Sterling Commerce or if you have an 
existing profile from which you can import 
partner details. The profile can be exported 
from another copy of the GENTRAN:Director 
system.

Reference
For more information, see Importing a Partner 
Profile on page 3 - 59.

Copy existing profile Use this method when you have an existing 
profile that you can copy. You must then enter a 
unique partner definition and key enveloping 
information for the copied partner.

Reference
For more information, see Copying a Partner 
Profile on page 3 - 64.

Create a new profile Use this method when you do not have a profile 
to import or copy.

Reference
 For more information on how to create a new 
partner profile, see Defining a partner profile 
on page 3 - 5.
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���
���6������� A partner profile begins with a partner definition. The partner definition 
contains the basic information about a partner that the system needs before 
you can define the rest of the partner profile.

;���

You need to create a partner definition for each partner with whom you are 
going to exchange data.

!

���
��
�6��� To complete the partner profile, you need to define an inbound or outbound 
relationship, or both.

! If you are receiving and processing information from this trading 
partner, you need to define an inbound relationship.

! If you are sending information to this trading partner, you need to define 
an outbound relationship.

;���

You need to create a partner profile for each partner with whom you are 
going to exchange data.
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The following table describes the process for creating a partner profile.

��
�� $���
������

1 Define default values that will be used each time you create a new partner relationship.

Note
You define partner defaults one time only.

Reference
For more information, see Using Quick Partner to Define Defaults on page 3 - 6.

2 Use this table to determine the next stage.

(=�.������������� �70;�������

! create a basic partner definition
! create an inbound relationship
! create an outbound relationship

the Partner Wizard

Reference
For more information, see Using the Partner 
Wizard on page 3 - 25.

! modify existing partner profiles
! modify existing partner 

relationships
! use partner tables
! use partner locations
! set up advanced options such as 

control numbers or 
acknowledgment options

the Partner Editor

Reference
For more information, see the appropriate 
section:
! Editing or Deleting a Partner Definition on 

page 3 - 56
! Setting Up Partner Profiles on page 3 - 3
! Using Partner Locations on page 3 - 84

3 Do you need to use a cross-reference or lookup table with the partner relationship in 
order to supplement or convert data entered or received inbound?
! If yes, see Creating a Table on page 3 - 68 for more information.
! If no, continue with stage 4.

4 Do you need to use locations to contain address and contact-related information about 
the partner?
! If yes, see Creating Partner Locations on page 3 - 85 for more information.
! If no, you have completed the partner profile definition process.
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(��
�������� The Quick Partner function enables you to establish default values that are 
used when adding new partner profiles or relationships with the Partner 
Wizard. These values will not affect existing partner profiles or 
relationships.

"���%%���
����

Use this function prior to setting up partner profiles and significantly 
simplify and quicken the creation of partner profiles and relationships.
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There are three defaults sets of values you can establish with the Quick 
Partner Defaults dialog box:

! Sender ID enables you to set up default sender ID values for outbound 
data.

! Inbound enables you to set up default values for inbound relationships. 
! Outbound enables you to set up default values for outbound 

relationships.
You can complete default values for any one of these sections, or for all 
three.
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To access the Quick Partner Defaults dialog box:

1. From the Tools menu, select Partner Editor.

2. Click DEFAULTS.

The Quick Partner Defaults dialog box is displayed.

!

���
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The following table lists the parts of the Quick Partner Defaults dialog box 
and their functions:

!

� =�������

SENDER ID Accesses the Quick Partner Sender ID Setup 
dialog box.

INBOUND Accesses the Quick Partner Inbound 
Defaults dialog box.

OUTBOUND Accesses the Quick Partner Outbound 
Defaults dialog box.

CLOSE Exits the Quick Partner Defaults dialog box.
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The Quick Partner Sender ID Setup dialog box enables you to set up default 
sender ID values for outbound data.

*����������	����
������1

From the Quick Partner Defaults dialog box, click SENDER ID. The Quick 
Partner Sender ID Setup dialog box is displayed.

!
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���6��������

The following table lists the parts of the Quick Partner Sender ID Setup 
dialog box and their functions:

!

� =�������

Group Sender ID Identifies your company in outgoing groups 
(as defined by the standards).

Group Qualifier Qualifies the group Sender ID (as defined by 
the standards).

Note
Used with EDIFACT and ODETTE 
standards only.

Interchange Sender ID The value that identifies your company in 
outgoing interchanges (as defined by the 
standards).

Interchange Qualifier Qualifies the interchange Sender ID (as 
defined by the standards).

Continued on next page
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The Quick Partner Inbound Defaults dialog box enables you to set up default 
values for inbound relationships.

*����������	����
������1

From the Quick Partner Defaults dialog box, click INBOUND.The Quick 
Partner Inbound Defaults dialog box is displayed.

Continued on next page

OK Saves the values and closes the Sender ID 
Setup dialog box.

CANCEL Closes the Sender ID Setup dialog box 
without saving values.

HELP Accesses context-sensitive help on the 
Sender ID Setup dialog box.

!
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The Quick Partner Inbound Defaults dialog box has a tab for each EDI 
standard. The options that are available on each tab are determined by the 
EDI standard. If an option is unavailable, it is not required by that standard.

The following table lists the parts of the Quick Partner Inbound Defaults 
dialog box and their functions:

!

� =�������

Transaction Sequence 
Checking option

Instructs the system whether to expect a functional acknowledgment 
from your trading partner.

Note
When you are setting up sequence checking options, note that if the 
system detects duplicate control numbers, or detects incremental or 
chronological control numbers that are out of sequence, those 
documents are located in ?In Documents.

Values
! None - Sequence checking will not be used.
! Duplicate - Check for duplicate control numbers.
! Incremental -The control number must be one greater than the last 

number.
! Chronological - The control number must be greater than the last 

number.

Note
These options are disabled if Sequence From Group is selected.

Sequence from Group Indicates whether the transaction set control numbering options for this 
group setup should be controlled at the group level.

Incremental or 
Chronological option

Specifies how you want sequence checking to be used.

Values
! Incremental - The control number must be one greater than the last 

number.
! Chronological - The control number must be greater than the last 

number.

Note
These options are disabled if Sequence from Group is not selected.

Continued on next page
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Format Indicates the format of the transaction set control number that the 
system will generate.

Values
Normal The number is generated by incrementing the last used 

control number. The length of the number is defined by the 
standard.

6/3 The number is a composite of two numbers. The first six 
digits are the last six digits of the functional group control 
number. The last three digits are a counter beginning at �1� 
within the functional group. Use this format only as 
instructed by your trading partner.

5/4 The number is a composite of two numbers. The first five 
digits are the last five digits of the functional group control 
number. The last four digits are a counter beginning at �1� 
within the functional group. This is the normal TDCC 
numbering convention. It is used by the Motor, Rail, and 
Ocean transportation industries.

5/3 The number is a composite of two numbers. The first five 
digits are the last five digits of the functional group control 
number. The last three digits are a counter beginning at �1� 
within the functional group. This is the normal UCS 
convention, which is used by the Grocery and Warehousing 
industries.

Note
This list is disabled if Sequence from Group is not selected.

Reject Duplicate 
Documents

Instructs the system to check for duplicate document names, and then 
reject those documents.

Group Sequence 
Checking option

Indicates how the system should sequence check groups.

Values
! None - Sequence checking will not be used.
! Duplicate - Check for duplicate control numbers.
! Incremental -The control number must be one greater than the last 

number.
! Chronological -The control number must be greater than the last 

number.

Continued on next page
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Transaction Sequence 
Checking option

Indicates how the system should sequence check interchanges.

Values
! None - Sequence checking will not be used.
! Duplicate - Check for duplicate control numbers.
! Incremental - The control number must be one greater than the last 

number.
! Chronological - The control number must be greater than the last 

number.

Acknowledge 
Transactions option

Instructs the system to generate a functional acknowledgment to this 
trading partner when you receive the transaction set defined in this 
relationship.

Values
! No - Do NOT generate acknowledgments
! Yes - No Error Detail - Generate acknowledgments without error 

detail
! Yes - With Error Detail - Generate acknowledgments with error 

detail 

Acknowledge Group 
option

Instructs the system to generate a functional acknowledgment to this 
trading partner when you receive the group defined in this relationship.

Acknowledge 
Interchange option

Instructs the system to generate a functional acknowledgment to this 
trading partner when you receive the interchange defined in this 
relationship.

OK Saves the values and exits the Inbound Defaults dialog box.

CANCEL Exits the Inbound Defaults dialog box without saving values.

HELP Accesses context-sensitive help on the Inbound Defaults dialog box.

�>�����?

!

� =�������
� � �� ���������������������������������������������������������������������	
��
�
���
��	���������
�����	��



#�������������������
�$�����" �(" ������C���+�!

���
����$�6����$�6
����
��������
$�6
�������
���

��1
The Quick Partner Outbound Defaults dialog box enables you to set up 
default values for Outbound relationships.

*����������	����
������1

From the Quick Partner Defaults dialog box, click OUTBOUND.The Quick 
Partner Outbound Defaults dialog box is displayed.
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The Quick Partner Outbound Defaults dialog box has a tab for each EDI 
standard. The options available on each tab are determined by the EDI 
standard. If an option is unavailable, it is not required by that standard.

The following table lists the parts of the Quick Partner Outbound Defaults 
dialog box and their functions:

!

� =�������

Transaction 
Acknowledgment option

Instructs the system to expect an acknowledgment from your trading 
partner when they receive the transaction set defined for the 
relationship.

Hours Overdue 
(transaction)

Defines how many hours must elapse before the expected 
acknowledgment is considered overdue.

Note
The default value for the Hours Overdue box is �48�, indicating that the 
acknowledgment is considered overdue in two days. If you enter a value 
of �0� (zero), the acknowledgment is immediately considered overdue.

Reject Duplicates Instructs the system to check for duplicate document names, and then 
reject those documents.

Group Acknowledgment 
option

Instructs the system to expect an acknowledgment from your trading 
partner when they receive the group defined for the relationship.

Hours Overdue (group) Defines how many hours must elapse before the expected 
acknowledgment is considered overdue.

Interchange 
Acknowledgment option

Instructs the system to expect an acknowledgment from your trading 
partner when they receive the interchange defined for the relationship.

Hours Overdue 
(interchange)

Defines how many hours must elapse before the expected 
acknowledgment is considered overdue.

Sequence From Group Instructs the system to manage transaction set control numbering 
options at the group level.

Continued on next page
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Format Defines the format of the transaction set control number that the system 
generates.

Values
Normal The number is generated by incrementing the last used 

control number. The length of the number is defined by the 
standard.

6/3 The number is a composite of two numbers. The first six 
digits are the last six digits of the functional group control 
number. The last three digits are a counter beginning at �1� 
within the functional group. Use this format only as 
instructed by your trading partner.

5/4 The number is a composite of two numbers. The first five 
digits are the last five digits of the functional group control 
number. The last four digits are a counter beginning at �1� 
within the functional group. This is the normal TDCC 
numbering convention. It is used by the Motor, Rail, and 
Ocean transportation industries.

5/3 The number is a composite of two numbers. The first five 
digits are the last five digits of the functional group control 
number. The last three digits are a counter beginning at �1� 
within the functional group. This is the normal UCS 
convention, which is used by the Grocery and Warehousing 
industries.

OK Saves the values and closes the Outbound Defaults dialog box.

CANCEL Closes the Outbound Defaults dialog box without saving values.

HELP Accesses context-sensitive help on the Outbound Defaults dialog box.
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��6�������� If you set defaults for an outbound relationship, you also need to specify 

enveloping defaults. The envelope you use depends on the EDI standard. 
The following table lists the EDI standards and their corresponding envelope 
options.

0$(���
��

� 0�5������.������

ANSI ISA or ICS

EDIFACT UNA

ODETTE UNA

TDCC ISA or BG

TRADACOMS SCH

UCS ISA or BG

VICS ISA or ICS
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The envelope options that you must specify depend on which envelope you 
are using. The following table defines all GENTRAN:Director envelope 
options. Refer to the table when completing the envelope information for 
outbound relationships.

0�5������������ $�6�������

Element Separator Defines the value that separates elements in an outbound data segment. 
This box is mandatory. The value MUST be between HEX �01� and 
HEX �FF�. 

Do one of the following:
! In the first box, type the special character (*, ^, etc.). The system 

converts and enters the hex value for that character in the second 
box.

! In the second box, type the hex value. The system converts and 
enters the special character for that hex value in the first box. If there 
is no printable character that corresponds to the hex value, the 
character box is blank.

.

Sub-Element Separator Defines the value that will separate the parts of an outbound element. 
This box is mandatory and the value MUST be between HEX �01� and 
HEX �FF�.

 Do one of the following:
! In the first box, type the special character (*, ^, etc.). The system 

converts and enters the hex value for that character in the second 
box.

! In the second box, type the hex value. The system converts and 
enters the special character for that hex value in the first box. If there 
is no printable character that corresponds to the hex value, the 
character box is blank.

Continued on next page
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Segment Terminator Defines the value that identifies the end of an outbound data segment. 
This box is mandatory. The value MUST be between HEX �01� and 
HEX �FF�. 

Do one of the following:
! In the first box, type a special character. The system converts and 

enters the hex value for that character in the second box.
! In the second box, type the hex value. The system converts and 

enters the special character for that hex value in the first box. If there 
is no printable character that corresponds to the hex value, the 
character box is blank.

Acknowledgment 
Requested

Instructs the system to require an acknowledgment for the outbound 
interchange.

Send UNA Segment Instructs the system to send the UNA segment.

Component Element 
Separator

Defines the value that separates the parts of an outbound element. This 
box is mandatory. The value MUST be between HEX �01� and HEX 
�FF�. 

Do one of the following:
! In the first box, type the special character. The system converts and 

enters the hex value for that character in the second box.
! In the second box, type the hex value. The system converts and 

enters the special character for that hex value in the first box. If there 
is no printable character that corresponds to the hex value, the 
character box is blank.

Decimal Notation Defines either a comma (�,�) or a period (�.�) to indicate the decimal 
point in a numeric box. This box is mandatory.

Recommendation
The character (�.�) is recommended.

Release Indicator Defines a character that restores any character, used as a syntactical 
separator, to its original meaning. This box is mandatory.

Send SCH Segment When selected, the system sends the SCH segment.

Sender ID Name Defines your name as it will appear on the interchange header segment 
sent to this Trading Partner.

Continued on next page
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Segment Code Separator Defines the value that separates segment codes. This box is mandatory. 
The value MUST be between HEX �01� and HEX �FF�. 

Do one of the following:
! In the first box, type the special character. The system will convert 

and enter the hex value for that character in the second box.
! In the second box, type the hex value, and the system will convert 

and enter the special character for that hex value in the first box. If 
there is no printable character that corresponds to the hex value, the 
character box is blank.
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� To use Quick Partner to define defaults, complete the following steps:
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1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 Click DEFAULTS.

System Response
The Quick Partner Default dialog box is displayed.

����������6
����5
�����6�
������
�($�

1 Click SENDER ID.

System Response
The Quick Partner Sender ID Setup dialog box is displayed.

2 Complete the Group and Interchange Sender ID and Qualifier information.

3 Click OK.

System Response
The sender ID information is saved and the Quick Partner ID Setup dialog box is closed.

Continued on next page
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1 Click INBOUND.

System Response
The Quick Partner Inbound Defaults dialog box is displayed.

2 Select the tab for the EDI standard you are using to establish inbound partner 
relationships.

Note
The options that are available on each tab are determined by the EDI standard. If an 
options is unavailable, it is not required by that standard.

3 Do you want to control transaction set control numbering options at the group level?
! If yes, continue with steps 5 through 7.
! If no, continue with step 4.

4 In the Sequence Checking section, select an option to indicate whether the system should 
expect a functional acknowledgment from your trading partner. Continue with step 8.

5 Select Sequence from Group to indicate whether the transaction set control numbering 
options for this group setup should be controlled at the group level. Continue with step 6.

6 Select the sequence checking option that specifies how sequence checking should be 
used. Continue with step 7.

7 ! From the list in the Sequence Checking section, select the format of the transaction 
set control number that the system generates. Continue with step 8.

8 Do you want the system to check for duplicate document names and reject those 
documents?
! If yes, select the Duplicate Documents check box and continue with step 9.
! If no, continue with step 9.

9 ! In the Sequence Checking section, select how the system should sequence check 
groups. Continue with step 10.

10 ! In the Sequence Checking section, select how the system should sequence check 
interchanges. Continue with step 11.

Continued on next page
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11 Do you want the system to generate a functional acknowledgment to this trading partner 
when you receive the transaction set defined for this relationship?
! If yes, in the Acknowledgments section, select the appropriate transaction set option 

and continue with step 12.
! If no, continue with step 12.

12 Do you want the system to generate a functional acknowledgment to this trading partner 
when you receive the group defined in this relationship?
! If yes, in the Acknowledgments section, select the Yes option and continue with step 

13.
! If no, continue with step 13.

13 Do you want the system to generate a functional acknowledgment to this trading partner 
when you receive the interchange defined in this relationship?
! If yes, in the Acknowledgments section, select the Yes option and continue with step 

14.
! If no, continue with step 14.

14 Do you have additional EDI standards you need to define?
! If yes, repeat steps 2 through 13 for each additional EDI standard you are using to 

define relationships.
! If no, click OK to save the inbound relationship information and exit the Quick 

Partner Inbound Defaults dialog box.

Continued on next page
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1 Click OUTBOUND.

System Response
The Quick Partner Outbound Defaults dialog box is displayed.

2 Select the tab for the EDI standard you are using to establish outbound partner 
relationships.

3 Do you want the system to expect an acknowledgment from your trading partner when 
they receive the transaction set defined in this relationship?
! If yes, in the Sequence Checking section:

a. Select the Yes option.
b. Type how many hours must elapse before the expected acknowledgment is 

considered overdue.
c. Continue with step 4.

! If no, continue with step 4.

4 Do you want the system to check for duplicate document names and reject those 
documents?
! If yes, select the Duplicate Documents check box and continue with step 5.
! If no, continue with step 5.

Note
When you are setting up duplicate document options, the system places any duplicate 
control numbers that it detects in ?In Documents.

5 Do you want the system to expect an acknowledgment from your trading partner when 
they receive the group defined in this relationship?
! If yes, in the Sequence Checking section, select the Yes option and continue with

step 6.
! If no, continue with step 6.

6 Do you want the system to expect an acknowledgment from your trading partner when 
they receive the interchange defined in this relationship?
! If yes, in the Sequence Checking section, select the Yes option and continue with 

step 7.
! If no, continue with step 7.

Continued on next page
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7 Do you want to manage transaction set control numbering options at the group level?
! If yes, complete the following:

a. Select Sequence from Group. 
b. From the list in the Transaction Control Numbers section, select the format of 

the transaction set control number that the system generates.
c. Continue with step 8.

! If no, continue with step 8.

8 ! Complete the appropriate envelope information, and continue with step 9.

Reference
For information about envelope definitions, refer to Envelope options on page 3 - 17.

9 ! Repeat steps 2 through 8 for each additional EDI standard you are using to define 
relationships.

! Click OK to save the inbound relationship information and exit the Quick Partner 
Outbound Defaults dialog box.
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1 Click CLOSE on the Quick Partner Defaults dialog box to exit Quick Partner. 

Note
The established default is used by the system when you create a new partner profile/
relationship using the Partner Wizard.
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The Partner Wizard is an easy-to-use method for adding new partners and 
new partner relationships to the system, and is designed for the novice EDI 
user. The Partner Wizard walks you through the creation of new partner 
definitions and profiles, inbound relationships, and outbound relationships. 
This tool also automatically creates the acknowledgment for inbound and 
outbound documents.

8�6�
��.�������� Before using Partner Wizard to create a new partner, you must have the 
following information:

! The EDI code for the partner.
! The application code used to identify the partner in the import file. This 

application code is needed only if the transactions are processed using 
the file Import facility.

! The communication profile name you use to communicate with the 
partner.
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� To use the Partner Wizard, complete the following steps:
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1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 Click WIZARD.

System Response
The Partner Wizard dialog box is displayed.

3 Click NEXT>.

System Response
The Partner Wizard leads you through the necessary steps to 
create a new partner profile or partner relationship.
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(��
�������� The partner definition contains the basic information about the partner that 
the system needs before you can define the rest of the partner profile.

8�6�
��.�������� Before setting up a new partner definition, you must have the following 
information:

! The communication profile name you use to communicate with this 
partner.

! The EDI code for this partner.
! The application code used to identify this partner in the import file. This 

application code is needed only if the transactions are processed using 
the file Import facility.

!
�����
� To create a new partner definition, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

Continued on next page
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2 Click NEW.

System Response
The Partner Definition - New dialog box is displayed.

3 In the Profile ID box, type a unique alphanumeric Profile ID 
for this partner.

Note
Do not use special characters.

4 In the Name box, type the partner name.

5 In the EDI Code box, type the EDI identifier for this partner.

Note
The system uses the EDI identifier during inbound 
processing, to select the correct partner.

6 If necessary, in the Application Code box, type an application 
code to identify this partner.

Note
The system uses this identifier during outbound import 
processing to select the correct partner.

7 From the Comm. Profile list, select the predefined 
communications setup that you are using for inbound and 
outbound processing.

8 Click SAVE.

Continued on next page
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9 Click EXIT.

System Response
The Partner Editor dialog box is displayed.

Note
To complete the partner profile you need to define an 
inbound or outbound relationship, or both.
! If you are receiving and processing information from this 

trading partner, you need to define an appropriate 
inbound relationship. For more information, see Creating 
a New Inbound Relationship on page 3 - 30. 

! If you are sending information to this trading partner, you 
need to define an outbound relationship. For more 
information, see Creating a New Outbound Relationship 
on page 3 - 42.
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(��
�������� To correctly receive and process information from a trading partner, you 
must have an inbound relationship established that defines the parameters 
for receiving data files. Each inbound relationship defines which business 
documents are received from a partner.
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Parameters are required when you create an inbound relationship. These 
parameters provide the system with the following information:

! The type of data which is received.
! The criteria the system uses to validate the information it receives.
! The functional groups and interchanges in which you expect to receive 

the documents.

�
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Each inbound relationship must have one or more associated inbound 
translation objects. These translation objects determine how the received 
data is processed. You need to specify which translation objects are used to 
define the rules for exporting, printing, and creating turnaround documents. 
At a minimum, one translation object must be available.

;���

If this relationship requires a new translation object, you must register that 
translation object with the system before creating the inbound relationship. 
For instructions on how to register translation objects, See Registering 
(Installing) a New Translation Object on page 2 - 3. 
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You must define or select an inbound interchange and/or inbound functional 
group before the system allows you to complete the setup of an inbound 
relationship. The inbound functional group defines the format of the 
functional group and the parameters that are used to verify it. The inbound 
interchange defines the format of the interchange and the parameters that are 
used to verify it. 

However, for some transactions, the functional group or interchange is 
optional. If your trading partner has chosen not to use it, then it is not 
necessary for you to select one. Refer to the standards discussed below to 
determine whether or not you are required to select an inbound functional 
group or interchange.

! For some ANSI X12 documents, the interchange is optional and the 
functional group is required. However, for most documents, both an 
interchange and functional group are required.

! For TDCC, the interchange is optional and the functional group is 
required.

! For UCS, the interchange is required and the functional group is also 
required.

! For EDIFACT, the interchange is required and the functional group is 
optional.

! For ODETTE, the interchange is required and the functional group is 
optional.

! For TRADACOMS, the Interchange is required and there is no 
functional group.

;���

If you do not want to use an optional functional group or interchange, you 
must select <none> from the appropriate dialog box to alert the system that 
you are not using a group.
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8�6�
��.�������� Before setting up an inbound relationship, you must have the following 
information:

! The EDI standard that you expect from this trading partner. For 
example, ANSI.

! The standard version that you expect from this trading partner. For 
example, 003020 for ANSI or 090001 for EDIFACT.

! The code for the transaction set you expect from this trading partner. For 
example, �INVOIC� represents an EDIFACT invoice.

! The type of functional group and interchange the transaction set is 
wrapped in when it is received from this partner.

(������
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After you complete your implementation planning for this partner, you can 
set up the inbound relationship by using the Inbound Relationship dialog 
box. The Inbound Relationship dialog box controls other subordinate dialog 
boxes, which are used to define everything that is necessary to establish the 
relationship.
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The process used to define an inbound relationship is explained in the 
following table:

��
�� $���
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1 Create a new inbound relationship. For more information, 
see  page 3 - 34.

2 Select at least one inbound translation object.

3 Create and select at least one inbound group to define how 
the document is received from this partner.

Note
Depending on the standards you are using, either the 
functional group or interchange may be optional. To 
determine what is optional for the standard you are using, 
see Inbound groups and interchanges on page 3 - 31.

4 Create and select at least one inbound interchange to define 
how the document is received from this partner.

Note
Depending on the standards you are using, either the 
functional group or interchange may be optional. To 
determine what is optional for the standard you are using, 
see Inbound groups and interchanges on page 3 - 31.

5 If you are generating functional acknowledgments as a result 
of receiving documents for an inbound relationship, you 
must set up the corresponding outbound relationship to 
generate the acknowledgments your partner requests.

Reference
For information about establishing an outbound relationship, 
see Creating a New Outbound Relationship on page 3 - 42.
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1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 ! Select the partner profile for which you want to create an 
inbound relationship. 

! Click INBOUND.

System Response
The Inbound Relationship dialog box is displayed.

Note
You must have already created a partner definition for this 
partner. For more information, see Creating a New Partner 
Definition on page 3 - 27.

Continued on next page
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3 Click NEW.

System Response
The New Inbound Relationship dialog box is displayed.

4 In the description box, type a unique relationship name. For 
example, Inbound Invoice.

5 Click SAVE.

System Response
A new inbound relationship is created and the Inbound 
Relationship dialog box is displayed.

6 From the appropriate lists on the Inbound Relationship dialog 
box, select the following:
! Standard 
! Version 
! Transaction Set 
! Release -- select for TRADACOMS only

Note
The information required for this dialog box should be 
provided to you by your trading partner when they define the 
details of the transactions they send to you.

Continued on next page
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7 Click ADVANCED>> to define parameters that comply with 
the processing needs of your partner. These parameters 
include Sequence Checking, Last Used Control, Duplicate 
Documents, or Generate Acknowledgment.

System Response
The Inbound Relationship dialog box is extended.
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1 On the Inbound Relationship dialog box, click 
TRANSLATION.

System Response
The Inbound Translation Object dialog box is displayed.

2 From the lists, select the translation objects that are required 
for this inbound relationship.

Note
The lists display all the translation objects registered in the 
system that are appropriate for the type of translation object, 
such as Export or Print, and the transaction set.

If there are no translation objects displayed in the lists, no 
translation objects are registered for the document defined in 
the relationship.

Continued on next page
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3 If you selected an Export File translation object and you want 
to export to a specific file, type the mapped path of that file in 
the Export File Name box.

Note
Do not use Universal Naming Convention (UNC) paths.

4 Click SAVE.

System Response
Your selections are saved and the Inbound Relationship 
dialog box is displayed.
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1 On the Inbound Relationship dialog box, click GROUPS to 
display a list of existing groups.

System Response
The Inbound Group Select dialog box is displayed.

2 Is the required group in the Groups list?
! If yes, select the group and click SELECT. Select <none> 

if you are not using groups. Continue with the Selecting 
an inbound interchange section of this table.

System Response
The highlighted group is selected and the Inbound 
Relationship dialog box is displayed.

! If no, continue with step 3 to create the group.

Continued on next page
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3 On the Inbound Group Select dialog box, click NEW.

System Response
The Inbound Group Entry dialog box is displayed.

4 In the Description box, type the group description.

5 In the Functional Group ID box, type the identification of the 
functional group you are specifying. 

Note
The EDI standards define which functional group ID should 
be used for each type of document.

6 If you have more complex requirements for processing the 
functional group, click ADVANCED>> to display the full list 
of functional group setup options.

System Response
The Inbound Group Entry dialog box is extended.

Continued on next page
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7 After you set up the required parameters in this dialog box, 
click SAVE.

System Response
The information is stored and the Inbound Group Select 
dialog box is displayed.

8 ! Highlight the new group. 
! Click SELECT.

System Response
The group is selected and the Inbound Relationship dialog 
box is displayed.

����������
��������������
�	
���

1 On the Inbound Relationship dialog box, click 
INTERCHANGES.

System Response
The Inbound Interchange Select dialog box is displayed, 
showing a list of existing interchanges.

2 Is the required interchange in the Interchanges list?
! If yes, select the interchange and click SELECT. Select 

<none> if you are not using groups. Continue with the 
Finalizing the inbound relationship section of this table.

System Response
The highlighted interchange is selected and the Inbound 
Relationship dialog box is displayed.
! If no, continue with step 3 to create the interchange.

Continued on next page

�>�����?

���� *�����
���������	
��
�
���
��	���������
�����	�� ��������� � � �+



�
�
�����
�;�,�(�������"��
�����	�� #�������������������
�$�����" �("
3 On the Inbound Interchange Select dialog box, click NEW.

System Response
The Inbound Interchange Entry dialog box is displayed.

4 In the Description box, type the interchange description.

5 In the Interchange ID box, type the identification of the 
interchange you are specifying. 

Note
The EDI standards define which interchange ID should be 
used for each type of document.

6 If you have more complex requirements for processing the 
interchange, click ADVANCED>> to display the full list of 
interchange setup options.

System Response
The Inbound Interchange Entry dialog box is extended.

Continued on next page
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7 After you set up the required parameters in this dialog box, 
click SAVE.

System Response
The information is stored and the Inbound Interchange Select 
dialog box is displayed.

8 ! Highlight the new interchange.
! Click SELECT.

System Response
The interchange is selected and the Inbound Relationship 
dialog box is displayed.
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1 On the Inbound Relationship dialog box, click SAVE.

2 Click EXIT.

System Response
The Partner Editor dialog box is displayed.
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(��
�������� To correctly send information to a trading partner, you need to define an 
outbound relationship. Outbound relationships define the parameters needed 
to send a data file to a trading partner. Each outbound relationship defines 
the format of a single business document, and how that business document is 
formatted and sent to the specified trading partner.
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Parameters are required when you create an outbound relationship. These 
parameters provide the system with the following information:

! How to create the required message.
! The criteria that the system uses to validate the information entered.
! How to create the functional group and interchange envelopes in 

preparation for sending.

�
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Each outbound relationship must have one or more associated outbound 
translation objects. These translation objects determine how the sent data is 
formatted. You need to specify which translation objects are used to define 
the rules for screen entry or file import. At a minimum, one translation 
object must be available.

;���

If this relationship requires a new translation object, you must register that 
translation object with the system before creating the outbound relationship. 
For instructions on how to register translation objects, see Registering 
(Installing) a New Translation Object on page 2 - 3.
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You must define or select an outbound interchange and/or outbound 
functional group before the system allows you to complete the setup of an 
outbound relationship. The outbound functional group defines the format of 
the functional group and the parameters that should be used to verify it. The 
outbound interchange defines the format of the interchange and the 
parameters that should be used to verify it. 

For some transactions, the functional group or interchange is optional. If 
your trading partner has chosen not to use it, then it is not necessary for you 
to select one. Refer to the standards discussed below to determine whether or 
not you are required to select an outbound functional group or interchange.

! For some ANSI X12 documents, the interchange is optional and the 
functional group is required. However, for most documents, both an 
interchange and functional group are required.

! For TDCC, the interchange is optional and the functional group is 
required.

! For UCS, the interchange is required and the functional group is also 
required.

! For EDIFACT, the interchange is required and the functional group is 
optional.

! For ODETTE, the interchange is required and the functional group is 
optional.

! For TRADACOMS, the Interchange is required and there is no 
functional group.

;���

If you do not want to use an optional functional group or interchange, select 
<none> from the appropriate dialog box to alert the system that you are not 
using a group.
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��.�������� Before setting up an outbound relationship, you must have the following 
information:

! The EDI standard that this trading partner expects. For example, 
ANSI X12.

! The standard version that this partner expects. For example, 003020 for 
ANSI or 090001 for EDIFACT.

! The code for the transaction set you use. For example, �INVOIC� 
represents an EDIFACT invoice.

! The type of functional group and interchange envelope the transaction 
set is wrapped in when it is sent to this partner.
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After you complete your implementation planning for this partner, you can 
set up the outbound relationship by using the Outbound Relationship dialog 
box. The Outbound Relationship dialog box controls other subordinate 
dialog boxes, where you define everything that is necessary to establish the 
relationship.
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The process you use when defining an outbound relationship is explained in 
the following table:

��
�� $���
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1 Create a new outbound relationship. For more information, 
see page 3 - 46.

2 If you are using the EDIFACT, ODETTE, or TRADACOMS 
standard, you must complete the envelope (header) 
information for this type of document.

3 Select at least one outbound translation object.

4 Create and select at least one outbound group (including 
enveloping information) to define how the document is 
received from this partner.

Note
Depending on the standards you are using, either the 
functional group or interchange may be optional. To 
determine what is optional for the standard you are using, 
see Outbound groups and interchanges on page 3 - 43.

5 Create and select at least one outbound interchange 
(including enveloping information) to define how the 
document is received from this partner.

Note
Depending on the standards you are using, either the 
functional group or interchange may be optional. To 
determine what is optional for the standard you are using, 
see Outbound groups and interchanges on page 3 - 43.

6 If you are receiving functional acknowledgments as a result 
of sending documents for an outbound relationship, part of 
establishing that outbound relationship is setting up the 
corresponding inbound relationship to receive the 
acknowledgments from your partner. 

Reference
For information on how to establish an inbound relationship, 
see Creating a New Inbound Relationship on page 3 - 30.
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� To create an outbound relationship, complete the following steps:
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1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 ! Select the partner profile for which you want to create an 
outbound relationship. 

! Click OUTBOUND.

System Response
The Outbound Relationship dialog box is displayed.

Note
You must have already created a partner definition for this 
partner. For more information, see Creating a New Partner 
Definition on page 3 - 27. 

Continued on next page
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3 Click NEW.

System Response
The New Outbound Relationship dialog box is displayed.

4 In the description box, type a unique relationship name.

5 Click SAVE.

System Response
A new outbound relationship is created and the Outbound 
Relationship dialog box is displayed.

6 From the appropriate lists on the Outbound Relationship 
dialog box, select the following:
! Standard
! Version
! Transaction Set
! Release -- select for TRADACOMS only

Note
The information required for this dialog box should be 
provided to you by your trading partner when they define the 
details of the transactions they send to you.

Continued on next page
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7 Click ADVANCED>> if you need to define parameters that 
comply with the processing needs of your partner.These 
parameters include Last Used Control Number, Expect 
Acknowledgment, Hours Overdue, Duplicate Documents, or 
Test Indicator. 

System Response
The Outbound Relationship dialog box is extended.

����������
��

��
��������5������>0$(=*��D��$0��0D�
���

�"*$*�� ����
��

������.?

1 If you are using the EDIFACT, ODETTE, or TRADACOMS 
standard, click ENVELOPE to complete the envelope (header) 
information.

System Response
One of the following dialog boxes is displayed:
! Outbound UNH Envelope dialog box
! Outbound MHD Envelope dialog box

2 ! Enter the appropriate information. 
! Click SAVE.

System Response
The information is saved and the Outbound Relationship 
dialog box is displayed.

Continued on next page
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1 On the Outbound Relationship dialog box, click 
TRANSLATION.

System Response
The Outbound Translation Object dialog box is displayed.

2 From the lists, select the translation objects that are required 
for this outbound relationship.

Note
The lists display all translation objects registered in the 
system that are appropriate for the type of translation object, 
such as Import or Print, and the transaction set.

If there are no translation objects displayed in the lists, no 
translation objects of that type are registered for the 
document defined in the relationship.

3 If you selected an Import translation object, you may need to 
define the following:
! In the Application ID box, type the application identifier 

that indicates the destination for the documents.
! In the Application Alias Value box, type criteria that the 

system uses to distinguish this relationship from others 
during the application import function.

Continued on next page
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4 Click SAVE.

System Response
The selections are saved and the Outbound Relationship 
dialog box is displayed.
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1 On the Outbound Relationship dialog box, click GROUPS.

System Response
The Outbound Group Select dialog box is displayed, showing 
a list of existing groups.

2 Is the required group in the Groups list?
! If yes, select the group, and click SELECT. Select <none> 

if you are not using groups. Continue with the Selecting 
an outbound interchange section of this table.

System Response
The highlighted group is selected and the Outbound 
Relationship dialog box is displayed.

! If no, continue with step 3 to create the group.

Continued on next page
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3 On the Outbound Group Select dialog box, click NEW.

System Response
The Outbound Group Entry dialog box is displayed.

4 In the Description box, type the group description.

5 In the Functional Group ID box, type the identification of the 
functional group you are specifying. 

Note
The EDI standards define which functional group ID should 
be used for each type of document.

6 If you have more complex requirements for processing the 
functional group, click ADVANCED>> to display the full list 
of functional group setup options.

System Response
The Outbound Group Entry dialog box is displayed.

Recommendation
Do not change the translation objects in the Group Transl. 
Obj. and Acknowledge Transl. Obj. lists, unless you have a 
specific reason to do so.

Continued on next page
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7 Click ENVELOPE to set up the parameters for the generation 
of the Functional Group segment.

System Response
The Outbound Functional Group dialog box that is displayed 
is determined by the standard selected on the Outbound 
Relationship dialog box. It is one of the following:
! Outbound GS Functional Group
! Outbound UNG Functional Group
! Outbound BAT Functional Group

8 After you set up the required parameters in the enveloping 
dialog box, click SAVE.

System Response
The information is stored and the Outbound Group Entry 
dialog box is displayed.

9 Click SAVE.

System Response
The information on the Outbound Group Entry dialog box is 
stored and the Outbound Group Select dialog box is 
displayed.

10 ! Highlight the new group. 
! Click SELECT.

System Response
The group is selected and the Outbound Relationship dialog 
box is displayed.

Continued on next page
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1 On the Outbound Relationship dialog box, click 
INTERCHANGES.

System Response
The Outbound Interchange Select dialog box is displayed, 
showing a list of existing interchanges.

2 Is the required interchange in the Interchanges list?
! If yes, select the interchange and click SELECT. Select 

<none> if you are not using groups. Continue with the 
Finalizing the outbound relationship section of this table.

System Response
The highlighted interchange is selected and the Outbound 
Relationship dialog is displayed.

! If no, continue with step 3 to create the interchange.

3 On the Outbound Interchange Select dialog box, click NEW.

System Response
The Outbound Interchange Entry dialog box is displayed.

Continued on next page
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4 In the Description box, type the interchange description.

5 In the Interchange ID box, type the identification of the 
interchange you are specifying. 

Note
The EDI standards define which interchange ID should be 
used for each type of document.

6 If you have more complex requirements for processing the 
interchange, click ADVANCED>> to display the full list of 
interchange setup options.

System Response
The Outbound Interchange Entry dialog box is extended.

Recommendation
Do not change the translation objects in the Interchange 
Transl. Obj. and Acknowledge Transl. Obj. lists, unless you 
have a specific reason to do so.

Continued on next page
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7 Click ENVELOPE to set up parameters for generating the 
interchange segment.

System Response
The Outbound Interchange dialog box that is displayed, is 
determined by the standard you selected on the Outbound 
Relationship dialog box. It is one of the following:
! Outbound ISA Envelope
! Outbound ICS Envelope
! Outbound BG Envelope
! Outbound UNB Envelope
! Outbound UNA Envelope
! Outbound STX Envelope

8 After you set up the required parameters in the enveloping 
dialog box, click SAVE.

System Response
The information is stored and the Outbound Interchange 
Entry dialog box is displayed.

9 Click SAVE.

System Response
The information on the Outbound Interchange Entry dialog 
box is stored and the Outbound Interchange Select dialog box 
is displayed.

10 Highlight the new interchange and click SELECT.

System Response
The interchange is selected and the Outbound Relationship 
dialog box is displayed.
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1 On the Outbound Relationship dialog box, click SAVE.

2 Click EXIT.

System Response
The Partner Editor dialog box is displayed.
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(��
�������� The partner definition contains the basic profile information about that 
partner to which the system associates the rest of that partner�s records. You 
can edit or delete the partner definition from the Partner Editor dialog box.
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To edit a partner profile, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

Continued on next page
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2 ! Select the appropriate partner from the Select a Partner 
list.

! Click EDIT.

System Response
The Partner Definition dialog box is displayed for that 
partner.

3 Make the necessary changes and click SAVE.

System Response
The Partner Editor dialog box is displayed.

Note
You can also edit other aspects of a partner relationship by 
clicking the appropriate button on the Partner Editor dialog 
box. For example, if you want to edit an inbound or outbound 
relationship, click INBOUND or OUTBOUND. 

You are not able to edit any boxes that are unavailable; these 
are the �keys� to the relationship. In this case, you must 
create a new inbound or outbound relationship for that 
partner.

Reference
! For more information on creating a new inbound 

relationship, see Creating a New Inbound Relationship 
on page 3 - 30. 

! For more information on creating a new outbound 
relationship, see Creating a New Outbound Relationship 
on page 3 - 42.
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Deleting a
partner profile To delete a partner profile, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 ! Select the appropriate partner from the Select a Partner 
list.

! Click DELETE.

System Response
You are prompted to confirm the deletion.

Caution
When you delete a partner relationship, the documents and 
interchanges associated with that partner are also deleted.
You are warned before the actual deletion.

3 Click YES to delete the selected partner profile.

System Response
The partner profile and all associated records are deleted.
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(��
�������� The partner profile defines the parameters that control the processing and 
structure of inbound and outbound data. As a result, the partner profiles may 
become complex and may require you to define a significant number of 
parameters.

To simplify this process, GENTRAN:Director includes the import partner 
feature, which enables you to import partner details from a file. The file of 
partner details can originate from a partner profile that was exported from 
another copy of the GENTRAN:Director system.

You can also use the import facility to update information for existing 
partners. If you import to an existing partner profile, you can add new 
trading relationships. Existing relationships are not modified.

;���

Any tables attached to the partner profile, such as cross-reference, lookup, or 
location, are also imported.

8�6�
��.�������� You must register any translation objects required for the partner before 
loading a partner profile. Only those profiles for which one or more of the 
necessary translation objects are available is imported. Any relationships in 
the import file that are not loaded can be imported once you obtain and 
register the translation objects. 

"�6�
����

For more information on registering translation objects, see Registering 
(Installing) a New Translation Object on page 2 - 3. 
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� To import a partner profile, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 Click IMPORT.

System Response
The Import File Select dialog box is displayed.

3 Select the location of the partner file by doing one of the 
following:
! Selecting it from the Look in list
! Typing it in the File name box

Continued on next page
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4 Click OPEN.

System Response
The Import dialog box is displayed. This dialog box allows 
you verify that this partner is the correct one.

5 Click SAVE to continue.

6 If you are prompted to enter additional partner information, 
enter that information and click SAVE.

System Response
The system imports the partner details if they do not already 
exist on the system, and any relationships for which there are 
translation objects.

During this process, the system prompts you for any 
additional information it needs by displaying the appropriate 
Partner Editor dialog box. You are prompted with dialog 
boxes when you would normally be required to provide 
information about your site. This is usually restricted to your 
EDI identifiers which the system uses to generate outbound 
EDI envelopes. The system continues displaying Partner 
Editor dialog boxes until it has all the information it needs. 

Once the import is complete, the system displays the message 
�Import process completed. Note any warnings or errors.� 

7 Click OK.

System Response
The Import dialog box is displayed.

8 Click EXIT.

System Response
The Partner Editor dialog box is displayed.
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(��
�������� GENTRAN:Director includes a feature that enables you to export existing 
partner details to a file. You can also export your partners to diskette to use 
as a backup of your partner system.

;���

Any tables attached to the partner profile, such as cross-reference, lookup, or 
location, are also exported.

!
�����
� To export a partner profile, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

Continued on next page
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2 ! Select a partner.
! Click EXPORT.

System Response
The Export File Build dialog box is displayed.

3 Name the export file by doing one of the following:
! Selecting it from the Look in list
! Typing it in the File name box

Note
The system automatically prompts you to name the export 
file with the name of the partner and the .PAR extension.

4 Click SAVE.

System Response
The partner is exported.
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(��
�������� The partner copy function enables you to select a partner profile to copy. 
This means that you do not need to type in similar partner profiles from 
scratch. Instead, you can copy from an existing profile, enter unique partner 
definition, and key enveloping information for the copied partner. 

The partner copy function is designed to provide you with a quick method 
for establishing partners that, generally, have similar or identical trading 
relationships.

;���

You must export the partner profile before you copy it. If you do not know 
which EDI standard that partner profile uses, check the profile information 
before you export and copy it.

"�6�
����

For more information, see Exporting a Partner Profile on page 3 - 62. 

!
�����
� To copy a partner profile, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

Continued on next page
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2 Click COPY.

System Response
The Partner Copy dialog box is displayed.

3 Click SELECT PARTNER.

System Response
The Import File Select dialog box is displayed.

4 Select the file you want to copy by doing one of the 
following:
! Selecting it from the Look in list
! Typing it in the File name box

5 Click OPEN to copy that partner. 

Notes
! The model partner profile name is displayed in the title 

bar of the Partner Copy dialog box.
! The default file extension for exported partners is 

�.PAR.�

Continued on next page
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6 On the Partner Copy dialog box Profile ID box, type a unique 
profile identifier.

7 In the Name box, type the partner name.

8 In the EDI Code box, type the EDI identifier for this partner.

Note
The system uses the EDI identifier during inbound 
processing to select the correct partner.

9 If necessary, in the Application Code box, type an application 
code to identify this partner.

Note
The system uses this identifier during outbound import 
processing to select the correct partner.

10 Complete the appropriate boxes in the enveloping section of 
the dialog box.

Note
You should only complete those boxes that are necessary for 
the standard used by the partner profile you copied. The 
standards are listed to the right of each box. 

If the partner profile you copied uses a standard, you must 
complete all the necessary enveloping boxes for that 
standard. If you do not complete the necessary boxes for the 
standard, the system takes the necessary information from the 
copied partner profile envelope.

Example
If the copied partner profile uses the UCS standard, you must 
complete the Interchange Communication ID box, among 
others.

11 After you enter all the partner information, click SAVE.

12 Click EXIT.

System Response
The Partner Editor dialog box is displayed.
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(��
�������� The translation process allows you to set up tables to use information in the 
Partner database when a document is entered into the system, either from a 
file or from the Document Editor facility.

�
������� The Partner Editor also allows you to use an internal system partner 
(<Internal System User>) to define your company to the system. Tables can 
be set up for use with either a trading partner or with the special system 
partner.

! Tables that you establish under a specific partner are valid only for that 
partner. 

! Tables that you set up under the internal system user can be used 
globally. 

�������
���� The use of partner or system partner tables is defined in the translation 
objects at design time. This allows commonly used items such as names and 
addresses to be inserted into the outbound data without the need to type it. It 
also allows you to use Lookup and Cross-reference tables to supplement or 
convert data you enter or receive inbound.

You can create cross-reference and lookup tables in GENTRAN:Director, or 
you can import and export existing tables to and from your system.

;���

Tables are used only if you create a translation object that specifically 
accesses those tables.
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!
�����
� To create a partner table, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 ! Select the partner profile or the system partner (<Internal 
System User>) for which you want to create a Cross-
reference or Lookup table.

! Click TABLES.
The Partner Tables dialog box is displayed.

Continued on next page
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3 Click NEW.

System Response
The New Table dialog box is displayed.

4 In the Table Name box, type the unique table name.

Note
The table name must be the same as the name used in the 
translation object that requires the table.

5 From the Table Type section, select the Cross-reference or 
Lookup table option.

6 Click SAVE.

System Response
The information is saved and the CrossRef Select or Lookup 
Select dialog box is displayed.

7 Click NEW.

System Response
The CrossRef Entry or Lookup Entry dialog box is displayed, 
depending on the type of table you selected on the New Table 
dialog box.

8 Type the table values. You can enter the following:
! Two values for a cross-reference and one value for a 

lookup table 
! A description
! Any other reference information for the entry

Note
The way that the data you enter is used depends on how the 
translation object is defined. Consult with the translation 
object designer if you are unclear about what is required.

Continued on next page
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9 Click SAVE after each entry to save the information and enter 
another table record.

10 Once you finish typing all entries, click EXIT.

System Response
The Cross-reference (or Lookup) Select dialog box is 
displayed.

11 Click EXIT.

System Response
 The Partner Editor dialog box is displayed.
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� To edit a partner table, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 ! Select the partner profile or the system partner (<Internal 
System User>) for which you want to modify a Cross-
reference or Lookup table.

! Click TABLES.
The Partner Tables dialog box is displayed.

Continued on next page
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3 ! Select the table you want to modify.
! Click EDIT.

System Response
The CrossRef Select or Lookup Select dialog box is 
displayed, depending on the type of table.

4 ! Select the item you want to modify.
! Click EDIT.

System Response
The CrossRef Entry or Lookup Entry dialog box is displayed, 
depending on the type of table.

5 Modify the entry.

6 Once you finish modifying all necessary table entries, click 
SAVE.

System Response
The Cross-reference or Lookup Select dialog box.

7 Click EXIT.

System Response
The Partner Editor dialog box is displayed.
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�����
� To delete entries in a partner table, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 ! Select the partner profile or the system partner (<Internal 
System User>) for which you want to delete a table entry.

! Click TABLES.
The Partner Tables dialog box is displayed.

Continued on next page
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3 ! Select the table you want to modify.
! Click EDIT.

System Response
The CrossRef Select or Lookup Select dialog box is 
displayed, depending on the type of table.

4 ! Select the item you want to modify. 
! Click DELETE.

System Response
The Confirm Delete dialog box is displayed.

5 Click YES to complete the deletion.

System Response
The CrossRef Select or Lookup Select dialog box is 
displayed.

6 Click EXIT.

System Response
The Partner Editor dialog box is displayed.
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!
�����
� To delete a partner table, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 ! Select the partner profile for which you want to delete a 
table.

! Click TABLES.
The Partner Tables dialog box is displayed.

Continued on next page
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3 ! Select the table you want to delete. 
! Click DELETE.

System Response
The Confirm Delete dialog box is displayed.

4 Click YES to complete the deletion and return to the Partner 
Editor dialog box.
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(��
�������� The Table Export function enables you to export partner cross-reference and 
lookup tables to a sequential file. This allows you to define a table for one 
trading partner and copy that table to another partner profile. 

01��
��6�����
.��� Typically, you export and then import tables created for another partner 
profile. However, if necessary, you can build tables outside of 
GENTRAN:Director by formatting your data in the export file layout.

The export file layout is a free-format ASCII text file. Each field must be 
delimited, or separated, with Hex01.

;���

You can create the file with a text editor such as Notepad. The default file 
extension for a lookup export file is �.LKP.� The default file extension for a 
cross-reference file is �.XRF.�

9��+����
����6�����

The fields in a lookup table are listed in the following table. Mandatory 
fields are designated with an asterisk[*]:

=���� $���
������

Partner key* A unique identifier for the partner.

Table name* The name of the table. Because this field 
is displayed in the table selection list, the 
name should be descriptive.

Item* The value that is found or �looked up� in 
the data during inbound or outbound 
processing.

Description A brief comment about the item.

Text1, Text2, Text3, Text4 Additional reference information 
required by the translation object using 
this table.
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The fields in a cross-reference table are listed in the following table. 
Mandatory fields are designated with an asterisk (*):

=���� $���
������

Partner key* A unique identifier for the partner.

Table name* The name of the table. Because this field 
is displayed in the table selection list, the 
name should be descriptive.

My Item* Your data value that corresponds to your 
partner�s data value.

Partner Item* Your partner�s data value that 
corresponds to your data value.

Description A brief comment about the item.

Text1, Text2, Text3, Text4 Additional reference information 
required by the translation object using 
this table.
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� To export a partner table, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 ! Select the partner profile or the system partner (<Internal 
System User>) for which you want to export a Cross-
reference or Lookup table.

! Click TABLES.
The Partner Tables dialog box is displayed.

Continued on next page
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3 Click EXPORT.

System Response
The Table Export File Build dialog box is displayed.

4 From the Save in list, select the location of the exported table 
file.

5 Do one of the following:
! Type the export file name in the File name box. 
! Select it from the list.

Note
The default file extension for cross-reference tables is 
�.XRF�. The default file extension for lookup tables is 
�.LKP�.

6 Click SAVE to begin the export process.

Note
When the export process is complete the system displays an 
informational dialog box.

7 Click OK.

System Response
The Partner Tables dialog box is displayed.

8 Click EXIT.

System Response
The Partner Editor dialog box is displayed.
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(��
�������� The Table Import function enables you to import partner cross-reference and 
lookup tables from a sequential file. This allows you to import tables created 
for another partner profile, or build tables outside of GENTRAN:Director by 
formatting your data in the export file layout.

!
�����
� To import a partner table, complete the following steps

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

Continued on next page
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2 ! Select the partner profile or the system partner (<Internal 
System User>) for which you want to import a Cross-
reference or Lookup table.

! Click TABLES.
The Partner Tables dialog box is displayed.

3 Click IMPORT.

System Response
The Table Import File Select dialog box is displayed.

4 From the Look in list, select the location of the table file.

5 ! Type the import file name in the File name box.
! Select it from the list.

Note
The default file extension for cross-reference tables is 
�.XRF�. The default file extension for lookup tables is 
�.LKP�.

Continued on next page
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6 Click OPEN to begin the import process.

Note
When the export process is complete the system displays an 
informational dialog box.

7 Click OK.

System Response
The Partner Tables dialog box is displayed.

8 Click EXIT.

System Response
The Partner Editor dialog box is displayed.
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(��
�������� Each partner profile may have many associated location tables. You can use 
location tables in many different ways. For example, you may need a list of a 
partner�s store addresses, warehouse addresses, or �invoice to� addresses. 
Any or all of these can be stored in a location table.

Locations are referenced in translation objects through one of the location 
keys or reference codes. Locations are used only if you use a translation 
object that specifically accesses those locations.
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Parameters are required to tell the system the following information:

! The name of the trading partner location
! The reference codes that the system uses to identify this location

These parameters are used to create a partner location.

8�6�
��.�������� Before setting up a partner location, you must have the following 
information:

! The unique name that identifies this partner location
! At least one reference code to identify the location
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!
�����
� To create partner locations, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 Click LOCATIONS.

System Response
The Location Select dialog box is displayed.

Continued on next page
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3 Click NEW.

System Response
The Location Entry dialog box is displayed.

4 In the Name box, type a unique identifier that defines this 
location within the partner.

5 In the Reference Code 1 box, type the unique identifier for 
the location you are defining. For example, the DUNS 
number can be defined for the location.

6 Complete the remaining boxes, as necessary.

Note
If you use Reference Code 2, it must also be unique.

7 Click SAVE.

System Response
The location information is saved and a blank Location Entry 
dialog box is displayed.

8 If you want to enter additional locations for this partner, 
complete steps 4 through 7 as many times as necessary.

9 Click EXIT.

System Response
The Partner Editor dialog box is displayed.
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!
�����
� To edit a partner location, complete the following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 Click LOCATIONS.

System Response
The Location Select dialog box is displayed.

Continued on next page
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3 ! From the Locations list, select a location.
! Click EDIT.

System Response
The Location Entry dialog box is displayed.

4 Make any necessary changes.

Note
The Reference Code1 box must be completed.

5 Do one of the following:
! Click SAVE to save the location information and return to 

the Location Select dialog box. 
! Click EXIT if you want to return to the Location Select 

dialog box without saving changes.

6 Click EXIT.

System Response
The Partner Editor dialog box is displayed.
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!
�����
� To delete a partner location and all associated records, complete the 
following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 Click LOCATIONS.

System Response
The Location Select dialog box is displayed.

3 ! From the Locations list, select a location.
! Click DELETE.

System Response
The Delete Confirmation dialog box is displayed, and 
prompts you to confirm the delete.

4 Click YES to confirm the delete.

5 Click EXIT.

System Response
The Partner Editor dialog box is displayed.
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 This chapter explains how to use the GENTRAN:Director document 
functions, including:

! Creating and editing documents
! Managing documents 
! Routing documents
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The Document Editor is the GENTRAN:Director data entry tool that allows 
you to create, modify, and view documents.

;���

To use the Document Editor, you must register the appropriate screen entry 
translation object with the system and set up a corresponding outbound 
relationship for the partner.
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(��
�������� To create a document using the Document Editor, the system must be set up 
to support screen entry for the partner/transaction set combination you want 
to enter.

;���

The appropriate Screen Entry translation object must be registered and a 
corresponding Outbound relationship must be set up for the partner. For 
more information, see Registering (Installing) a New Translation Object on 
page 2 - 3 and Creating a New Outbound Relationship on page 3 - 42.

!
�����
� Complete the following steps to create a document:

���� *�����

1 From The Desk, select Workspace.

System Response
The Workspace browser is displayed.

Continued on next page
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2 Click NEW.

System Response
The Create New Document dialog box is displayed.

3 ! Select the appropriate partner/transaction set 
combination from the list.

! Click OK.

System Response
The translation object for the selected combination is 
displayed.

Example
The following illustration is an example of a translation 
object.

Continued on next page
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4 Type all the required data items into the boxes on the 
document translation object.

Note
If the document contains a looping structure, or lower-level 
detail records such as line items, then the input translation 
object contains a list, as in the illustration below.

5 To access items in a list, highlight the first entry and click 
NEW.

6 Enter the data for the item.

Notes
! To enter a second or subsequent item, click NEXT or 

press ALT + T. 
! After all loop items are entered, click STORE to save and 

exit the loop dialog box.
! If the document contains codes, press SHIFT + F1 from 

each code field to access a list of the codes.

Continued on next page
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7 If the document contains calculated fields, select Recalculate 
from the Document Editor File menu before saving the 
document.

System Response
The totals are updated, and the document is checked for 
errors. 

8 When you are finished entering data, select Save from the 
Document Editor File menu.

System Response
The system saves the information and automatically 
recalculates and check for errors. If errors are found, you are 
prompted to view the errors.

9 Select Exit from the Document Editor File menu.

System Response
The Document Editor is closed. The system prompts you to 
save the document before closing. 

Note
You can now open and edit this document from the 
Workspace browser.
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(��
�������� To edit a document using the Document Editor, you need to load the 
appropriate screen entry translation object for the partner/transaction set 
combination you want to edit. 

"�6�
����

 For more information on registering a translation object, see Registering 
(Installing) a New Translation Object on page 2 - 3. For more information 
on selecting a translation object for a partner relationship, see Creating a 
New Outbound Relationship on page 3 - 42.

!
�����
� To open and edit a document, complete the following steps:

���� *�����

1 From The Desk, select Workspace.

System Response
The Workspace browser is displayed.

Continued on next page
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2  From the Workspace, select the document. 

Note
Only documents in the Workspace can be edited.

! If the document has already been moved to the Out 
Documents and has not been sent, you can move it back 
to the Workspace using the UnPost function.  See 
UnPosting a Document on page 4 - 37.

! If a document has been sent, it cannot be modified. 
However, you can move a copy of the document from the 
Out Drawer to the Workspace, modify the copy, and send 
it.  See Copying a Document (to Reprocess and 
Resend) on page 4 - 34..

3 Click OPEN.

System Response
The document is displayed in the Document Editor facility.

Continued on next page
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4 Modify the data as required.

Note
If the document contains a looping structure, or lower-level 
detail records such as line items, then the input translation 
object contains a list, as in the illustration below.

5 ! To add a new line item, highlight the first entry and click 
NEW.

! To access items in the list, highlight the entry to be 
changed and click OPEN. You can also double-click the 
item.

Continued on next page
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6 You can now change or enter data for the item. 

Notes
! To move through the entries, use NEXT and PREV.
! To enter a second or subsequent item, click NEXT or 

press ALT + T. 
! After all loop items are entered, click STORE to save and 

exit the loop dialog box.
! If the document contains codes, press SHIFT + F1 from 

each code field to access a list of the codes.

7 If the document contains calculated fields, select Recalculate 
from the Document Editor File menu before saving the 
document.

System Response
The totals are updated and the document is checked for 
errors. 

8 When you are finished entering data, select Save from the 
Document Editor File menu.

System Response
The information is saved and automatically recalculated and 
checked for errors. If errors are found, you are prompted to 
view the errors.

9 From the Document Editor File menu, select Exit.

System Response
The Document Editor is closed and the system prompts you 
to save the document before closing. 
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(��
�������� You can access document browsers in GENTRAN:Director in any of the 
following ways:

! The Desk enables you to access the In Documents, ?In Documents, 
Workspace, Out Documents, ?Out Documents, Interchanges, In Drawer, 
and Out Drawer.

! The Main Toolbar gives you access to the In Documents, ?In 
Documents, Workspace, Out Documents, ?Out Documents, 
Interchanges, In Drawer, Out Drawer, and Send Queue. 

! The View menu gives you access to the In Documents, ?In Documents, 
Workspace, Out Documents, ?Out Documents, Interchanges, In Drawer, 
Out Drawer, and Send Queue. 

��%%
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If you select the In Documents, ?In Documents, Out Documents, ?Out 
Documents, In Drawer, or Out Drawer browser from any of the three 
locations above, the appropriate summary dialog box for that browser is 
displayed.

The summary dialog box displays the number of each type of document for 
each partner contained in the browser. This enables you to filter the display 
of documents in the browser to only those of the document type and partner 
that you want.
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� Complete the following steps to access these browsers:

! In Documents
! ?In Documents 
! Out Documents 
! ?Out Documents 
! In Drawer
! Out Drawer

���� *�����

1 From The Desk, select a browser.

System Response
The summary dialog box for that browser is displayed.

2 Select the type of document for the appropriate partner.

Note
! To highlight more than one partner/document type 

combination, click on the first partner/document type, 
press SHIFT, and then click the last partner/document 
type in the group. 

! To highlight several partner/document types that are not 
adjacent to each other in the summary dialog box, press 
and hold CTRL while clicking each partner/document 
type.

Continued on next page
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3 Click VIEW.

System Response
The browser containing those documents is displayed.

Example
The following is an example of the In Documents browser.
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:��,�6������� The View function enables you to view various types of information, 
depending on the format selected in the View Choice dialog box. The view 
types include:

! The raw input data
! EDI-formatted data 
! A translator report
! Tracking information 

;���

The formatted view option is only active if a Screen Entry translation object 
is available in the Partner Relationship record.

�������	��:��,
6�������

The View function can be accessed when one of the following occurs: 

! A document browser such as In Documents, Out Documents, 
Workspace, In Drawer, and Out Drawer is active and a single document 
is selected.

! The Interchanges or Restored Interchanges browser is active and a 
single document within an interchange is selected.

"�6�
����

For information on the Interchanges browser, see Viewing Documents within 
Interchanges on page 6 - 11.
% � �% ���������������������������������������������������������������������	
��
�
���
��	���������
�����	��



1"����,���9���" :��,����
�$���%���
:��,����

$���%����6
�%
�	��$���%���

8
�,��
�

To view a document from a document browser, complete the following 
steps:

���� *�����

1 From the desk, select the In Documents, Out Documents, 
Workspace, In Drawer, or Out Drawer browser.

System Response
The summary dialog box for that browser is displayed.

2 ! Select the type of document for the appropriate partner.
! Click VIEW.

System Response
The browser containing those documents is displayed.

3 Select a single document from the appropriate browser.

4 Click VIEW.

System Response
The View Choice dialog box is displayed.

Continued on next page
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5 Use the following table to select the option that corresponds 
to how you want the input data displayed. 

Note
Some selections may not be available.

Select... To display...

Raw EDI The data in EDI format.

Formatted Document The data formatted with a screen 
entry translation object.

Note
This option is not available if no 
screen entry translation object 
exists for the document.

Translator Report A report of the actions the 
translator took on this document 
and lists any EDI- or translation 
object-based compliance errors.

Reference
For a detailed explanation of 
translator reports, see �Appendix 
C, Error Messages� in the 
Administrator�s Guide.

Track Information The document tracking 
information that is available for a 
single document.

Note
This function is not available if 
document level auditing is 
disabled. 

Reference
For more information on enabling 
document level auditing, see 
�System Administrator Functions� 
in the Administrator�s Guide.

6 Click OK to access the view that you specified.
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To view a document from the Interchanges or Restored Interchanges 
browser, complete the following steps:

���� *�����

1 From the appropriate area of The Desk, select the 
Interchanges browser.

2 Select a single document.

3 Click the Data icon on the Toolbar.

System Response
The raw EDI data view of the Interchange is displayed in the 
Data View window on the Interchanges or Restored 
Interchanges browser.
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The Processing browser displays any document that is currently being 
processed in the GENTRAN:Director system. The Processing browser 
allows you to find which documents are currently being processed by you or 
other users in the GENTRAN:Director system.

;���

Any document that is currently being processed in the GENTRAN:Director 
system is displayed in the browser as unavailable. You are not permitted to 
access that document until processing is complete and the document has 
been released to the system.

"�����6������� The Processing browser enables you to use the Reset function and return any 
documents that are displayed in the browser, but for which processing has 
terminated, to their previous location. Typically, you use this function for 
exception cases when the processing of a document terminated improperly.
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� To view the documents that are currently being processed, complete the 
following steps:

���� *�����

1 From the View menu, select Processing.

System Response
The Processing browser is displayed.

2 You can perform the following functions on the Processing 
browser:

Function Action

Sort Arranges the columns of the 
documents in the active browser.

Reset Returns any documents that are 
displayed in the Processing 
browser, but for which processing 
has terminated, to their previous 
location.

Note
This function is typically used for 
exception cases when the 
processing of a document 
terminated improperly.
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=����6������� The Find function enables you to find specified text in the active data-view 
window.

�������	��=���
6�������

The Find function is available when a data-view is the active window. The 
following are the data-view windows:

! Audit Log
! Document Tracking
! Interchange Tracking
! Raw Data-View of an Interchange
! Raw Data-View of a Document
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!
�����
� To find specified text, complete the following steps:

���� *�����

1 Access one of the following data-view windows:

Window Access by...

Audit Log selecting Audit Log from the View menu.

Document Tracking ! selecting a document in a browser
! selecting View from the Commands menu 
! clicking the Tracking information option and OK

Interchange Tracking ! selecting an interchange in the Interchanges browser
! selecting View from the Commands menu
! clicking the Tracking information option and OK

Raw Data View of an
Interchange

! selecting Interchanges from The Desk
! selecting an interchange from the Interchanges browser 
! selecting Interchanges from the View menu 
! selecting Data from the Interchanges cascading menu to 

display the raw EDI data

Raw Data View of a 
Document

! selecting a document in the Interchanges browser 
! selecting View from the Commands menu
! clicking OK on the View Choice dialog box to display the 

raw EDI data

2 From the Edit menu, select Find.

System Response
The Find dialog box is displayed.

3 In the Find What box, type the text you want to locate.

Continued on next page
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4 Do you want the system to search for case-sensitive text?
! If yes, select the Match Case check box and continue with step 5.
! If no, continue with step 5.

5 Click FIND NEXT to find the first occurrence of the specified text.

Notes
! If the system locates that text, it is highlighted in the data-view window. 
! If the system does not find the specified text, the system beeps. If this is the case, 

skip to step 6.

6 If the system finds the specified text, continue clicking FIND NEXT to find each 
subsequent occurrence of that text. 

Note
When the system has located the last occurrence of that text in the direction you 
specified, the system beeps.

7 Click CANCEL.

System Response
The data-view window is displayed.
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(��
�������� The Sort function can be used when the In Documents, ?In Documents, In 
Drawer, Workspace, Out Documents, ?Out Documents, or Send Queue 
browser is open. This function arranges the columns of the documents in the 
active browser into one of the following sequences:

! Partner/Type/Name
! Partner/Name/Type
! Type/Partner/Name
! Name/Type/Partner
The Sort function can also be used when the Out Drawer is active. The Sort 
function allows you to arrange the Out Drawer columns and filter the display 
of documents by status.

�	
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To change the default method that GENTRAN:Director uses to sort columns 
in the document browsers, complete the following steps:

���� *�����

1 From the Options menu, select Preferences.

System Response
The Preferences dialog box is displayed.

2 Click the Sort Columns tab.

System Response
The default sort order is displayed.

3 Select the option that corresponds to the appropriate sort 
order. 

4 Click OK.

System Response
The change is saved globally.
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To sort the columns of documents in these browsers, complete the following 
steps:

! In Documents 
! ?In Documents 
! In Drawer 
! Workspace 
! Out Documents 
! ?Out Documents 
! Send Queue

���� *�����

1 From The Desk, select the browser where the documents are 
located.

System Response
If you select the In Documents, ?In Documents, Out 
Documents, ?Out Documents, In Drawer, Out Drawer, or 
Send Queue browser, the summary dialog box for that 
browser is displayed.

2 If a summary dialog box is displayed: 
! Select the type of document for the appropriate partner.
! Click VIEW.

System Response
The browser containing those documents is displayed.

Continued on next page
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Complete the following steps to sort the columns of the documents or filter 
the document display in the Out Drawer browser:

3 Click SORT.

System Response
The Sort Browser Columns dialog box is displayed.

4 Do the following:
! Select the appropriate option for the desired sort order.
! Click OK.

System Response
The list of documents is sorted in the specified sort order.

���� *�����

1 From The Desk, select the Out Drawer.

System Response
The Out Drawer Summary dialog box is displayed.

2 ! Select the type of document for the appropriate partner.
! Click VIEW.

System Response
The Out Drawer browser is displayed.

Continued on next page
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3 Click SORT.

System Response
The Sort/Filter Out Drawer Contents dialog box is displayed.

4 Do you want to sort the browser columns?
! If yes, click the appropriate option for the desired sort 

order and continue with step 5.
! If no, continue with step 5.

Continued on next page
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5 If you want to filter the display of documents in the Out 
Drawer by document status, you can choose not to display 
documents with certain statuses. Select the check box next to 
each status that you do not want displayed.

Note
When you clear a check box, the display of that status is 
turned �off.� The default is to display documents regardless 
of status.

Use the following table to determine which check boxes to 
select:

Status Code Description

Sent Indicates that the document was 
successfully transmitted.

OnNet Indicates that the document was 
successfully delivered to a value-added 
network. 

Note
To obtain this status using 
COMMERCE:Network, you must have 
your mailbox configured to receive the 20 
report in data format.

NetWarn Indicates that the document was delivered 
to a value-added network and the network 
detected non-critical errors in the data. The 
data is available to be picked up by the 
designated trading partner. 

Note
To obtain this status using 
COMMERCE:Network, you must have 
your mailbox configured to receive the 20 
report in data format.

Continued on next page
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(cont.)

Status Code Description

NetErr Indicates that the document was delivered 
to a value-added network and the network 
detected critical errors in the data. The data 
is available to be picked up by the 
designated trading partner.

Note
To obtain this status using 
COMMERCE:Network, you must have 
your mailbox configured to receive the 20 
report in data format.

PickedUp Indicates that the document was 
successfully delivered to a trading partner 
via a value-added network.

Note
To obtain this status using 
COMMERCE:Network, you must have 
your mailbox configured to receive the 70 
report in data format.

Ack�d Indicates that the document was 
acknowledged by your partner and there 
were no errors.

Waiting Indicates that the document is waiting to be 
reconciled with an inbound functional 
acknowledgment.

Overdue Indicates that the document is waiting to be 
reconciled with an inbound functional 
acknowledgment but has exceeded the 
number of hours by which that 
acknowledgment is deemed late.

Continued on next page
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(cont.)

Status Code Description

AckErr Indicates that the document was 
acknowledged by your partner and there 
were errors, but it was accepted by your 
partner in spite of the errors.

~Ack This status is only displayed if there were 
no acknowledgments expected for this 
document and either the group or the 
interchange was partially acknowledged.

Note
If your partner is going to issue partial 
acknowledgments at the interchange or 
group level, they should also indicate 
acceptance or rejection at the transaction 
level.

Reject Indicates that the document was 
acknowledged by your partner and there 
were errors. The document was rejected by 
your partner.

Click OK.

System Response
The contents of the Out Drawer is sorted or filtered as 
specified.
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(��
�������� The Delete function is used to remove a document or group of documents 
from the system.

;����

! When a document is deleted, all the associated document information, 
tracking information, and translation report information is also deleted.

! When the last document in an interchange is deleted, the interchange 
entry is also deleted.

!
�����
� To delete a document or group of documents, complete the following steps:

���� *�����

1 From The Desk, select the current location of the document.

System Response
If you select the In Documents, ?In Documents, Out 
Documents, ?Out Documents, In Drawer, or Out Drawer 
browser, the summary dialog box for that browser is 
displayed.

2 If a summary dialog box is displayed, select the type of 
document for the appropriate partner and click VIEW.

System Response
The browser containing those documents is displayed.

3 Click DELETE.

System Response
The confirmation dialog box is displayed.

4 Click YES.

System Response
The document is deleted.
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(��
�������� If no documents are selected, the Print function prints a summary list of all 
documents in the browser. For selected documents, the Print function prints 
one of the following:

! Raw EDI data 
! Formatted version of the documents using the print translation object 

established (partner relationship 
! Summary list of those documents

!
�����
� To print a document or group of documents, complete the following steps:

���� *�����

1 From The Desk, select the current location of the document.

System Response
If you select the In Documents, ?In Documents, Out 
Documents, ?Out Documents, In Drawer, or Out Drawer 
browser, the summary dialog box for that browser is 
displayed.

2 Do the following:
! Select the type of document for the appropriate partner.
! Click VIEW.

System Response
The browser containing those documents is displayed.

3 Do you want to print a summary list of all documents?
! If yes, click PRINT to access the Print dialog box. 

Continue with step 6.
! If no, continue with step 4.

Continued on next page
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4 Do you want to print selected documents, either formatted or 
unformatted, or a summary list of selected documents?
! If yes, select a document or group of documents and click 

PRINT. Continue with step 5.

System Response
The Print Choice dialog box is displayed.

! If no, continue with step 6.

5 Select the appropriate option on the Print Choice dialog box 
and click OK.
! To print selected unformatted documents, select the 

Selected Items option.
! If you want the selected documents printed as formatted, 

select the Selected Items option and the Formatted check 
box. A print translation object must exist for the 
documents to be printed as formatted.

! To print a summary list of selected documents, select the 
Summary List of Items option.

System Response
The Print dialog box is displayed.

6 On the Print dialog box, set the appropriate options and click 
OK.

Note
The system displays the Print dialog box if you either 
selected no documents from the browser and clicked PRINT, 
or if you chose Summary List of Items from the Print Choice 
dialog box.
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(��
�������� The routing function moves a selected document or group of documents to 
the In Drawer. Documents are automatically moved from the In Documents 
or ?In Documents to the In Drawer by the system at the completion of a 
successful Export or Print. However, you might want to manually move a 
document to the In Drawer so that you could create a turnaround (response) 
document.

;���

You can only move documents to the In Drawer when In Documents or the 
?In Documents is the active browser. 

!
�����
� To move a document or group of documents, complete the following steps:

���� *�����

1 From The Desk, select the In Documents or ?In Documents.

System Response
The summary dialog box for that browser is displayed.

2 Do the following:
! Select the type of document for the appropriate partner.
! Click VIEW.

System Response
The browser containing those documents is displayed.

3 Select the documents that you want to move to the In Drawer.

4 Click MOVE.

System Response
The selected documents are moved to the In Drawer.
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(��
�������� The Copy function copies a document that was already sent successfully to 
the Workspace, so you can modify the document and resend it. The Copy 
function can only be used when Out Drawer is active. 

;���

This function can result in sending duplicate documents to a trading partner.

"�6�
����

After you modify the documents, you may want to resend them. For more 
information on resending, see Resending a Document on page 5 - 10.

!
�����
� Complete the following steps to copy a document or group of documents:

���� *�����

1 From The Desk, select the Out Drawer.

System Response
The Out Drawer Summary dialog box is displayed.

2 Select the type of document for the appropriate partner and 
click VIEW.

System Response
The Out Drawer browser is displayed.

3 Select the documents that you want to copy to the 
Workspace.

4 Click COPY.

System Response
The selected documents are copied to the Workspace.
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(��
�������� The Post function moves a selected compliant document or group of 
compliant documents to the Out Documents. A document is compliant if it 
conforms to the validation rules as defined by the translation object. A 
document is designated compliant if the Status column contains �OK.� If the 
Status column contains �NotOk,� the document is not compliant and is not 
posted.

;���

The Post function can only be used when the Workspace is active. 

!
�����
� Complete the following steps to post a document or group of documents:

���� *�����

1 From The Desk, select the Workspace.

System Response
The Workspace browser is displayed.

2 Select the compliant documents that you want to move to the 
Out Documents.

Note
A document is designated compliant if the Status column 
contains �OK.� If the Status column contains �NotOk,� the 
document is not compliant and is not posted.

Continued on next page
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3 Click POST.

System Response
The selected documents are moved to the Out Documents.
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(��
�������� The UnPost function moves a selected document or group of documents 
back to the Workspace. You can use UnPost to prevent a document from 
being sent to a trading partner or to allow the document to be modified 
before it is sent. The UnPost function can only be used when Out Documents 
is the active browser. 

;���

If you modify the document, you must repost before the system can send it.

!
�����
� Complete the following steps to UnPost a document or group of documents:

���� *�����

1 From The Desk, select the Out Documents.

System Response
The Out Documents Summary dialog box is displayed.

2 Do the following:
! Select the type of document for the appropriate partner.
! Click VIEW.

System Response
The Out Documents browser is displayed.

3 Select the documents that you want to move back to the 
Workspace.

4 Click UNPOST.

System Response
The selected documents are moved back to the Workspace.
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(��
�������� The Respond function automatically generates a response document by 
transferring data from an inbound source document. The Respond function is 
only available when the In Drawer is the currently selected browser, one or 
more documents are selected, and Turn Around translation objects exist for 
the selected documents. 

��
�

����
����%����

The Respond function creates a turnaround document, using the Turn 
Around translation object from the Partner relationship, in response to the 
currently selected documents. For instructions, see Creating a New Inbound 
Relationship on page 3 - 30. You can create a turnaround document for non-
compliant documents, or documents with a �NotOK� status, as well as 
compliant documents.

 ���6.���
����%����

The documents generated by the turnaround process are placed in the 
Workspace, where you can modify them prior to sending. 

;���

To modify a document, a Screen Entry translation object must be set up in 
the outbound relationship for the created document.

"�6�
����

For instructions on setting up an appropriate screen entry translation object, 
see Creating a New Outbound Relationship on page 3 - 42.
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� To respond to one or more documents, complete the following steps:

���� *�����

1 From The Desk, select In Drawer.

System Response
The In Drawer Summary dialog box is displayed.

2 ! Select the type of document for the appropriate partner.
! Click VIEW.

System Response
The In Drawer browser is displayed.

3 Select the document or documents for which you want to 
create a turnaround document.

4 Click RESPOND.

System Response
! The system automatically creates a turnaround document 

in response to each document you selected by using the 
Turn Around translation object that you specified in the 
Partner relationship.

! The turnaround documents produced are displayed in the 
Workspace for you to modify, if necessary, before 
posting to the Out Documents.

Reference
For instructions on posting documents, see Posting a 
Document on page 4 - 35.
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(��
�������� GENTRAN:Director allows you to import data from data files as an 
alternative to using the Document Editor to enter data directly into the 
system. To import a document, you must have a system import and/or import 
translation object for the transaction set that is imported, registered with the 
system.

"�6�
����

For more information on translation object registration, see Registering 
(Installing) a New Translation Object on page 2 - 3. 

*�������
�
���6���
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�
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Additionally, for each type of import file, you need to define an import 
specification on the Import tab in the System Configuration program that 
indicates which import or system import translation object is used to begin 
translation during the import process.

Have your system administrator map to a shared folder where the files that 
you want to import are located.

;���

Do not use Universal Naming Convention (UNC) paths.

"�6�
����

For more information on adding import specifications, see the �Imports Tab� 
section in the Administrator�s Guide. 
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To import a document, complete the following steps:

���� *�����

1 From The Desk, select the Workspace.

System Response
The Workspace browser is displayed.

2 Click IMPORT.

System Response
The Application Files to Import dialog box is displayed.

Continued on next page
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3 Select the file or files to be imported and click OPEN.

System Response
The documents are imported into the Workspace. 

The documents either have an �OK� status to indicate that 
the documents were successfully read and compliance 
checked or, if the documents failed compliance checking, 
they are marked as �NotOK.� 

Note
You may not send non-compliant documents � either delete 
those documents and re-process them from the data file, or 
correct the documents in the Document Editor if you have 
Screen Entry translation objects for them. 

Reference
For more information on correcting the documents in the 
Document Editor, see Opening and Editing a Document on 
page 4 - 7. 

Important
If you import a file and no documents are displayed in the 
Workspace, check the Audit Log.
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(��
�������� To export a document to a data file, an export translation object for the 
transaction set must be loaded into the system and registered, and set up as 
the Export translation object in the inbound relationship record for the 
partner.

"�6�
����

! For more information on translation object registration, see Registering 
(Installing) a New Translation Object on page 2 - 3.

! For more information on setting up the Export translation object, see 
Creating a New Inbound Relationship on page 3 - 30.

!
�����
� To export a document, complete the following steps:

���� *�����

1  From The Desk, Select the In Documents, ?In Documents, or 
In Drawer.

System Response
The summary dialog box is displayed for the selected 
browser.

2 ! Select the type of document for the appropriate partner.
! Click VIEW.

System Response
The appropriate document browser is displayed.

Continued on next page
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3 ! Select the document or documents that are to be 
exported.

! Click EXPORT.

System Response
The Select Export Method dialog box is displayed.

4 Select one of the following options and click OK.
! To convert all selected documents to data and write them 

to a single file, select the Export to Single File option.
! To write selected documents to the files set up in the 

partner inbound relationship, select the Export to Default 
Files option.

! To rename selected documents, select the Select File by 
Document option.

System Response
The Choose file to Export document dialog box is displayed.
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 This chapter explains how to use communications with 
GENTRAN:Director. For information about stand-alone communications, 
see Using Stand-alone Communications on page 5 - 20.
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The Communications feature enables you to send and receive data from your 
trading partners. GENTRAN:Director uses the Communicator to handle 
your communication needs.

������
����� The following table describes the system process that occurs when you send 
an interchange:

��
�� $���
������

1 The documents in the selected interchange are batched into 
EDI envelopes, and the required control numbers are 
generated from the information in the partner profile.

2 After the interchange is built, it is listed in the Interchange 
browser. For instructions on viewing an interchange, see 
Viewing Interchanges on page 6 - 6.

3 If the communication fails because there is no profile set up, 
the interchange and documents are left in a �Ready to send� 
status.
If communication fails because there is no modem, the 
interchange and documents are left in a �Queued� status. 
Note
No user action is required at this point. Interchanges that 
failed to send are automatically sent as part of the next 
transmission session.

4 After communication is successful, the documents are moved 
to the Out Drawer and the interchange status is set to �Sent.�
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!
�����
� To send a selected document or set of documents, complete the following 
steps:

���� *�����

1 From The Desk, select Out Documents. 
System Response
The Out Documents Summary dialog box is displayed.
Note
If the documents to be sent are not in Out Documents, you 
must post the documents from the Workspace to Out 
Documents.
Reference
For instructions on posting, see Posting a Document 
on page 4 - 35.

Continued on next page
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2 Do the following:
! Select the type of document for the partner.
! Click VIEW.

System Response
The Out Documents browser is displayed.

3 Select the document or documents that need to be sent. 
Note
To select a group of documents click the first document, 
press SHIFT, and click the last document. To select several 
documents that are not adjacent to each other in the Out 
Documents list, press and hold CTRL while clicking each 
document.

Continued on next page
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4 Click SEND.
System Response
The GENTRAN:Director dialog box is displayed.

5 Click YES to start the transmission session.
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(��
�������� You can send all the documents in Out Documents using one of the 
following methods:

! Selecting the Transmit icon on The Desk.
! Accessing the Out Drawer browser and clicking SEND.

!
�����
� To send all documents, complete one of the following sets of instructions:

���� *�����

 ��	����

1 From The Desk, click the Transmit icon.
System Response
The Communication Session dialog box is displayed.

Continued on next page
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2 Do the following:
! Select one or more profiles for which you want to send 

data.
! Click OK to start a communication session to send data. 

Click CANCEL if you want to cancel the transmission 
session.

Note
All documents currently located in the Out Documents, for 
which the partner is using one of the selected profiles, is 
sent.
If there are no documents in the Out Documents or 
interchanges with a �Ready� status in the Interchanges 
browser, a receive-only session is performed and the In 
Documents and ?In Documents are updated with any data 
received.

 ��	����

1 From The Desk, select Out Documents.
System Response
The Out Documents Summary dialog box is displayed.
Note
If the documents to be sent are not in Out Documents, you 
must post the documents from the Workspace to Out 
Documents.
Reference
For instructions on posting, see Posting a Document on page 
4 - 35.
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2 Do the following:
! Select the type of document for the partner.
! Click VIEW.

System Response
The Out Documents browser is displayed.

3 Do not select any documents. If any documents are selected, 
press CTRL and click on the documents to deselect them.

4 Click SEND.
System Response
The GENTRAN:Director dialog box is displayed.

5 Click YES to start the transmission session.
Note
All the documents in the Out Documents are sent to the 
appropriate profiles.
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(��
�������� After a document is successfully enveloped and sent, it is stored in the Out 
Drawer. If you need to resend the document, you must make a new copy of 
the document and execute the Send process again.

!
�����
� To resend a document, complete the following steps:

���� *�����

1 From The Desk, select Out Drawer.
System Response
The Out Drawer Summary dialog box is displayed.

2 Do the following:
! Select the type of document for the partner.
! Click VIEW.

System Response
The Out Drawer browser is displayed.

Continued on next page
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3 Select the document or documents that need to be resent. 
Note
To select a group of documents click the first document, 
press SHIFT, and click the last document. To select several 
documents that are not adjacent to each other in the Out 
Drawer list, press and hold CTRL while clicking each 
document.

4 Click COPY.
A copy of the documents is made and placed in the 
Workspace.

5 From The Desk, select Workspace.
System Response
The Workspace browser is displayed.

6 Make any necessary changes to the documents.
Note
You can modify a document only if there is a Data Entry 
translation object for the partner relationship.

Continued on next page
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7 Do the following:
! Select the documents. 
! Click POST.

System Response
The documents are posted to the Out Documents browser.

8 From The Desk, select Out Documents.
System Response
The Out Documents Summary dialog box is displayed.

9 Do the following:
! Select the type of document for the partner.
! Click VIEW.

System Response
The Out Documents browser is displayed.

Continued on next page
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10 Do the following:
! Select the documents.
! Click SEND.

System Response
The GENTRAN:Director dialog box is displayed.

11 Click YES to start the transmission session.
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(��
�������� Any time a Send session is executed, the system automatically checks your 
Mailbox for any information waiting to be received. If any data is in the 
Mailbox, it is received without any action from you.

If you need to receive information without first sending anything, you must 
initiate a receive-only session using one of the following methods:

! Selecting the Receive command from the Commands menu.
! Accessing the In Documents browser and clicking RECEIVE.

!
�����
� To start a receive-only session, complete one of the following sets of 
instructions.:,

���� *�����

 ��	����

1 From the Commands menu, select Receive.
System Response
The system initiates a receive-only session.

 ��	����

1 From the Tools menu, select In Documents. 
System Response
The In Documents Summary dialog box is displayed. 

Continued on next page
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2 Do the following:
! Select the type of document for the partner.
! Click VIEW.

System Response
The In Documents browser is displayed.

3 Click RECEIVE.
System Response
The Communication Session dialog box is displayed.

Continued on next page
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4 Do the following:
! Select one or more profiles for which you want to send 

data.
! Click OK to start a communication session to send data. 

Click CANCEL if you want to cancel the transmission 
session.

Note
This action initiates a receive-only session and updates the In 
Documents or ?In Documents with any data received as a 
result of that session.
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(��
�������� The Send Queue displays a list of documents that are currently queued to be 
sent, and enables you to perform document-based tasks similar to those 
available in the main system browsers.

;���

The Send Queue contains documents only if a transmission session failed. 
The documents remain in the Send Queue until a successful transmission 
session occurs; no user intervention is required.

!
�����
� To view the Send Queue, complete the following steps:

���� *�����

1 From the View menu, select Send Queue.
System Response
The Send Queue browser is displayed.

2 Select a document or a group of documents.
Continued on next page
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3 Use the command buttons on the Send Queue browser to perform the 
following functions:

IF you want to... THEN click...

view the content of a
! single selected document in raw EDI data, 
! formatted document, 
! translation report,

VIEW

print the selected documents or summary of the 
documents,

PRINT

delete the selected documents, DELETE

sort the displayed columns in the document list, SORT
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(��
�������� The Process File feature invokes the post-communications process with any 
data file, just as if the file was received through a communication session. 
This enables you to process a data file from a diskette or anywhere on your 
system.

!
�����
� To send a data file to the Communicator, complete the following steps:

���� *�����

1 From the Commands menu, select Process File.
System Response
The Process File dialog box is displayed.

2 Select the data file, and then click OPEN.
System Response
The system immediately invokes the post-communications 
process with the file, just as if the file was received through a 
communication session.
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(��
�������� A stand-alone communications module is provided with 
GENTRAN:Director. The program SENDFILE.exe is used to browse and 
select a communications profile, such as COMMERCE Exchange. It can 
also be used to test communications, and is recommended for use when 
changing a password or getting quick reports. 

�0;$=(90��1�
�
��

%

The SENDFILE.exe program can be run from GENTRAN:Director program 
group. To launch the program, from the Windows start menu select 
Programs>COMMERCE:Connection>Send file. The Communication 
Options dialog box is displayed. 

"�6�
�����

For information about using SENDFILE.exe to send data, see Sending 
Command Files to the INS Network on page 5 - 102.

For information about using SENDFILE.exe to change passwords, see 
Changing Passwords on page 5 - 103. 
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(��
�������� A communication port is the physical serial port on your PC to which your 
modem is connected. You must have at least one port definition on your 
system for the Communicator to run. However, you can configure as many 
definitions of the four communication ports (COM1, COM2, COM3, and 
COM4) on your system as necessary. The port profiles you establish can also 
be copied and modified, if necessary.

;���

If you have one modem, you can only configure the physical port to which 
the modem is attached. However, GENTRAN:Director enables you to set up 
multiple port profiles for each physical communication port. This enables 
you to define:

! Different modem speeds and initialization strings for the same port. 
! Specific definitions for each network you will be accessing.

!
�����
� To create or edit a communication port profile, complete the following steps:

���� *�����

1 From the Tools menu:
! Select Communications.
! Select Ports from the Communications submenu.

System Response
The Communication Port Setup dialog box is displayed.
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2 Do you want to create or modify a new port profile?
! If you want to create a new profile, click NEW and continue 

with step 3.

System Response
The New Port Profile dialog box is displayed.
! If you want to edit an existing profile, select the port profile 

you want to modify, click SETUP, and continue with step 4.

System Response
The Port Setup dialog box is displayed.

3 ! In the Name box, type a unique name for the new port 
profile. 

! Click OK and continue with step 4.

System Response
The Port Setup dialog box is displayed.

4 From the Port drop-down list, select the serial port to which 
your modem is connected on this communication controller. 
Values
! COM1
! COM2
! COM3
! COM4

Note
The system uses this port to send data to and from your modem.

Continued on next page
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5 From the Baud drop-down list, select the baud rate of your 
modem. 
Values
! 1200 ! 9600 ! 28400
! 2400 ! 19200

Note
The baud rate is the transmission speed of the modem line. The 
default baud rate is �19200.� If you are unsure about the rate at 
which your modem operates, refer to the operations manual for 
your modem.

6 From the Line drop-down list, select the telephone dialing 
method that your modem will use. 
Values
! Tone - touch tone leased dialing. This is the default.
! Pulse - pulse dialing.

7 In the Initialization box, type the command(s) to initialize your 
modem. 
Note
These commands will vary depending on your modem�s type. If 
you do not know the modem initialization command(s), refer to 
the operations manual for your modem.

8 Select the flow control option that corresponds to the flow 
control commands you set on your modem.
Note
These options control the flow of information from your PC to 
your modem, and from your modem to your PC.

9 Click OK.
System Response
The port profile setup is saved and the Communication Port 
Setup dialog box is displayed. 
Click CLOSE  to exit the Communication Port Setup dialog box
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(��
�������� The copy port profile feature allows you to save a port profile as a different 
name and make modifications to that port profile. This keeps you from 
having to create a new port profile from scratch.7

!
�����
� To copy a communication port profile, complete the following steps:

���� *�����

1 From the Tools menu:
! Select Communications.
! Select Ports from the Communications submenu.

System Response
The Communication Port Setup dialog box is displayed.

Continued on next page
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2 Do the following:
! Select the port profile you want to copy.
! Click COPY.

System Response
The Copy Port Profile dialog box is displayed.

3 Do the following:
! Type a new port profile name. 
! Click OK.

System Response
The port is copied under the new name and the Port Setup 
dialog box is displayed.

4 Make the appropriate modification to the port profile.
Reference
For more information on modifying communication port 
profiles, see Procedure on page 5 - 21.

�

>�����? *�����
���������	
��
�
���
��	���������
�����	�� ��������� & � �&



$����������%%����
�����!�
��!
�6���� 1"������99���������"
,�$��������99������������������/�$�"

!
�����
� To delete a communication port profile, complete the following steps:

���� *�����

1 From the Tools menu:
! Select Communications.
! Select Ports from the Communications submenu.

System Response
The Communication Port Setup dialog box is displayed.

2 ! Select the port profile you want to delete. 
! Click DELETE.

System Response
The system prompts you to confirm the delete operation.

3 Click YES to remove the port profile.
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(��
�������� The communication profile contains all of the relevant information needed to 
establish a communication session. You must define at least one 
communication profile on your system, but you can define multiple 
communication profiles, if necessary.

You need to create a new communication profile if you will be using another 
network, or communicating directly with your trading partners.

A communication profile must be linked to a partner profile in Partner Editor 
before the Communicator can use that profile to communicate. 

"�6�
����

For more information on linking a communication profile to a partner 
profile, see Creating a New Partner Definition on page 3 - 27.
���������	
��
�
���
��	���������
�����	�� ��������� & � �)



�
�
�����
���0���������%%����
�����!
�6���� 1"������99���������"
!
�����
� To create or edit a communication profile, complete the following steps:

���� *�����

1 From the Tools menu:
! Select Communications.
! Select Profile from the Communications submenu.

System Response
The Communication Profile Setup dialog box is displayed.

2 Do you want to create or modify a new communications profile?
! If you want to create a new profile, click NEW and continue with step 3.

System Response
The New Profile dialog box is displayed.
! If you want to edit an existing profile, select the profile you want to modify, click 

SETUP, and continue with step 4.

System Response
The Profile Setup dialog box is displayed.

Continued on next page
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3 ! In the Name box, type the unique name of the new communication profile. 
! Click OK, and continue with step 4.

System Response
The Profile Setup dialog box is displayed.

4 From the Profile Type drop-down list, select a type for the communication profile.
Values
! Asynchronous - this is the default.
! Bisynchronous
! Commerce:Exchange
! File Copy
! TCP/IP
! FTP
;���

TCP/IP is not supported on the Windows ME operating system.
Continued on next page
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5 Complete the boxes that are activated.
Fields on this dialog box are activated or deactivated depending on which Profile Type 
you select. The following table lists the fields on the Profile Setup dialog box.

Field Definition

Dial Retries Allows you to specify the number of times you want the 
system to redial the host (network) modem number if the 
host modem is busy or does not respond. 
Note
You can specify any number of redial times up to �99�.

Session Retries Allows you to specify the number of times you want the 
system to initiate a host (network) session if a 
session-related error occurs.
Note
You can specify any number of redial times up to �99�.

Modem Number Allows you to specify the phone number of the host 
(network) modem.
Note
You will need to define the exact number that the system 
needs to dial. Therefore, if the system must dial a �9� or 
other number to reach an outside phone line, you must 
include that prefix in this field. Follow the prefix with a 
comma before the phone number. For example, 
9,16145550000.

Port Profile Allows you to select the port profile.

File Copy Name Allows you to specify the path and file name of the file to 
which the output of the communication session is written.

IP Address Allows you to type the destination IP Address in dotted 
decimal notation. For example, 199.3.19.29.

Socket Allows you to type the socket number for the destination 
network. For example, 3244.

Continued on next page
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6 Did you select a Profile Type of Asynchronous, Bisynchronous, or TCP/IP?
! If yes, continue with the �Creating a logon script� section of this table.
! If no, continue with the �Configuring Commerce:Exchange� section of this table.

;���

TCP/IP is not supported on the Windows ME operating system.

�
�
�����
���������
���

1 For Asynchronous, Bisynchronous, or TCP/IP profile types, click LOGON SCRIPT to 
create a logon script.
System Response
The Logon Script window is displayed.

2 Do you currently have a logon script on your system that you could import and modify, 
instead of creating a new script?
! If yes, click IMPORT! to import the logon script.
! If no, type the necessary script commands and variables in the Logon Script window.

Notes
! Sterling Commerce provides predefined scripts when you install 

GENTRAN:Director. You can continue importing scripts until you find the script 
with appropriate comments. The system overlays the previous script each time you 
import. You can modify the chosen script (if necessary) and save it, instead of 
creating your own script.

! If you are going to be creating your own script, see Communicator Script Language 
in the online Help for more information.

! If the predefined script contains substitution variables, you only need to provide the 
variable values on the Script Variable Substitution dialog box. For more information, 
see Substituting Script Variables on page 5 - 46.

3 When you finish creating or importing the script, click SAVE!.
Note
When you modify a predefined script, we strongly recommend that you use the Save As! 
function to save it as a different name. Other wise, the script could be overwritten when 
you install a new version of GENTRAN:Director. The default file extension for scripts is 
�.SCR�.

Continued on next page
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1 For Asynchronous, Bisynchronous, or TCP/IP profile types, click RECEIVE ONLY SCRIPT 
to create a receive only script.

;���

TCP/IP is not supported on the Windows ME operating system.
System Response
The Receive Only Script window is displayed.

2 Do you currently have a receive only script on your system that you could import and 
modify, instead of creating a new script?
! If yes, click IMPORT! to import the receive only script.
! If no, type the necessary script commands and variables in the Receive Only Script 

window.

Notes
! Sterling Commerce provides predefined scripts when you install 

GENTRAN:Director. You can continue importing scripts until you find the script 
with appropriate comments. The system overlays the previous script each time you 
import. You can modify the chosen script if necessary and save it, instead of creating 
your own script.

! If you are going to be creating your own script, see Communicator Script Language 
in the online Help for more information.

! If the predefined script contains substitution variables, you only need to provide the 
variable values on the Script Variable Substitution dialog box. For more information, 
see Substituting Script Variables on page 5 - 46.

3 When you finish creating or importing the script, click SAVE!.
Note
When you modify a predefined script, we strongly recommend that you use the Save As! 
function to save it as a different name. Other wise, the script could be overwritten when 
you install a new version of GENTRAN:Director. The default file extension for scripts is 
�.SCR�.

Continued on next page
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1 For Asynchronous, Bisynchronous, or TCP/IP profile types, click SEND RECEIVE SCRIPT 
to create a send receive script.

����

TCP/IP is not supported on the Windows ME operating system.
System Response
The Send Receive Script window is displayed.

2 Do you currently have a send receive script on your system that you could import and 
modify, instead of creating a new script?
! If yes, click IMPORT! to import the send receive script.
! If no, type the necessary script commands and variables in the Send Receive Script 

window.

Notes
! Sterling Commerce provides predefined scripts when you install 

GENTRAN:Director. You can continue importing scripts until you find the script 
with appropriate comments. The system overlays the previous script each time you 
import. You can modify the chosen script (if necessary) and save it, instead of 
creating your own script.

! If you are going to be creating your own script, see Communicator Script Language 
in the online Help for more information.

! If the predefined script contains substitution variables, you only need to provide the 
variable values on the Script Variable Substitution dialog box. For more information, 
see Substituting Script Variables on page 5 - 46.

3 When you finish creating or importing the script, click SAVE! to save the script for this 
profile.
Note
When you modify a predefined script, we strongly recommend that you use the Save As! 
function to save it as a different name. Other wise, the script could be overwritten when 
you install a new version of GENTRAN:Director. The default file extension for scripts is 
�.SCR�.

Continued on next page
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1 Did you select a Profile Type for Commerce:Exchange?
! If yes, click CONFIGURE EXCHANGE to configure those options.
! If no, continue with the �Setting advanced options� section of this table.

System Response
The Commerce:Exchange dialog box is displayed.
Reference
For more information, see the COMMERCE:Connection® for the Internet 
documentation.
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1 On the Profile Setup dialog box, click ADVANCED>>.
System Response
The fields in the following table are appended to the Profile Setup dialog box.
Note
If your data needs to be in a specific format, you can use the XPROCESS utility program 
to manipulate the data you send. For information on how to use the XPROCESS 
program, see XPROCESS Utility Program on page 5 - 37.

Field Definition

Pre-Processor Enables you to specify a program name with arguments 
that are called for every file to be sent. Each send filespec 
will be appended to the command line. 
Example
You can specify a program to be run against every file to 
be sent before communication starts.

Continued on next page
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(cont.)

Pre-Post Processor Enables you to specify a program name with arguments 
that will be called for every file received. Each receive 
filespec will be appended to the command line.
Example
You can specify a program that will be run against every 
file received before the post-processor processes it.

Post Processor Enables you to specify the program that will process the 
received data. 
Example
You can specify a program that will process all received 
data in the system and update statuses, etc.
Caution
Do not change the default value �commpost.exe� unless 
you are instructed to do so by GENTRAN:Director 
Customer Support.

Trace1 Enables a �datascope� trace that shows every byte sent or 
received during a session.
Warning
If Trace1 or Trace2 is enabled, the trace information is 
written to the communication log file.

You should only select the Trace1 and/or Trace2 check box 
to debug communication problems. Clear these check 
boxes once the problem is resolved.

Trace2 Enables a function level trace to show every function 
called during a session.
Warning
If Trace1 or Trace2 is enabled, the trace information will 
be written to the communication log file.

You should only select the Trace1 and/or Trace2 check box 
to debug communication problems. You should clear these 
check boxes once the problem is resolved.

Continued on next page

�

>�����? *�����
���������	
��
�
���
��	���������
�����	�� ��������� & � �&



�
�
�����
���0���������%%����
�����!
�6���� 1"������99���������"
�
5�����	����%%����
������
�6���

1 Click OK.
System Response
The profile setup is saved and the Communication Profile Setup dialog box is displayed.

2 Click CLOSE.
System Response
The Communication Profile Setup dialog box is closed.
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(��
�������� The XPROCESS utility program enables you to manipulate data that you 
send or receive into a specific format. 

If you specify this program in the Pre-Processor field of the Profile Setup 
dialog box (Advanced section), it will manipulate the data you send based on 
the specified options. 

If you specify this program in the Pre-Post Processor field of the Profile 
Setup dialog box (Advanced section), it will manipulate the data that was 
received based on the specified options.

When you specify the XPROCESS program in either the Pre-Processor or 
Pre-Post Processor field, you must also specify an option using the following 
format: XPROCESS - n (n = value from 0 to 13). See below for a list of 
options.

E!"��0��
�������

The available XPROCESS program options are listed in the following table:

������ $�6������� 2	
��.����.��

-0 Converts any specified hex 
character to any other specified 
hex character.
The syntax for the hex values is 
�0(zero)x� followed by the hex 
code. For example, for 
hexadecimal A, you would type 
�0x41�.
Note
You only need to specify a 
[filename] if you are running 
XPROCESS from a command 
line.

XPROCESS -0 
[hexValue1] [hexValue2] 
[filename] 

Continued on next page
���������	
��
�
���
��	���������
�����	�� ��������� & � �)



E!"��0���������.�!
��

%
-1 Appends the file you specify to 
the beginning of the data.

XPROCESS -1 
[filename] 

-2 Replaces tilde (~)/carriage return 
(0D)/line feeds (0A) with 
carriage returns (0D).

XPROCESS -2

-3 Replaces all carriage returns 
(0D) with tildes (~) and drops 
any line feeds (0A).

XPROCESS -3

-4 Drops all carriage returns (0D) 
and line feeds (0A).

XPROCESS -4

-5 Drops all carriage returns (0D) 
and line feeds (0A) and adds hex 
0x1A to the end of the file.

XPROCESS -5

-6 Removes all hex 0x1A from the 
file.

XPROCESS -6

-7 Adds GM header/trailer records 
and drops all carriage returns 
(0D) and line feeds (0A).

XPROCESS -7

-8 Replaces every tilde (~), carriage 
return (0D), and line feed (0A) 
with line feed (0A).

XPROCESS -8

-9 Replaces every line feed (0A) 
with tilde (~).

XPROCESS -9

-10 Replaces all carriage returns 
(0D) with carriage return (0D) 
and line feed (0A).

XPROCESS -10

-11 Replaces a string of hexadecimal 
characters with another string of 
hexadecimal characters.
Example
xprocess -11 0x7e0x0d0x0a 
0x7e0x0d

XPROCESS -11
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-12 Removes all occurrence of a 
hexadecimal string from a file.
Example
xprocess -12 0x0d0x0a

XPROCESS -12

-13 Inserts a hexadecimal string at a 
specified increment (Nbr bytes) 
in the input file.
Example
xprocess -13 40x0d0x0a

XPROCESS -13
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(��
�������� The VATPRINT utility is an external data processor used to generate Value 
Added Tax (VAT) Transmission Reports when sending or receiving 
TRADACOMS or UK EDIFACT data. This report is generated in the format 
defined by UK Customs and Excise and the UK Article Number Association 
(ANA). 

������:*�!"(;� You invoke the VATPRINT utility by entering the utility name and 
parameters in the Pre-Processor and/or Pre-Post Processor fields of the 
Communication Profile Setup screen.The Pre-Processor is used for sending 
and the Pre-Post Processor is used for receiving.

�.��
1 The syntax of the VATPRINT utility is:

VATPRINT [option] [Print_filename] [Attachment_filename]

!


%���
� The VATPRINT utility has the following parameters:

(��% $���
������

Option ! /p  Writes the report to the 
printer.

! /f  Creates or appends the 
report to a file.

Print_filename The name of the file to create or 
append. Used only with the /f 
option. If the Print_filename 
contains an asterisk (*), then the 
asterisk will be replaced with the 
current date and time in the 
format 
YYYYMMDDHHMMSS.

Continued on next page
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%��� In this example, you want to generate a VAT report from Interoffice Ltd., a 
Trading Partner in the UK who uses the UK EDIFACT standards. You enter 
the command line shown below in the Pre-Post Processor field on the 
Communication Profile assigned to Interoffice. When messages are received 
from Interoffice, a VAT report is generated and appended to a file in the 
C:\Reports directory.

Command line:

VATPRINT.EXE /f C:\Reports\VATreport.txt 

0

�
�7
������ The VATPRINT utility records processing errors in the file Vat.err. This file 
Is stored in the bin directory where you installed GENTRAN:Director. 
Errors are time and date stamped, and the most recent error is located at the 
end of the file.

�����
���
��
��

��
:�
�����

The following standards versions are supported with this release of 
GENTRAN:Director:

! TRADACOMS V9
! EDIFACT 90.1

Attachment_filename The name of the file containing 
the EDI messages that you want 
the VAT Report for.  Used only 
when the utility is invoked 
manually from a Command 
Prompt.  When used as a Pre-
Processor or Pre-Post Processor 
within a Communication Profile, 
the currently processing file 
name is substituted dynamically 
each time the utility is run.

(��% $���
������
���������	
��
�
���
��	���������
�����	�� ��������� & � %�



�������	��:*�!"(;��������.�!
��

%
�����
���
 ���
���

TRADACOMS Credit Notes and TRADACOMS and EDIFACT INVOIC 
messages are the only messages that are supported with this release of 
GENTRAN:Director.
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(��
�������� The copy profile feature enables you to save a profile as a different name and 
make modifications to the profile, instead of creating a new profile from 
scratch.

!
�����
� To copy a communication profile, complete the following steps:

���� *�����

1 From the Tools menu:
! Select Communications.
! Select Profile from the Communications submenu.

System Response
The Communication Profile Setup dialog box is displayed.

Continued on next page
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2 ! Select the profile you want to copy.
! Click COPY.

System Response
The Copy Profile dialog box is displayed.

3 ! Type the new profile name. 
! Click OK.

System Response
The profile is copied under the new name and the Profile 
Setup dialog box is displayed.

4 Make any necessary changes to the profile.
Reference
For more information on modifying communication profiles, 
see Creating and Editing Communication Profiles on page 
5 - 27.
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!
�����
� To delete a communication profile, complete the following steps:

���� *�����

1 From the Tools menu:
! Select Communications.
! Select Profile from the Communications submenu.

System Response
The Communication Profile Setup dialog box is displayed.

2 ! Select the profile you want to delete.
! Click DELETE.

System Response
The system prompts you to confirm the delete operation.

3 Click YES to remove the profile.
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(��
�������� Script variables are used mainly in the predefined scripts that Sterling 
Commerce provides to you, but you can also use script variables to create 
new scripts. If you use a predefined script, you must define the correct value 
for each variable used in the script. Each variable can be used in all the 
scripts for a communication profile. These scripts include Logon, Receive 
Only, and Send Receive.

You can edit a variable in a predefined communication script in the 
following ways:

! Manually edit a variable in the actual scripts. 
! Override the value assigned to a variable by defining the variable on the 

Script Variable Substitution dialog box.

01
%���

If you send data to a trading partner via COMMERCE:Network, you can 
manually type in your network mailbox and password into the actual scripts. 
You can also access the Script Variable Substitution dialog box, type your 
mailbox in the %var1% (variable 1) field, and type your password in the 
%var2% (variable 2) field.

"���%%���
����

We recommend that you use the Script Variable Substitution dialog box 
instead of editing the actual scripts whenever possible.
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�����
� To substitute script variables, complete the following steps:

���� *�����

1 From the Tools menu:
! Select Communications.
! Select Profile from the Communications submenu.

System Response
The Communication Profile Setup dialog box is displayed.

2 ! Select the profile you want to modify.
! Click SETUP.

System Response
The Profile Setup dialog box is displayed.

Continued on next page
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3 Click SCRIPT VARIABLES.
System Response
The Script Variable Substitution dialog box is displayed.

4 Type the actual value of the variable(s) you want to define.
Note
The %var% fields enable you to override the value assigned 
to a variable (%var1% through %var8%) by defining the 
variable on this dialog box. 

5 Click OK to exit the Script Variable Substitution dialog box.

6 Click OK to exit the Profile Setup dialog box.
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(��
�������� File Transfer Protocol (FTP) enables you to transfer and receive files from a 
host computer. FTP scripts are not shipped with GENTRAN:Director. To use 
FTP, you must create those scripts.

�=�!���
������	
�
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�
��

The following table shows the scripts that you must create before you can 
use FTP. 

��
����;
%� ��
�����.��

FTPlg.scr Logon

FTPro.scr Receive Only

FTPsr.scr Send/Receive
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� To create an FTP profile, complete the following steps: 

���� *�����

1 From the GENTRAN:Director Main Menu Bar:
! Select Tools.
! Select profile from the Communications sub-menu.

System Response
The Communication Profile Setup dialog box is displayed.

2 Click NEW. 
System Response
The new profile dialog box is displayed.

3 Type FTP as the new profile name, and click OK.
System Response
The Profile Setup dialog box is displayed.

4 Select FTP from the Profile Type drop-down list.
System Response
The dialog box is displayed.

5 Enter an IP Address in the IP Address field.
Continued on next page
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6 Click LOGON SCRIPT.
System Response
The Logon Script - New dialog box is displayed.

7 Type the following as your logon script:

;Logon Script - FTP 

The Logon Script - New dialog box should look like the following.

8 Click SAVE!.
System Response
The Save As Script dialog box is displayed.

9 Enter FTPlg.scr as the file name, and click SAVE.
System Response
The Profile Setup - New dialog box is displayed.

10 Click RECEIVE ONLY SCRIPT...
System Response
The Receive Only - New dialog box is displayed.

Continued on next page
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11 Type the following as your Receive Only script:

;RO Script - FTP
rcvfile ftp %EDIRCV% "remotefilename"
ftpdelete "remotefilename"

Where �EDIRCV� is a substitution variable that represents the 
filename of an  FTP file received into your system, and 
�remotefilename� is the name of the file that you want to retrieve 
from the FTP server.
System Response
The Receive Only - New dialog box should look similar to the 
following.

12 Click SAVE!. 
System Response
The Save As Script dialog box is displayed.

13 Enter FTPro.scr as the file name and click SAVE.
System Response
The Profile Setup - New dialog box is displayed.

Continued on next page
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14 Click SEND RECEIVE SCRIPT.
System Response
The Send Receive Script - New dialog box is displayed.

15 Type the following as your Send Receive script:

;SR Script - FTP
sndloop
   sndfile ftp %EDISND%
   sndok
endloop
rcvfile ftp %EDIRCV%"somefilename"
ftpdelete "somefilename"

System Response
The Send Receive Script - New dialog box should look similar to 
the following.

16 Click SAVE!. 
System Response
The Save As Script dialog box is displayed.

Continued on next page
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17 Enter FTPsr.scr as the file name, and click SAVE.
System Response
The Profile Setup - New dialog box is displayed.

18 Click OK.
System Response
The Communication Profile Setup dialog box is displayed. Note 
that FTP has been added to the Profiles list.
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(��
�������� OFTP is the Odette File Transfer Protocol. If your network supports OFTP, 
you can configure GENTRAN:Director so that the communications system 
uses OFTP to transfer files over asynchronous communication lines.

�=�!���
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�
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In GENTRAN:Director, the following OFTP-specific communication scripts 
are provided:

;���

The communication scripts are located in the
CommScr\Samples folder under the folder where GENTRAN:Director is 
installed on your machine. The default is location is Program Files\Sterling 
Commerce\GENTRAN Director.

�=�!���%%����
�����

��
�����
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OFTPLG.scr Logon Script

OFTPRO.scr Receive Only Script

OFTPSR.scr Send Receive Script
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The stages for setting up the GENTRAN:Director system to use OFTP are 
listed in the following table:

��
�� $���
������

1 Set up a communication profile for the network.

Reference
For more information, see Building a Network Communications 
Profile on page 5 - 58.

2 Import the OFTP-specific scripts.

Note
The scripts are designed to either send and receive data or 
receive data only.

Reference
 For more information, see Building a Network 
Communications Profile on page 5 - 58.

3 Create a new trading partner relationship for this trading 
partner.

Reference
For more information, see the Creating a New Outbound 
Partner Relationship on page 5 - 63.

4 Create your OFTP destination table by using the 
GENTRAN:Director Partner Editor.

Reference
For more information, see the Creating a Destination Table on 
page 5 - 75.

5 Connect to the network.
& � &' �����������������������������������������������������������������������	
��
�
���
��	���������
�����	��



!
��

����6�
��.���%�������
������6���

����
���(������/����;"��9�����(��������/���������

8�6�
��.�������� Before you begin setting up the GENTRAN:Director system to use OFTP, 
you must have the following information:

! Your OFTP ID. This is assigned by your network�some networks use 
an EDI User ID or ANA Code.

! Your OFTP password.This is initially assigned by your network but 
you may have changed it.

! Your trading partner�s OFTP ID.

�=�!�($ A network user is assigned an OFTP ID. This identifier is a 25-digit code 
that is typically an EDI User ID, ANA Code, or other assigned network 
number.

�=�!��
��,�
� The network also assigns a password, which is usually set to �PASSWORD� 
initially.

"���%%���
����

Change your password at regular intervals.
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!
�����
�  To create the network communication profile, complete the following steps:

���� *�����

1 From the Tools menu:

! Select Communications.
! Select Profile from the Communications submenu.

System Response
The Communication Profile Setup dialog box is displayed.

2 Click NEW to create a new communications profile.

System Response
The New Profile dialog box is displayed.

Continued on next page
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3 ! In the Name box, type a unique name for the new 
communication profile.

! Click OK.

System Response
The Profile Setup dialog box is displayed.

4 Verify that the Profile Type list contains �Asynchronous� as 
the type of the communication profile.

5 In the Dial Retries box, type the number of times you want the 
system to redial the host (network) modem number if the host 
modem is busy or does not respond. 

Note
You can specify any number of redial times up to 99.

6 In the Session Retries box, type the number of times you want 
the system to initiate a host (network) session if a 
session-related error occurs.

Note
You can specify any number of redial times up to 99.

7 In the Modem Number box, type the phone number of the 
host (network) modem.

8 From the Port Profile list, select the appropriate port profile 
for your system.

Continued on next page
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9 Click LOGON SCRIPT to import a logon script.

System Response
The Logon Script window is displayed.

10 Do the following:
! Click IMPORT! to import the logon script.
! Select �OFTPLG.scr� as the Logon Script.
! Click OK.

System Response
The script is imported for this communication profile.

11 Make any necessary changes to the script and save the script 
using the SAVE! command.

Note
The OFTPLG.scr script is provided to connect to the INS 
Network (Tradanet). 

! You need to modify the handshaking sequence for the 
specific network to which you are connecting. 

! Some networks may also require a PAD Password and/or 
PAD parameters to be set in the script. You can do so by 
sending the PAD Password in the required script sequence 
and using the SET command to modify the PAD 
parameters.

12 Click RECEIVE ONLY SCRIPT to import a receive only script.

System Response
The Receive Only Script window is displayed.

13 Do the following:
! Click IMPORT! to import the receive only script.
! Select �OFTPRO.scr� as the Receive Only Script.
! Click OK.

System Response
The script is imported for this communication profile.

14 Make any necessary changes to the script and save the script 
using the SAVE! command.

Continued on next page
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15 Click SEND RECEIVE SCRIPT to import a send receive script.

System Response
The Send Receive Script window is displayed.

16 Do the following:
! Click IMPORT! to import the send receive script.
! Select �OFTPSR.scr� as the Send Receive Script.
! Click OK.

System Response
The script is imported for this communication profile.

17 Make any necessary changes to the script and save the script 
using the SAVE! command.

18 Click SCRIPT VARIABLES.

System Response
The Script Variable Substitution dialog box is displayed.

19 Do the following:
! In the %var1% box, type your OFTP ID.
! In the %var2% box, type your OFTP password.
! Click OK to save the variables and exit the dialog box.

Note
The system substitutes the value that you specify for each of 
these fields wherever that variable is in the script.

Continued on next page
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20 Click OK to save the profile setup.

System Response
The Communication Profile Setup dialog box is displayed.

21 Click CLOSE to exit the Communication Profile Setup dialog 
box.
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(��
�������� Rather than creating a new trading partner, you can modify an existing 
partner relationship. To modify an existing partner relationship, you need to 
modify the following fields in the interchange envelope:

! Sender ID. This field should contain your OFTP ID, as assigned by the 
network.

! Receiver ID. This field should contain your trading partner�s OFTP ID.

;���

Other networks may not require the OFTP ID to be part of the envelope. 
These networks may instead use the ANA User ID or other EDI Number that 
they assign.

If you need to create a new outbound partner relationship, complete the steps 
in the following procedure.
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� To create an outbound relationship to use OFTP, complete the following 
steps:
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1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

2 Click NEW.

System Response
The Partner Definition - New dialog box is displayed.

3 In the Profile ID box, type a unique alphanumeric Profile ID 
for this partner.

4 In the Name box, type the partner name.

5 In the EDI Code box, type the EDI identifier for this partner.

Note
The system uses this identifier during inbound processing to 
select the correct partner.

Continued on next page
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6 If necessary, in the Application Code box, type an application 
code to identify this partner.

Note
The system uses this identifier during outbound import 
processing to select the correct partner.

7 From the Comm. Profile list, select the predefined 
communications setup that you are using for inbound and 
outbound processing.

8 After you enter all the partner definition information, click 
SAVE.

9 Click EXIT to return to the Partner Editor dialog box.

Note
To complete the partner profile for use with OFTP you need 
to define an outbound relationship.

Continued on next page
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1 ! Select the partner profile for which you want to create an 
outbound relationship.

! Click OUTBOUND.

System Response
The Outbound Relationship dialog box is displayed.

2 Click NEW.

System Response
The New Outbound Relationship dialog box is displayed.

3 In the description box, type a unique relationship name.

4 Click SAVE.

System Response
The system creates a new outbound relationship, and the 
Outbound Relationship dialog box is displayed.

Continued on next page
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5 From the appropriate lists on the Outbound Relationship 
dialog box, select the following:
! Standard
! Version
! Transaction Set
! Release -- select Release for TRADACOMS only

Note
The information required for this dialog box should be 
provided to you by your trading partner when they define the 
details of the transactions they send to you.

6 Do you need to define parameters to comply with the 
processing needs of your partner? For example, Last Used 
Control Number, Expect Acknowledgment, Hours Overdue, 
Duplicate Documents, or Test Indicator.
! If yes, click ADVANCED>> and continue with the next 

section of this table.

System Response
The Outbound Relationship dialog box is displayed.
! If no, continue with the next section of this table.
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1 If you are using the EDIFACT, ODETTE, or TRADACOMS 
standard, click ENVELOPE to complete the envelope (header) 
information.

System Response
One of the following dialog boxes is displayed:
! Outbound UNH Envelope dialog box
! Outbound MHD Envelope dialog box

2 Do the following:
! Enter the appropriate information. 
! Click SAVE.

System Response
The information is saved and the Outbound Relationship 
dialog box is displayed.

Continued on next page
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1 On the Outbound Relationship dialog box, click 
TRANSLATION.

System Response
The Outbound Translation Objects dialog box is displayed.

2 From the lists, select the translation objects that are required 
for this outbound relationship.

Note
The lists display all the translation objects registered in the 
system that are appropriate for the translation object, such as 
Import or Print, and the transaction set.

If  no translation objects are displayed in the lists, no 
translation objects of that type are registered for the correct 
version of the document defined in the relationship.

3 If you selected an Import translation object, you may need to 
define the following:
! In the Application ID box, type the application identifier 

that indicates the destination for the documents.
! In the Application Alias Value box, type criteria that the 

system will use to distinguish this relationship from 
others during the application import function.

4 Click SAVE.

System Response
Your selections are saved and the Outbound Relationship 
dialog box is displayed.
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1 On the Outbound Relationship dialog box, click GROUPS.

System Response
The Outbound Group Select dialog box is displayed showing 
a list of existing groups.

2 Is the required group in the Groups list?
! If yes, select the group and click SELECT. Select <none> 

if you are not using groups. Continue with the Selecting 
an outbound interchange section of this table.

System Response
The highlighted group is selected and the Outbound 
Relationship dialog box is displayed.

! If no, continue with step 3 to create the group.

3 On the Outbound Group Select dialog box, click NEW.

System Response
The Outbound Group Entry dialog box is displayed.

4 In the Description box, type the group description.

Continued on next page
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5 In the Functional Group ID box, type the identification of the 
functional group you are specifying. 

Note
The EDI standards define which functional group ID should 
be used for each type of document.

6 If you have more complex requirements for processing the 
functional group, click ADVANCED>> to display the full list 
of functional group setup options.

System Response
The Outbound Group Entry dialog box is extended.

Recommendation
Do not change the templates in the Group Transl. Obj. and 
Acknowledge Transl. Obj. lists, unless you have a specific 
reason to do so.

7 Click ENVELOPE to set up parameters for generating the 
Functional Group segment.

System Response
The Outbound Functional Group dialog box that is displayed 
is determined by the standard you selected on the Outbound 
Relationship dialog box. It can be one of the following:
! Outbound GS Functional Group
! Outbound UNG Functional Group
! Outbound BAT Functional Group

8 After you set up the required parameters in the enveloping 
dialog box, click SAVE.

System Response
The information is stored and the Outbound Group Entry 
dialog box is displayed.

9 Click SAVE to store the information on the Outbound Group 
Entry dialog box and return to the Outbound Group Select 
dialog box.

Continued on next page
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10 Do the following:
! Highlight the new group. 
! Click SELECT.

System Response
The group is selected and the Outbound Relationship dialog 
box is displayed.

����������
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1 On the Outbound Relationship dialog box, click 
INTERCHANGES.

System Response
The Outbound Interchange Select dialog box is displayed 
showing a list of existing interchanges.

2 Is the required interchange in the Interchanges list?
! If yes, select the interchange and click SELECT. Select 

<none> if you are not using groups. Continue with the 
Finalizing the outbound relationship section of this table.

System Response
The highlighted interchange is selected and the Outbound 
Relationship dialog box is displayed.

! If no, continue with step 3 to create the interchange.

Continued on next page
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3 On the Outbound Interchange Select dialog box, click NEW.

System Response
The Outbound Interchange Entry dialog box is displayed.

4 In the Description box, type the interchange description.

5 In the Interchange ID box, type the identification of the 
interchange you are specifying. 

Note
The EDI standards define which interchange ID should be 
used for each type of document.

6 If you have more complex requirements for processing the 
interchange, click ADVANCED>> to display the full list of 
interchange setup options.

System Response
The Outbound Interchange Entry dialog box is extended.

Recommendation
Do not change the templates in the Interchange Transl. Obj. 
and Acknowledge Transl. Obj. lists, unless you have a 
specific reason to do so.

Continued on next page
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7 Click ENVELOPE to set up parameters for generating the 
interchange segment.

System Response
The Outbound Interchange dialog box that is displayed is 
determined by the standard you selected on the Outbound 
Relationship dialog box. It can be one of the following:
! Outbound ISA Envelope
! Outbound ICS Envelope
! Outbound BG Envelope
! Outbound UNB Envelope
! Outbound UNA Envelope
! Outbound STX Envelope

8 Modify the following boxes on the interchange envelope:
! Sender ID.This field should contain your OFTP ID, as 

assigned by the network.
! Receiver ID. This field should contain your trading 

partner�s OFTP ID.

9 After you set up the required parameters in the enveloping 
dialog box, click SAVE.

System Response 
The information is stored and the Outbound Interchange 
Entry dialog box is displayed.

10 Click SAVE.

System Response
The information on the Outbound Interchange Entry dialog 
box is stored and the Outbound Interchange Select dialog box 
is displayed.

11 Do the following:
! Highlight the new interchange. 
! Click SELECT.

System Response
The interchange is selected and the Outbound Relationship 
dialog box is displayed.

Continued on next page
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1 On the Outbound Relationship dialog box, click SAVE to save 
the outbound relationship.

2 Click EXIT.

System Response
The Partner Editor dialog box is displayed.
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(��
�������� You need to create a destination table for all of the partners who are on the 
network. The system uses this destination table, instead of the interchange 
envelope information, to obtain the OFTP ID for the file destination.

You will use a GENTRAN:Director lookup table to access the appropriate 
information.

!
�����
� Complete the following steps To create a destination table, complete the 
following steps:

���� *�����

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

Continued on next page
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2 Do the following:
! Select the partner profile for which you want to create the 

destination table.
! Click TABLES.
The Partner Tables dialog box is displayed.

3 Click NEW.

System Response
The New Table dialog box is displayed.

4 In the Table Name box, type OFTPTBL.

5 From the Table Type section, select the Lookup table option.

Continued on next page
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6 Click SAVE.

System Response
The information is saved and the Lookup Select dialog box is 
displayed.

7 Click NEW.

System Response
The Lookup Entry dialog box is displayed.

8 In the Lookup Value box, type OFTPID.

9 In the Description box, type OFTP Lookup Table.

10 In the first Reference Data box, type your trading partner�s 
OFTP ID for the network.

11 Click SAVE.

12 Click EXIT.

System Response
The Lookup Select dialog box is displayed.

Continued on next page
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13 Click EXIT.

System Response
The Partner Editor dialog box is displayed.

14 Repeat steps 2 through 11 to create a destination table for 
each partner you trade with through the network.
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(��
�������� The INS Command Generator Subsystem enables you to communicate with 
the INS Tradanet Service (INS Network) using Odette File Transfer Protocol 
(OFTP)  over Asynchronous communication lines.

;���

The INS Network may also be known as the GEIS Tradanet Service.  
Throughout this User�s Guide, we refer to the INS Network.

"�6�
����

For more information on the OFTP protocol, see the Using OFTP section in 
this chapter.
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All communication with the INS Network is done using command options. 
Sterling Commerce supports a subset of these options which perform basic 
day-to-day housekeeping and reporting functions on the network.

"�6�
����

For descriptions of available command options, see How to Define INS 
Command Options beginning on page 5 - 93.
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The INS Network requires that data and command options be sent in 
separate files. 

To accomplish this, use the INS Command Editor to set up your 
requirements. When the requirements are saved, the Editor bundles them 
into a single file.
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(��
�������� Before you can use the INS Command Generator subsystem, you must set up 
a communications profile and create a new relationship for the partner that 
you will trade with on the INS Network.

�8�6�
��.��
�����

This table describes the information that you need before you can set up and 
configure the INS Command Generator subsystem. Use the right-hand 
column to record your  information.

(�6�
%
�����.���������� (����6�����
����

EDI Number (ANA Code, User 
ID, or OFTPID)

Your Password 

;����

A new user�s password is preset to 
PASSWORD. You must change 
this password before you can 
actively use the INS Network.

Your Tradanet User Number 
(TUN):

;����

Give this password to your trading 
partner.

Your trading partner�s User 
Number (TUN)

;����

Get this from your trading partner. 
Continued on next page
& � *- �����������������������������������������������������������������������	
��
�
���
��	���������
�����	��



7�,�������6���
��(;����%%����
�����
�����������
��
���6���
�����	�

�.���%

This table describes each stage that you must complete to set up and 
configure the INS Command Generator Subsystem. 

Your trading partner�s EDI 
Number. This can be ANA Code, 
User ID, or OFTPID.

��
�� $���
������

1 Build an INS Communications profile.
Reference
For more information, see Building an INS Communications 
Profile on page 5 - 83. 

2 Create a new trading partner with an INS Network 
Destination Table.
Reference
For more information, see Create a New Trading Partner 
with an INS Network Destination Table on page
5 - 87. 

3 Import the TRADANET trading partner to handle the INS 
Network reports.
Reference
For more information, see Importing the TRADANET 
Trading Partner on page 5 - 89. 

4 Define User Settings in the INS Command Editor.
Reference
For more information, see Defining INS User Settings on 
page 5 - 90.

Continued on next page
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5 Format INS Command Options using the INS Command 
Editor.
Reference
For more information, see Define INS Command Options on 
page 5 - 93.

6 Use GENTRAN:Director to invoke a communications 
session to transmit the Command Files to the INS Network.
Reference
For more information, see Sending Command Files to the 
INS Network on page 5 - 101. 
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!
�����
� To build an INS Communications profile, complete the following steps: 

���� *�����

1 From the Tools menu on the GENTRAN:Director Main 
Menu bar:
! Select Communications. 
! Select Profile from the Communications submenu.

System Response
The Communication Profile Setup dialog box is displayed.

2 Click NEW.
System Response
The New Profile dialog box is displayed.

3 Enter the new profile name, and click OK.
System Response
The Profile Setup dialog box is displayed.

4 Complete the following:
! Profile Type:  Select Asynchronous.
! Dial Retries: Enter your requirements.
! Session Retries: Enter your requirements.
! Modem Number: Enter the number of the modem that 

you will be using.
! Port Profile: Select the port already defined by your 

system.

5 Click  LOGON SCRIPT.
System Response
The Logon Script dialog box is displayed.

Continued on next page
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6 Select IMPORT!
System Response
The Import Script dialog box is displayed.

7 In the Look In: drop down list, browse to the 
CommScr\Samples folder where GENTRAN:Director is 
installed.

8 Select INSOFLG.scr as the file name, and click OPEN.
System Response
The INSOFLG script information is displayed in the Logon 
Script dialog box.

9 Click SAVE!
System Response
The Profile Setup dialog box is displayed.

10 Click RECEIVE ONLY SCRIPT.
System Response
The Receive Only Script dialog box is displayed.

11 Select IMPORT!
System Response
The Import Script dialog box is displayed.

12 In the Look In: drop down list, browse to the 
CommScr\Samples folder  where GENTRAN:Director is 
installed.

13 Select  INSOFRO.scr as the file name, and click OPEN.
System Response
The INSOFRO script information is displayed in the 
Receive Only Script dialog box.

Continued on next page
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14 Click SAVE!
System Response
The Profile Setup dialog box is displayed.

15 Click SEND RECEIVE SCRIPT...
System Response
The Send Receive Script dialog box is displayed.

16 Select IMPORT!
System Response
The Import Script dialog box is displayed.

17 In the Look In:  list, browse to the CommScr\Samples folder  
where GENTRAN:Director is installed.

18 Select INSOFSR.scr as the file name and click OPEN.
System Response
The Send Receive Script dialog box is displayed showing 
the INSOFSR script information.

19 Click SAVE!
System Response
The Profile Setup dialog box is displayed.

20 Click SCRIPT VARIABLES.
System Response
The Script Variables dialog box is displayed.

21 Enter the following information:
! %var1% field: Enter your EDI number.
! %var2% field: Enter the current password.

Continued on next page
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22 Click OK.
System Response
The Profile Setup dialog box is displayed.

23 Click OK.
System Response
The Profile Setup dialog box is closed.
Note
Remember to change the password field (%var2%) every 
time you make a password change. Do not change the field 
until the new password takes effect.
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�����
� To create a new trading partner with an INS Network Destination table, 
complete the following steps:
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1 Create the new Trading Partner that you want to trade with 
on the INS network.    
Reference
For information on setting up a trading partner, see the 
�Using Partners� chapter in this guide.

2 When creating the outbound STX envelope, enter the 
following information:

! Sender ID Code field:  Enter your EDI Number (ANA 
User ID) assigned by INS.  

! Receiver ID Code field: Enter your trading partner's 
EDI Number, as that is the mailbox this interchange is 
destined for.  

! The Recipient's Reference field: Enter your password 
to the INS Network. 
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3 From the Tools menu on the GENTRAN:Director Main 
Menu bar, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

4 Select the Partner that you want to create the destination 
table for.

Continued on next page
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5 Click TABLES.

System Response
The Partner Tables dialog box is displayed.

6 Click NEW.

System Response
The New Table dialog box is displayed. 

7 Enter the following information:

! Table Name: Enter OFTPTBL
! Table Type: Select the Lookup radio button.

8 Click SAVE.

System Response
The Lookup Select dialog box is displayed.

9 Click NEW.

System Response
The Lookup Entry dialog box is displayed.

10 Enter the following information:

! Lookup Value: OFTPID
! Description: OFTP Lookup Table
! Reference Data: On the first line, enter your Trading 

Partner�s EDI number for the INS Network.

11 Click SAVE, and then click EXIT.

System Response
The Lookup Select dialog box is displayed with OFTPID in 
the Items box.

12 Click EXIT two (2) times to return to the Partner Editor 
dialog box.

13 Repeat Steps 3 through 12 for each trading partner that you 
trade with on the INS Network.

�>�����?

���� *�����
& � ** �����������������������������������������������������������������������	
��
�
���
��	���������
�����	��



(%��
������	���"*$*;0���

�����!

���

�9(�������� ���
�,���������������������

!
�����
� To import the TRADANET trading partner to manage INS Network reports, 
complete the following steps:

���� *�����

1 From the Partner Editor dialog box, select IMPORT. 
System Response
The Import File Select dialog box is displayed.

2 Do the following:
! Select TRADANET.par.
! Click OPEN.
! Click SAVE to save this partner.

3 Select the name of your INS Communication Profile and 
click SAVE to confirm the network connection.

4 Do the following:

! Click INBOUND.
! Select the INS Reports relationship.
! Click SAVE to confirm the inbound relationship.

5 Click EXIT. 

System Response
The GENTRAN:Director EC Manager window is 
displayed.
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(��
�������� The INS Command Editor is a stand-alone program that is used to designate 
commands and parameters for the INS Network.

After online changes have been made, a parameter file is saved for use as 
input by the the INS Command Generator.
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The EDI number and password are used in every INS Command file that you 
create. Information that is entered on the User Settings dialog box is saved in 
the System Registry and redisplayed each time the dialog box is accessed. 
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The following is an example of the Settings dialog box.
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This table describes the parts and functions of the INS Gateway Settings 
dialog box.

!
�����
� To select User Settings, complete the following steps.

!

� =�������

Syntax Rules Defines the standard data syntax used with this INS 
Command Generator mailbox.  Valid values are:
! ANA
! ANAA
! DSHB

Sender Identifies the Sender using an EDI number or OFTP ID 
defined on the INS Network.

Password Defines the Sender�s Password on the INS Network.  
Characters entered into this box are not displayed on the 
screen.

Verify Password Ensures that the password entered in the Password box is 
typed correctly.

����
*�����

1 From the GENTRAN:Director Program group, select the 
INS Command Editor.
System Response
The INS Command Editor desktop is displayed.

2 Do the following:
! Select View.
! Select User Settings from the INS Command Entry 

System menu bar.

System Response
The Settings dialog box is displayed.

Continued on next page
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3 Complete the User Settings dialog box:
a) Select the syntax you want to use.

Recommendation
We recommend that you use the ANA syntax.

b) Enter your EDI number or ANA User ID in the 
Sender box.

c) Enter your INS Network Password in the 
Password box.

Note
Your password is not displayed as you enter it.

d) Re-enter your INS Network Password in the 
Verify Password box.

4 Click OK.
System Response
The INS Entry System desktop is displayed.
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(��
�������� The INS Command Editor Commands Options dialog box is used to create 
the INS commands that are sent to the INS Network, and to configure the 
required telecommunications parameters.

After you save your INS Command Options, the INS Command Editor 
performs a series of checks to verify that the selected options on the Enable 
tab match the selected options on the DelF, NewP, and NewRel tabs.

When the INS Command Generator detects missing or inconsistent 
information, you are prompted to correct the discrepancy.
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The following is an example of the INS Command Generator Enable tab.
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The following table describes the parts and functions of the INS Command 
Generator Enable tab.

;���

The items on this dialog box have three valid options: 

! Never � never send this command.
! Always � always send this command.
! Once � send this command one time only.

!

� =�������

Bcast Not available at this time.

Blist Not available at this time.

Broadcast Not available at this time.

Bdelf Not available at this time.

Delf Deletes files on the INS Network.

Go / NG Not available at this time.

ListM Lists incoming messages in the user s INS Network Mailbox.

ListP Lists outgoing messages in the user s INS Network Postbox.

ListR Lists INS Network relationships the user has defined.

NewP Defines a new Password for the user.

NewRel Defines a new INS Network relationship for the user.

SelF Not available at this time.

Status Not available at this time.
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The following is an example of the INS Command Generator DelF tab.

!

���
��
=�������� The following table describes the parts and functions of the INS Command 

Generator Delf tab.

!

� =�������

Unextracted 
files

Defines the INS Delf command so that it removes 
unextracted files.

Insert Adds filenames to the Unextracted file list.

Delete Removes filenames from the Unextracted file list.

Extracted Files Defines the Delf command so that it removes extracted 
files.

Insert Adds filenames to the Extracted file list.

Delete Removes filenames from the Extracted file list.

Extracted, all Selects all extracted files.
Continued on next page
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The following is an example of the INS Command Generator NewP tab.

!

���
��
=�������� The following table describes the parts and functions of the INS Command 

Generator NewP tab.

Extracted, 
older than

Selects extracted files older than the specified number of 
days.

Extracted, data 
type

Selects extracted files by a specific data type.

!

� =�������

New Password Defines a new INS Network Password.  The characters 
that you type are not displayed on the screen.

Verify Password Ensures that the password entered in the New box is 
typed correctly.
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The following is an example of the INS Command Generator NewRel tab.

!

���
��
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The following table describes the parts and functions of the INS Command 
Generator NewRel tab.

!

� =�������

Relation-
ship list

Defines an INS Network Relationship.

Insert Inserts filenames into the Relationship list.

Delete Deletes filename from the Relationship list.

Direction Defines the direction that files are transmitted with the Rela-
tionship. Valid values are send and receive.

Action Defines action to be taken with the relationship. Valid values 
are Establish and Cancel.

Data Type Defines the type of data to be transmitted to the Trading Part-
ner. Valid values are Any or a user-defined value.

Partner Defines the name of the new Trading Partner.  Valid values are 
Anybody or a user-defined value.
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� To format INS Command Options, complete the following steps.

���� *�����

1 Do the following:
! Select View.
! From the INS Entry System menu bar, Select Command 

Options.

System Response
The INS Command Options dialog box is displayed.

2 Select the Enable tab and complete the Enable dialog box.

;���

The Enable dialog box is used to select the INS commands 
you want to send to the INS Network.  You have three 
choices for each command:

! Always − always send this command.
! Never − never send this command.
! Once − send this command one time only.

3 Select the DelF tab and complete the DelF dialog box.

"���%%���
����

The default number of days for deleting files that have been 
extracted is three. The INS Network charges for storage of 
entries that are more than 5 days old. We recommend that 
you delete extracted files that are 3 days old every day.

4 Select the NewP tab and complete the NewP dialog box.

"���%%���
����

We recommend that you change your password on a regular 
basis. It is also a good idea to send the password change as 
the only command in the communications session.

Continued on next page
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5 Select the NewRel tab and complete the NewRel dialog box.

;���

Use the NewRel dialog box only when creating or removing 
trading relationships on the INS Network.

a) Click Insert.
b) Select the Direction.

c) Select the Action.

d) Select the Data Type.

e) Select the Trading Partner.
6 Click OK.

System Response
The INS Command Options dialog is closed and the INS 
Command Editor is displayed.

7 Do you want to save your changes using the default 
filename?
! If yes, select Save from the File menu and proceed to 

Step 8.

System Response
A Default.ins file is created in the Bin\Commscr folder 
where GENTRAN:Director is installed. The default 
location is: Program Files\Sterling 
Commerce\GENTRANDirector\Bin\Commscr\
Default.ins. 

! If no, select Save As... from the File menu. In the File 
name field, enter a name and an .ins extension. Click 
SAVE. Proceed to Step 8.

8 Exit the INS Command Editor.
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The .ins file is a text file that displays all of the command option parameters 
that you select. The file also details whether a specified option is designated 
to run once or to run always. You can view, save, or rename this file as you 
would any other text file.

The first record in the file is set to Yes and contains the EDI Number (ANA 
User ID) and Password that is included in each INS Command File.  

The INS Command Editor automatically fills out the last entry with the NG 
ALL command.  This command ensures that all files not previously 
extracted from the INS Mailbox plus reports will be extracted.  

After the INS Command Generator runs, 25 INS#.CMD files are created, 
and the status of the first record changes to No. This status change ensures 
that the INS commands specified to run once do so. An .ins file is not created 
again, unless changes are made on the INS Command Editor dialog box.
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(��
�������� Normally you run communications in an unattended mode by using the 
GDW_Send_Receive function in an unattended session.  The INS profile 
that you set up is called from the unattended session and your INS scripts are 
executed.

In a Send/Receive session, EDI data is sent first, followed by the INS 
commands. The communications session retrieves this data from the INS 
Mailbox.

In a Receive Only session, INS commands are sent, followed by the 
communications session retrieving data from the INS Mailbox.

Two (2) sample unattended sessions are provided in the Tutorial folder 
where GENTRAN:Director is installed. Those files are:

! INS_Send.ses - Outbound data and INS commands sent, data retrieved.
! INS_Recv.ses - Send INS commands and retrieve reports and data only.
Use these model sessions to guide you as you develop your own outbound 
and inbound flows.
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�����
� To start the stand-alone communications module and send files to the INS 
Network, complete the following steps: 

"�6�
����

For more information about stand-alone communications, see Using 
Stand-alone Communications on page 5 - 20.

���� *�����

1 From the Program group, select Sendfile. 
System Response
The Stand-alone Communication Processor is launched.

2 Do you plan to send data?
If Yes, 

!Enter a file name in the Filename to send  field.
!In the Receiver�s OFTP ID box, enter the EDI 

Number (ANA User ID).  

Note
This data does not include INS commands, they will be sent 
anyway.
If No, 

!Enter the INS Communications Profile in the Profile 
to use field.  You set this profile up earlier.

!Verify that the Receiver�s OFTP ID box is deselected.
3 Click OK.

System Response
A communication session starts and processes the INS 
Command Files to the INS Network.
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(��
�������� The most efficient method of changing a password is by using stand-alone 
communications. We recommend that you do not combine NEWP with any 
other INS commands. Use the INS Command Editor to build INS command 
files that handle just the password change. After the password is changed, set 
up the INS Command Editor for other actions.

For more information about stand-alone communications, see Using 
Stand-alone Communications on page 5 - 20.

!
�����
� To change your password, complete the following steps: 

���� *�����

1 Verify that you have the correct EDI Number and current 
password set up in the INS Communications Profile.

2 Select the INS Command Editor from the 
GENTRAN:Director program group.
System Response
The INS Command Entry System dialog box is displayed.

3 Do the following:
! From the Main Toolbar, select View.
! Select User Settings.

System Response
The Settings dialog box is displayed.

4 Verify that the EDI Number and current password  are 
correct and then click OK.
System Response
The INS Command Entry System dialog box is displayed.

Continued on next page
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5 Do the following:
! From the Main Menu Bar, select View.
! Select Command Options.

System Response
The Command Options dialog box is displayed.

6 On the Enable tab, select Never for every setting except 
NEWP. Change the setting for NEWP to Once.

7 Do the following:
! Select the NEWP tab. 
! Enter and confirm the new password. 
! Click OK to exit the dialog box.

8 From the File menu, select Exit.
System Response
The INS Command Editor is closed.

9 Select the INS Command Generator from the 
GENTRAN:Director program group, and select SENDFILE.

10 Repeat Steps 1 through 9 for stand-alone communications. 
The only command file processed is the NEWP password 
change.
Note
Before your next communications transmission, verify that 
you have changed the password to the new one in the INS 
Communications Profile and the INS Command Editor.

11 Enter a file name in the Filename to send box,  if you plan to 
send some data.
Note
This data does not include INS commands, which will be 
sent anyway.
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. The Log Summary enables you to view, print, delete, purge, or reprocess 
communication log entries. You can view information for all completed 
communication sessions, including the following:

! Status of the session 
! Finish date and time 
! Profile name 
! Name of the application that requested the communication session 
! Session control number

9���$��
�� The Log Detail function enables you to view the complete communication 
log for a selected session, including trace information if the Trace function is 
enabled.
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!
�����
� To use the log summary, complete the following steps:

���� *�����

1 From the Tools menu:
! Select Communications.
! Select Log from the submenu.

System Response
The Communication Log Summary window is displayed.

Note
This window contains the available session control records for the completed 
communication sessions.

Continued on next page
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The following table describes the status options that can be displayed for a 
communication session.

2 Do one of the following:
! View the summary information for completed session control records.
! Use the following table to determine your next step.

IF you want to... THEN...

view the complete 
communication log for a selected 
session,

click LOG DETAIL

print the log summary, click PRINT!

purge session control records 
older than the number of days 
you specify,

! select a session control record or 
records and click DELETE!

delete a selected document, click PURGE!

restart the post-communications 
process for any files that were 
received,

! select a session control record and 
click REPROCESS!

3 Click CLOSE! to exit the Log Summary window.

��
��� $���
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Success Indicates that the communication session was a 
success.

Failure Indicates that the communication session failed.
Continued on next page
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.
Snd Fail ! Refers to a Send/Receive session. A Send/
Receive session consists of a Send sub-process 
and Receive sub-process.

! Indicates that the Send sub-process failed, but 
the Receive sub-process succeeded. 

Note
If both sub-processes succeed, the status is 
Success. If both sub-processes fail, the status is 
Failure.

Rcv Fail ! Refers to a Send/Receive session. A Send/
Receive session consists of a Send sub-process 
and Receive sub-process.

! Indicates that the Send sub-process succeeded, 
but the Receive sub-process failed. 

Note
If both sub-processes succeed, the status is 
Success. If both sub-processes fail, the status is 
Failure.
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!
�����
� To use the log detail, complete the following steps:

���� *�����

1 From the Tools menu:
! Select Communications.
! Select Log from the submenu.

System Response
The Communication Log Summary window is displayed.

Note
This window contains the available session control records for the completed 
communication sessions.

Continued on next page
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2 ! Select a log summary record.
! Click DETAIL!

System Response
The Communication Log Detail window is displayed.
Note
The Communication Log Detail window displays the details for each action 
from the selected communication session record.

3 Use the following table to determine your next step.

IF you want to... THEN...

print the log details, click PRINT!

return to the Log Summary 
Window,

click SUMMARY!

exit the Log Detail window, click CLOSE!

4 Click CLOSE! to exit the Log Summary window.

�

>�����? *�����
& � ��- �����������������������������������������������������������������������	
��
�
���
��	���������
�����	��



�5�
5��,
�������	����%%����
��


�	��	��0

(��
�������� The Communicator is the GENTRAN:Director communication feature. The 
Communicator window lists the currently executing communication session 
and all sessions waiting to execute. 

The Communicator gives you access to all the communications functions 
available in GENTRAN:Director, enables you to view the currently queued 
communication sessions, and delete communication jobs from the queue.

7�,����
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You can access the Communicator by selecting GENTRAN Director 
Communicator from the Start menu, or by selecting the Communicator icon 
from your taskbar when a communication session is executing.
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�����
� To view the currently executing and queued communication sessions, 
complete the following steps:

���� *�����

1 From the Start menu: 
! Select GENTRAN Director.
! Select GENTRAN Director Communicator.

System Response
The Communicator window is displayed.

Note
This window enables you to view information for all queued 
communication sessions. The available information includes 
the following: 
! Status of the session 
! Requested date and time
! Profile name
! Name of the application that requested the 

communication session
! Session control number
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� To delete a currently queued communication session, complete the following 
steps:

���� *�����

1 From the Start menu: 
! Select GENTRAN Director.
! Select GENTRAN Director Communicator.

System Response
The Communicator window is displayed.

2 Select the communication session you want to remove from 
the queue.

3 From the Options menu, select Delete Job. 
System Response
The communication session is removed from the queue.
Note
You can only delete jobs that are queued; not jobs that are 
currently executing.
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 This chapter explains how to use interchanges with GENTRAN:Director.

(���
�	
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�

The Interchange feature enables you to:

! View a hierarchical list of all the interchanges that were sent or 
received.

! View status information for the interchanges. For example, whether or 
not a functional acknowledgment was received and the status of that 
acknowledgment.

! Filter the display of interchanges.
! Access the documents within the interchanges.
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(��
�������� The Interchanges browser enables you to view a list of all the interchanges, 
groups, and documents that were sent or received. This browser contains 
status information about the interchanges. For example, whether or not a 
functional acknowledgment was received and the status of that 
acknowledgment.

;���

The Interchanges browser can always be accessed. 

(�6�
%
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�
�
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The information on the Interchanges browser is organized in a hierarchical 
manner. The following table describes the hierarchical organization of the 
information on the Interchanges browser:

9�5�� 7�,����
����� (�6�
%
����������
.��

Interchange Open Interchanges browser ! The direction of the interchange
! Control number
! Partner name
! Date and time the interchange was created
! Process status
! Network status
! Interchange acknowledgment status

Note
Any components that are missing or not 
appropriate for a particular interchange, are not 
displayed.

Group Double-click an interchange ! The group control number 
! Group type
! Group acknowledgment status

Note
Any components that are missing or not 
appropriate for a particular group, are not 
displayed.

Continued on next page
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You can perform the following functions on the Interchanges browser:

! Filter the display of interchanges from the Interchanges Filter dialog 
box by date, partner, and direction (inbound and outbound).

! Display the raw-EDI data or translator report data for the selected 
interchange or document, in the Data view and Translator Report view 
windows.

! Toggle the status of interchanges between �Ready to Send� and �Hold�.
! Print or delete a selected item. 

;���

Use the toggle function if you do not want to send an interchange right away.

Document Double-click a group ! The document status
! Document control number
! Document typ
! Document name
! Reference data
! Transaction acknowledgment status

Note
Any components that are missing or not 
appropriate for a particular document, are not 
displayed.

EDI data Double-click a document

Note
A screen entry translation 
object for that document 
must be available on your 
system.

EDI data

�>�����?
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7�,����
����� To access the Interchange Browser, select Interchanges from The Desk. The 
Interchanges browser is displayed.
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!
�����
� To view interchanges, complete the following steps:

���� *�����

1 From The Desk, select Interchanges.

System Response
The Interchanges browser is displayed.

2 Do you want to filter the display of interchanges by status?
! If yes, see Sorting Interchanges on page 6 - 8.
! If no, continue with step 3.

Note
The Sort function enables you to filter the display of interchanges by date, 
partner, and direction (inbound and outbound).

3 Select an interchange, or a group of interchanges if allowed.

Continued on next page
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4 Use the following table to determine your next step.

IF you want to... THEN select...

view a translator report of the 
actions the translator took on this 
interchange,

! View from the Commands menu, and 
then Translator Report.

view the content of a single 
selected interchange in raw EDI 
data format,

! Interchanges from the View menu. 
! Data from the View submenu.

print a selected interchange or a 
summary of interchanges,

Print from the File menu.

view the translator report for a 
single selected interchange,

! Interchanges from the View menu. 
! Translator Report from the View 

submenu.

delete a selected interchange and 
all associated documents,

Delete from the Document menu.

Notes
! If you delete an interchange with a 

status of �Queued,� you receive a 
warning that you must remove 
specified messages from Out 
Documents and from your trading 
partner�s Inbox. If you proceed, you 
are warned that if your partner bases 
processing results on control number 
sequencing, you should modify the 
transaction, group, and interchange 
control numbers. 

! If you delete an interchange with a 
status of �Ready to send,� you are 
warned that if your partner bases 
processing results on control number 
sequencing, you should modify the 
transaction, group, and interchange 
control numbers.

attach an interchange to a partner Attach from the Document menu.
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(��
�������� When the Interchanges browser is active, the Sort function enables you to 
filter the display of interchanges by date, partner, and direction for inbound 
and outbound.

!
�����
� To sort interchanges by partner and/or date, complete the following steps:

���� *�����

1 From The Desk, select Interchanges.

System Response
The Interchanges browser is displayed.

Continued on next page
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2 From the Commands menu, select Sort. 

System Response
The Interchange Filter dialog box is displayed.

3 Do you want the system to filter the display of interchanges 
by date and time?
! If yes, clear the �No Date/Time Checking� check box 

and proceed with step 4.
! If no, select the �No Date/Time Checking� check box 

and proceed with step 6.

4 Use the Date From slide bar to select the beginning date of a 
date range, from which the system should filter the display 
of interchanges.

5 Do you want the end date for the date range to always be the 
current system date and time?
! If yes, select the �Always Current� check box.
! If no, deselect the �Always Current� check box and 

move the Date to slide bar to the date and time you want 
to use.

Continued on next page
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6 Do you want to filter the display of interchanges by partner?
! If yes, select the partners that you want displayed from 

the Partner list. The Partner list contains all the partner 
profiles on your system. 

Note
By default, all partners are displayed. You can click partner 
profiles to deselect them and change the display. To deselect 
all the partner profiles, click UNSELECT ALL PARTNERS. At 
least one partner must be selected.

! If no, continue with step 7.

7 Which direction do you want to filter the interchange? 

The default display is both inbound and outbound 
interchanges. Click the Inbound or Outbound check box to 
clear the direction.

Note
At least one of the Direction check boxes must be selected.

�>�����?
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(��
�������� You can view the individual documents in an interchange as long as a screen 
entry translation object for each document is available on your system.

!
�����
� To view the documents within an interchange, complete the following steps:

���� *�����

1 From The Desk, select Interchanges.

System Response
The Interchanges browser is displayed.

Note
The Interchanges browser contains all the interchanges, group, 
and documents that were sent or received.

Continued on next page
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2 Double-click a document to view it. 

Note
You must have a screen entry translation object for this 
document available on your system.

3 Select a document.

4 Use the following table to determine your next step.

IF you want to... THEN select...

view a translator 
report of the 
actions the 
translator took on 
this document,

! Interchanges from the View menu, 
and then Translator Report.

view the content of 
a single selected 
interchange in raw 
EDI data format,

! Interchanges from the View menu. 
! Data from the View submenu.

print a selected 
document or 
translation report,

Print from the File menu.

delete a selected 
document,

Delete from the Document menu.

copy the document 
to the appropriate 
browser,

! Copy from the Document menu.
! Select the appropriate browser:

" Select ?In Documents or In 
Documents for compliant Inbound 
documents.

" Select Workspace for outbound 
documents from the submenu.

�

>���� *�����
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(��
�������� The Attach to Partner dialog box can be accessed when the Interchanges 
browser is active and one interchange is selected. The Attach function 
enables you to link the interchanges to a partner. For example, you should 
use the Attach function if you received documents that did not have an 
identifiable partner and are now listed without a partner in the ?In 
Documents browser.

;���

The interchanges for documents not having an identifiable partner, are listed 
in the Interchanges browser without a partner.

!
�����
� To attach an interchange to a partner, complete the following steps:

���� *�����

1 From The Desk, select Interchanges.

System Response
The Interchanges browser is displayed.

2 Select an interchange

Continued on next page.
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3 Does the partner already exist?
! If yes, continue with step 4.
! If no, you must create the partner before you can 

continue.

Reference
For instructions on creating a new partner and partner 
relationship, see Creating a New Partner Definition on page 
3 - 27.

4 From the Document menu, select Attach.

System Response
The Select Partner dialog box is displayed.

Continued on next page
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5 ! Select a partner from the Possible Partners list.
! Click OK.

System Response
The selected interchange is linked to the partner, and the 
Interchange browser is displayed.

Exceptions

1. If the partner to which you are attaching the interchange 
has more than one interchange definition, you are 
prompted with an additional dialog box. In this case, you 
should do the following:
! Select the appropriate interchange definition.
! Click OK.

2. If the partner to which you are attaching the interchange 
has more than one group definition, you are prompted 
with an additional dialog box. In this case, you should do 
the following:
! Select the appropriate group definition.
! Click OK.

3. If the partner to which you are attaching the interchange 
has more than one relationship defined for a type of 
document in the interchange, you are prompted with an 
additional dialog box for each instance. In this case, you 
should do the following:
! Select the appropriate relationship definition.
! Click OK.

6 After you attach the interchange to a partner, open ?In 
Documents by selecting it from the appropriate area of The 
Desk.

Note
You can then export, print, or move the documents to the In 
Drawer.
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(��
�������� To resend outbound interchanges from the Interchanges browser, you must 
use the Resend command.You can only resend interchanges that were 
previously sent or that have a status of �Ready to send.�

"�������
����� The following table describes the system process that occurs when you 
resend a selected interchange:

��
�� $���
������

1 The documents in the selected interchange are batched into 
EDI envelopes and the required control numbers, etc., are 
generated from the information in the partner profile.

2 After the interchange is built, it is listed in the Interchange 
browser. For instructions on viewing an interchange, see 
Viewing Interchanges on page 6 - 6.

3 If the communication fails because there is no mailbox set up 
or the Mailbox service is not started, the interchange and 
documents are left in a �Ready to send� status.

If communication fails because there is no modem, the 
interchange and documents are left in a �Queued� status. 

Note
No user action is required at this point. Interchanges that 
failed to send are automatically sent as part of the next 
transmission session.

4 After communication is successful, the documents are moved 
to the Out Drawer and the interchange status is set to �Sent.�
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� To resend outbound interchanges, complete the following steps:

���� *�����

1 From The Desk, select Interchanges.

System Response
The Interchanges browser is displayed.

2 Select the outbound interchange that needs to be resent.

3 From the Commands menu, select Resend.

System Response
The GENTRAN:Director dialog box is displayed.

4 Click YES to start the transmission session.
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 This chapter explains how to use GENTRAN:Director acknowledgments, 
and includes the following topics:

! Defining inbound acknowledgment criteria 
! Defining outbound acknowledgment criteria 
! Manually acknowledging a document

*�+��,�����
6�
��
�

Acknowledgments are sent to a trading partner to inform them that you 
received their transmission, and to tell them about any errors. You must 
define the level of acknowledgments for those you receive from your trading 
partners, as well as those that you send to your trading partners when you 
receive a transmission from them.
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(��
�������� The criteria that the system uses to acknowledge inbound document, 
functional groups, and/or interchanges is defined at the Partner level. The 
translation objects that are necessary to generate functional 
acknowledgments are included as system translation objects and are 
registered when you install GENTRAN:Director.

;���

If you are generating functional acknowledgments as a result of receiving 
documents for an inbound relationship, part of establishing that inbound 
relationship is setting up the corresponding outbound relationship to 
generate acknowledgments.

"�6�
����

For information on establishing an outbound relationship to generate 
acknowledgments, see Creating a New Outbound Relationship on 
page 3 - 42.

!
�����
� To define criteria to generate acknowledgments, complete the following 
steps:

���� *�����

1 Document acknowledgment criteria is defined when you set 
up the partner relationship using the Advanced options on 
the Inbound Relationship dialog box.

Reference
For more information about setting parameters on the 
Inbound Relationship dialog box, see page 3 - 30.

Continued on next page
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2 Functional Group acknowledgment criteria is defined when 
you set up the Inbound Group Entry using the Advanced 
options on the Inbound Group Entry dialog box.

Reference
For more information about setting parameters on the 
Inbound Group Entry dialog box, see page 3 - 30.

3 Interchange acknowledgment criteria is defined when you 
set up the Inbound Interchange Entry using the Advanced 
options on the Inbound Interchange Entry dialog box.

Reference
For more information about setting parameters on the 
Inbound Interchange Entry dialog box, see page 3 - 30.
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(��
�������� Reconciling documents and their acknowledgments is a function that the 
system automatically performs for you. The translation objects that are 
necessary to process the acknowledgments you receive, are included as 
system translation objects and are registered when you install 
GENTRAN:Director. 

However, you must establish the level of acknowledgments that you receive 
from your trading partners by completing the Outbound Relationship dialog 
box.

;���

If you are receiving functional acknowledgments as a result of sending 
documents for an outbound relationship, part of establishing that outbound 
relationship is setting up the corresponding inbound relationship to receive 
acknowledgments from your partner.

"�6�
����

For information about establishing an inbound relationship to receive 
acknowledgments, see Creating a New Inbound Relationship on 
page 3 - 30.
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!
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� To set up the level of acknowledgments that you expect to receive from your 
partners, complete the following steps:

���� *�����

1 The requirement for receiving interchange acknowledgments 
is set in the Advanced section of the Outbound Interchange 
Entry dialog box.

Reference
For more information on setting parameters on the Outbound 
Interchange Entry dialog box, see page 3 - 41.

Recommendation
Do not change the translation objects in the Interchange 
Transl. Obj. and Acknowledge Transl. Obj. lists, unless you 
are certain of the result.

Continued on next page
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2 The requirement for receiving functional group 
acknowledgments is set in the Advanced section of the 
Outbound Group Entry dialog box.

Reference
For more information on setting parameters on the Outbound 
Group Entry dialog box, see page 3 - 41.

Recommendation
Do not change the translation objects in the Group Transl. 
Obj. and Acknowledge Transl. Obj. lists, unless you are 
certain of the result.

Note
If the acknowledgment is overdue, or it is not received in the 
number of hours designated in the Hours Overdue box, it is 
indicated with a status of �Overdue� on the Interchanges 
browser.
! For instructions on how to access the Interchanges 

browser, see Viewing Documents within Interchanges on 
page 6 - 11.

! For an explanation of status codes, see the Glossary on 
page G - 9.

Continued on next page
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3 The requirement for receiving transaction set 
acknowledgments is set in the Advanced section of the 
Outbound Relationship dialog box.

Reference
For more information on setting parameters on the Outbound 
Relationship dialog box, see page 3 - 41.
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(��
�������� The Acknowledge function does NOT generate an acknowledgment; it 
merely changes the status of the outbound document.The status of a 
document in the Out Drawer may need to be manually set to 
�acknowledged� for many reasons. For example, if you have contacted a 
partner about an overdue document and that partner verified that it was 
received, but they are not sending you an acknowledgment.

!
�����
� To manually change the status of a document to acknowledged, complete the 
following steps:

���� *�����

1 From The Desk, select Out Drawer.

System Response
The Out Drawer Summary dialog box is displayed.

Continued on next page
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2 Do the following:
! Select the type of document for the partner.
! Click VIEW.

System Response
The Out Drawer browser is displayed.

3 Select an Unacknowledged document that needs to be set to 
�Ack�d� (acknowledged).

Note
Unacknowledged documents can have one of the following 
statuses:
! Overdue
! Waiting
! Sent
! OnNet
! PickedUp
! NetErr
! NetWarn

4 Click ACK.

System Response
The status of the document is set to �Ack�d.�
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 This chapter describes how to use the GENTRAN:Director tracking and 
audit systems.

�

�+����6�
��
� The system writes a Document Tracking record for every significant event 
that occurs for a document. For example, a Document Tracking record is 
written when the document is created, when it is modified, or when it is 
exported. 

;���

This function is not available if document level auditing is disabled. For 
more information on enabling document level auditing, see �System 
Administrator Functions� in the Administrator�s Guide.

*�����6�
��
� The system writes an Audit record for every significant event that occurs in 
the system. For example, an Audit record is written when a user logs on, 
when a Send session is initiated, or when a document is deleted.

;���

The Audit Log contains entries for the entire GENTRAN:Director system. 
The events are differentiated by user name and machine name.
* � � ���������������������������������������������������������������������	
��
�
���
��	���������
�����	��



1"����� ������7���������������;"��9" :��,����
���!
�������$���%�����

�+����(�6�
%
����
>��0�����������������,���9��������7������/��9�����

(��
�������� Typically, you view document tracking information to help resolve a 
problem with a document. These records can be viewed from any of the 
document browsers.

!
�����
� To view or print document tracking information, complete the following 
steps:

���� *�����

1 From The Desk, select a browser. 

System Response
If you select the In Documents, ?In Documents, Out 
Documents, ?Out Documents, In Drawer, or Out Drawer 
browser, the summary dialog box for that browser is 
displayed.

2 Do the following:
! Select the type of document for the appropriate partner.
! Click VIEW to access the browser containing those 

documents.

Continued on next page
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3 Do the following:
! Select a single document.
! From the Commands menu, select View.

System Response
The View Choices dialog box is displayed.

4 Select the Track Information option and click OK.

System Response
A new tracking window for that document is displayed.

Note
The tracking window contains an entry for each tracked 
event. If there are more events than can be displayed in the 
window, a scroll bar enables you to view the remaining 
records.

Continued on next page
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5 To print the displayed tracking information, select Print from 
the File menu.
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(��
�������� The Audit Log allows you to get information to help resolve a system 
problem, or to track a user�s activities. These records may be viewed at any 
time.

!
�����
� To view or print audit log information, complete the following steps:

���� *�����

1 From the View Menu, select Audit Log.

System Response
A new Audit Log window is displayed that contains an entry 
for each audited event

2 To print the displayed audit information, select Print from 
the File menu.
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 This chapter defines the Accum Tracking Extension and explains how to use 
accum tracking.
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(��
�������� Some automotive original equipment manufacturers (OEMs) require their 
suppliers to track accumulative year-to-date (YTD) quantities of the parts 
they ship. These parts must be tracked through a combination of destination 
(partner location) and part number (trackable item).

01
%���

If a customer ships partner number 55663322 to two different locations, 
there are two records (one for each location) for this part number.

The accumulative count for each part number is included in the ANSI X12 
856 Advance Ship Notices (ASN) that the supplier sends to the OEM.

The accum quantity that most OEMs typically require in the ASN, is the sum 
of the actual YTD quantity (for the model year, not the calendar year) at the 
last shipment, plus the ship quantity.

7�,�*���%
�

�+����,�
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The Accum Tracking Extension is an add-on feature of GENTRAN:Director 
which enables you to do the following:

! Define items to be tracked
! Maintain items to be tracked
! Maintain the associated counts
! Report on those items
The Accum Tracking Extension lets you define trackable items. Each 
trackable item is the equivalent of one part (identified by part number) that is 
shipped to one location for a partner. This enables you to automatically keep 
track of accumulative YTD quantities of automotive parts, so that you can 
send them in the ASNs.
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The following table illustrates the accum tracking process. It is based on a 
scenario in which you ship part number 123 to the Detroit and Toronto 
locations of Generic Auto Company:

��
�� $���
������

1 You receive the system and screen entry translation objects for 
Generic Auto Company from Sterling Commerce.

2 Register the translation objects in GENTRAN:Director.

3 Import an outbound partner relationship for Generic Auto 
Company into the GENTRAN:Director Partner Editor.

4 In the Generic Auto Company partner relationship (in Partner 
Editor), create one location table for the Detroit location and 
one location table for the Toronto location.

5 In the Accum Tracking Extension, create a trackable item 123 
for the Detroit location and another trackable item 123 for the 
Toronto location.

6 The system stores each trackable item as a record in the 
GENTRAN:Director database lookup table (identified as a 
accum tracking item by the tag �$$$Accum$$$�).

Note
This process is handled by the system and is hidden from you. 
You do not create the lookup table.

7 Use the screen entry translation object to enter the ASN in 
GENTRAN:Director. As part of the ASN, type the ship 
quantity of each part, or trackable item. 

8 Send the ASN to your partner.

Continued on next page
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As shown in the previous table, the system handles most of the accum 
tracking process automatically. There are very few exceptions when you will 
need to manually intervene. Some exceptions are the following:

! If you experience communication problems, you may need to manually 
correct the affected accums.

! For each new model year, you need to reset each accum to zero.

;���

Some automotive OEMs have specific accum tracking requirements. The 
translation objects that you receive from Sterling Commerce are designed to 
accommodate these requirements.

��6�,

�
��%�������

The Accum Tracking Extension is a separate install set on the 
GENTRAN:Director CD. The Accum Tracking Extension consists of the 
following components:

9 While the system is preparing to send the ASN, it looks up the 
accum quantity of each item and adds that quantity to the ship 
quantity you entered on the ASN. The system inserts the sum 
of these two quantities in the accum quantity field on the ASN.

Example
For item 123 bound for Detroit:
Accum quantity + Ship quantity = total accum quantity

10 After the ASN is sent, the system automatically adds the ship 
quantity to the accum quantity stored in the database lookup 
table, and updates the accumulative count.

��%������ $���
������

ACCUM.EXE Accum Tracking Extension executable.

ACCUM.HLP Help file for the Accum Tracking Extension.

READMEA.TXT Read Me file for the Accum Tracking Extension.
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!
����� The following table provides a high-level overview of the sequence of tasks 
you complete to implement the Accum Tracking Extension with 
GENTRAN:Director.

��
�� $���
������

1 Install GENTRAN:Director, including the Accum 
Tracking Extension

Reference
For more information, see the GENTRAN:Director Getting 
Started Guide.

2 Register translation objects
In GENTRAN:Director, register the system and screen entry 
translation objects from the disk you receive from Sterling 
Commerce (*.TPL files).

Reference
For more information, see Registering (Installing) a New 
Translation Object on page 2 - 3.

3 Import partners
In Partner Editor, import the partner profiles from the disk 
you receive from Sterling Commerce (*.PAR files).

Reference
For more information, see Importing a Partner Profile on 
page 3 - 59.

4 Create location tables
In the Partner Editor, create location tables for the associated 
locations for each partner.

Reference
For more information, see Creating Partner Locations on 
page 3 - 85.

Continued on next page
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5 Configure Accum Tracking Extension
Configure the Accum Tracking Extension to your 
specifications.

Reference
For more information, see Using the Configuration Dialog 
box on page 9 - 12.

6 Set up the tracking environment
Set up the items that you want to track.

Reference
For more information, see Adding a Trackable Item on page 
9 - 23.

7 Process your data through GENTRAN:Director

Reference
For more information, see the Using Documents chapter in 
this guide.
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(��
�������� The Accum Tracking Extension is a graphical user interface that uses a 
branching series of dialog boxes, and enables you to add and maintain 
trackable items. 

$�
�

% The following diagram illustrates the branching sequence of the Accum 
Tracking Extension dialog boxes:

Accum Tracking Extension -

Accum Tracking
Extension -
Configuration

Accum Tracking
Extension -
Location List

Accum Tracking
Extension -
Item List

Accum Tracking
Extension -
Item Maintenance

Partner List
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(��
�������� The Accum Tracking Extension - Partner List dialog box is the main dialog 
box of the Accum Tracking Extension. This dialog box contains a list of all 
partner relationships currently defined in GENTRAN:Director. 

;���

To define a new trading partner, you must use the GENTRAN:Director 
Partner Editor.

*����������	�
��
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From the GENTRAN:Director Tools menu, select Accum Tracking. The 
Partner List dialog box is displayed.
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The following table lists the parts of the Partner List dialog box and their 
functions:

!

� =�������

Trading Partners Lists all the partner relationships currently 
defined in GENTRAN:Director. You may 
select one or more partners.

EXIT Closes the Accum Tracking Extension.

LOCATIONS Accesses the Locations List dialog box for a 
selected partner.

Exception
Only valid if one partner is selected.

Reference
For more information on the Location List 
dialog box, see Using the Location List 
Dialog box on page 9 - 15.

SELECT�ALL Selects all partner relationships in the 
Trading Partners list.

CLEAR�COUNTS Sets the counts for all items associated with 
the selected partners to zero.

Confirmation
The system prompts you for confirmation.

DELETE�ITEMS Deletes all trackable items associated with 
the selected partners.

Confirmation
The system prompts you for confirmation.

CONFIGURATION Accesses the Configuration dialog box.

Reference
For more information, see Using the 
Configuration Dialog box on page 9 - 12.

LOAD�COUNTS Not currently used.

Continued on next page
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REPORT Prints a report for all trackable items in all 
defined locations for the selected partners.

HELP Displays help for the Partner List dialog 
box.

!
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(��
�������� The Accum Tracking Extension - Configuration dialog box enables you to 
set global configuration options for the Accum Tracking Extension. These 
options are stored in the registry.

*����������	�
��
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To access the Configuration dialog box, click CONFIGURATION.
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The following table lists the parts of the Configuration dialog box and their 
functions:

!

� =�������

Use Secondary 
Description

Specifies whether the secondary description 
is used for trackable items, in addition to a 
primary description.

Note
This option is selected by default. Clearing 
this check box makes the Secondary 
Description box on the Item Maintenance 
dialog box unavailable.

Reference
 For more information, see Using the Item 
Maintenance Dialog box on page 9 - 20.

Use Secondary Count Specifies whether the secondary count is 
used for trackable items, in addition to a 
primary count. 

Note
This option is selected by default. Clearing 
this check box makes the Count 2 box on the 
Item Maintenance dialog box unavailable.

Reference
For more information, see Using the Item 
Maintenance Dialog box on page 9 - 20.

Zero Counts on Add Specifies whether the counts of a new 
trackable item are automatically set to zero. 
The new trackable item counts are shown in 
the Count 1 and Count 2 boxes on the Item 
Maintenance dialog box.

Note
This option is selected by default.

Reference
For more information, see Using the Item 
Maintenance Dialog box on page 9 - 20.

Continued on next page
���������	
��
�
���
��	���������
�����	�� ��������� + � ��



�������	�����6���

�����$�
������1 1"����� ������9�����7�����:���"���
Hide Accum Entries 
From Partner Editor

Specifies whether the accum tracking 
lookup table is hidden in the Partner Editor.

Note
This option is selected by default.

OK ! Applies the configuration settings by 
making the appropriate changes to the 
registry.

! Closes the Configuration dialog box.

CANCEL ! Discards any changes.
! Closes the Configuration dialog box.

HELP Displays help for the Configuration dialog 
box.

!
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(��
�������� The Accum Tracking Extension - Location List dialog box displays a list of 
all locations currently defined in GENTRAN:Director for the selected 
partner on the Partner List dialog box.

;���

The Accum Tracking Extension does not allow you to define trackable items 
for locations which have a �PrimaryRefCode� greater than eight characters.

"�6�
����

To define a new trading partner, you must use the GENTRAN:Director 
Partner Editor.

*����������	�
��
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To access the Location List dialog box, select a partner relationship from the 
Partner List dialog box and click LOCATIONS.
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The following table lists the parts of the Location List dialog box and their 
functions:

!

� =�������

Partner Locations Contains all the locations currently defined 
for the selected partner.

OK Closes the Location List dialog box.

ITEMS TO TRACK Accesses the Items List dialog box for the 
selected location.

Exception
Only valid if one location is selected.

Reference
For more information, see Using the Items 
List Dialog box on page 9 - 17.

SELECT ALL Selects all locations in the Partner Locations 
list.

CLEAR COUNTS Sets the counts for all items associated with 
the selected locations to zero.

Confirmation
The system prompts you to confirm the 
selection.

DELETE ITEMS Deletes all trackable items associated with 
the selected locations.

Confirmation
The system prompts you to confirm the 
selection.

REPORT Prints a report for all trackable items in all 
selected locations.

HELP Displays help for the Location List dialog 
box.
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(��
�������� The Items List dialog box displays a list of all trackable items currently 
defined for a selected location.

*����������	�
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To access the Items List dialog box, select a location from the Location List 
dialog and click ITEMS TO TRACK.
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The following table lists the parts of the Items List dialog box and their 
functions:

!

� =�������

Items to Track Contains all the trackable items for the 
selected location.

OK Closes the Items List dialog box.

ADD Displays a blank Item Maintenance dialog 
box, which allows you to define a new 
trackable item for this location.

Reference
For more information, see Using the Item 
Maintenance Dialog box on page 9 - 20.

EDIT Displays the Item Maintenance dialog box 
for the selected trackable item, which allows 
you to edit the selected trackable item. 

Reference
For more information, see Using the Item 
Maintenance Dialog box on page 9 - 20.

SELECT ALL Selects all trackable items in the Items to 
Track list.

CLEAR COUNTS Sets the counts for the selected trackable 
items to zero.

Confirmation
The system prompts you to confirm the 
selection.

DELETE ITEMS Deletes the selected trackable items.

Confirmation
The system prompts you to confirm the 
selection.

Continued on next page
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REPORT Prints a report for the selected trackable 
items.

HELP Displays help for the Item List dialog box.
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(��
�������� The Accum Tracking Extension - Item Maintenance dialog box enables you 
to add or edit a trackable item.

*����������	�
��
������1

Do you want to add or edit a trackable item?

�.���%�"�������

The Item Maintenance dialog box is displayed.

(=�.���,
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add an item click ADD.

edit an item select a trackable item from the Items to 
Track list, and click EDIT.
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The following table lists the parts of the Item Maintenance dialog box and 
their functions.

!

� =�������

Partner Displays the partner name of the selected 
partner.

Location Displays the location name of the selected 
location.

Item ID Contains the item identifier of the item you 
want to track. 

Note
This box is mandatory.

Description Consists of primary and secondary 
description boxes for the item, or a product 
description for the trackable item. 

Note
The secondary description box is not 
available if the �Use Secondary 
Description� check box is cleared on the 
Configuration dialog box.

Reference
For more information, see Using the 
Configuration Dialog box on page 9 - 12.

Count 1
Count 2

Displays the current accum counts for the 
selected or new trackable item.

Note
For a new trackable item, these boxes are set 
to zero if �Zero Counts on Add� is selected 
on the Configuration dialog box.

Reference
For more information, see Using the 
Configuration Dialog box on page 9 - 12.

Continued on next page
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UPDATE/EXIT ! Updates or adds the current trackable 
item.

! Closes the Item Maintenance dialog 
box.

UPDATE/NEW ! Updates or adds the current trackable 
item.

! Displays a blank Item Maintenance 
dialog box to enable you to add a new 
trackable item.

UPDATE/NEXT ! Updates or adds the current trackable 
item.

! Displays the next trackable item on the 
Item List dialog box.

CANCEL ! Discards any changes or additions.
! Closes the Item Maintenance dialog 

box.

DELETE ! Deletes the current trackable item.
! Closes the Item Maintenance dialog 

box.

HELP Displays help for the Item Maintenance 
dialog box.

!

� =�������
+ � �� ���������������������������������������������������������������������	
��
�
���
��	���������
�����	��



1"����� ������9�����7�����:���"��� *������
��

�+
����(��%
�������������7�2$�����9

(��
�������� Before you add a trackable item with the Accum Tracking Extension, you 
must first verify that the following are set up in the GENTRAN:Director 
Partner Editor:

! The partner relationship for which you need to track the item.
! A location table for the specific partner relationship location for which 

you need to track the item.

"�6�
����

!  For more information on creating partner relationships, See Creating a 
New Partner Definition on page 3 - 27.

! For more information on creating location tables, see Creating Partner 
Locations on page 3 - 85.

!
�����
� To add a trackable item, complete the following steps:

���� *�����

1 In the GENTRAN:Director program group, double-click the 
Accum icon.

System Response
The Partner List dialog box is displayed.

Continued on next page
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2 From the Trading Partners list, select the partner relationship 
for which you want to set up a trackable item.

3 Click LOCATIONS.

System Response
The Location List dialog box is displayed.

4 From the Partner Locations list, select the partner location 
where the tracked item is sent.

5 Click ITEMS TO TRACK.

System Response
The Items List dialog box is displayed.

Continued on next page
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6 Click ADD.

System Response
The Item Maintenance dialog box is displayed.

7 In the Item ID box, type the part number of the item you want 
to track.

8 Do the following:
! In the first Description box, type the primary product 

description for the item.
! In the second Description box, type the secondary product 

description for the item.

Note
The second Description box is not be available if the �Use 
Secondary Description� check box is cleared on the 
Configuration dialog box. For more information, see Using the 
Configuration Dialog box on page 9 - 12.

9 Do you need to add another trackable item for this location?
! If yes, click UPDATE/NEW, and repeat steps 7 - 9.
! If no, click UPDATE/EXIT and continue with step 10.

10 Click OK.

System Response 
The Item List dialog box is closed.

Continued on next page
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11 Click OK.

System Response
The Location List dialog box is closed.

12 Click EXIT.

System Response
The Accum Tracking Extension is closed.
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 This chapter provides an example of operational activities that may be 
executed as part of your daily processing. 

;���

This example may not be valid for your company.
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!
������6��, An example outbound process flow is listed in the following table:

��
�� $���
������

1 Do one of the following:
! Import a file from the Workspace.
! Create a document using the Document Editor.

Reference
!  For instructions on how to import a file, see Importing a 

Document on page 4 - 40.
! For instructions on creating a new document, see 

Creating a Document on page 4 - 3.

2 Post the compliant documents to Out Documents. 

Reference
For instructions on posting, see Posting a Document on page 
4 - 35.

3 Send selected, or all documents, to your trading partner. 

Reference
! For instructions on how to send selected documents, see 

Sending a Document on page 5 - 4.
! For instructions on how to send all documents, see 

Sending All Documents on page 5 - 7.

4 If you expect to receive acknowledgments for the sent 
documents, open the Interchanges and OutDrawer browsers 
from The Desk.

5 Review the documents you sent to make sure you received 
acknowledgments for all of them.

Note
Process control can automate some tasks. For more 
information, See �Controlling Your Processes� in the 
Administrator�s Guide.
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(��
�������� You can initiate inbound processing after sending documents using the 
outbound processing flow shown on the previous page, or by initiating a 
receive-only session.

"�6�
����

 For instructions on receiving documents, see Receiving a Document on page 
1 - 11.

!
������6��, An example inbound process flow for valid documents is listed in the 
following table:

��
�� $���
������

1 Do the following:
! From The Desk, select In Documents.
! Review the valid documents you received. These 

documents are shown with an �OK� status. 

2 Print using the associated print translation object, or
export the valid documents.

Note
Process control can automate some tasks.

Reference
!  For instructions on printing documents, see Printing a 

Document on page 4 - 31.
! For more information on exporting documents, see 

Exporting a Document on page 4 - 43.
! For more information, see �Controlling Your Processes� 

in the Administrator�s Guide.
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(��
�������� You can initiate inbound processing after sending documents using the 
outbound processing flow shown on page 10 - 3, or by initiating a
 receive-only session.

"�6�
����

For instructions on receiving documents, see Receiving a Document on 
page 5 - 14.

!
������6��, An example inbound process flow for invalid documents is listed in the 
following table:

��
�� $���
������

1 From The Desk, select ?In Documents.

Note
If the system cannot find an existing partner relationship for a 
document, the data will go to ?In Documents. The following 
are reasons this might occur:
! There is no partner. 
! There is a partner but no relationship is set up for this 

document.
! There is no template associated with the partner 

relationship.

Continued on next page
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2 Are the documents invalid due to an incorrect or missing 
partner, or a missing inbound relationship or translation 
object?
! If yes, you can set up a partner relationship (if necessary) 

and then attach the document to a partner relationship.
! If no, continue with stage 3.

Reference
! For instructions on creating a partner profile, see 

Creating a New Partner Definition on page 3 - 27. 
! For instructions on creating an inbound relationship or 

selecting translation objects, see Creating a New Inbound 
Relationship on page 3 - 30.

! For instructions on attaching an interchange to a partner 
relationship, see Attaching Interchanges to a Partner on 
page 6 - 13.

3 Once the documents are valid, you can do the following: 
! Print using the associated print translation object. 
! Export them. 

Note
Process control can automate some tasks.

Reference
! For instructions on printing documents, see Printing a 

Document on page 4 - 31.
! For more information on exporting documents, see 

Exporting a Document on page 4 - 43.
! For more information, see �Controlling Your Processes� 

in the Administrator�s Guide.
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(��
�������� The Transaction Data File (TDF) serves as a bridge between your 
application data and the GENTRAN:Director translator. For outbound 
processing, data is imported from a TDF (or application) file and translated 
to EDI format using a TDF Import translation object. The data is then ready 
to be posted and sent to your trading partner. 

For inbound processing, EDI documents that are received by 
GENTRAN:Director can be exported to a TDF-formatted file using a TDF 
Export translation object. This data file is then ready to be processed or 
converted to your internal application files.
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(��
�������� TDFs provide a simple method to integrate your application with the 
translation capabilities of GENTRAN:Director. Importing data from TDF, or 
application data files, is an alternative to using the Document Editor to enter 
data directly into the system without having to define your data file import 
maps. 

TDF is a flat file representation of the EDI standard document. Each EDI 
segment that is sent will be generated from a flat file record that corresponds 
to that segment. In order to use the TDF interface, you must reformat your 
application data into the standard TDF layout using an application program. 
In addition, you must have a TDF import translation object for the 
transaction set that will be imported, registered with the system.

����������

��� The information presented in the following sections relate to setting up your 
system to correctly import data from TDF files. If you have already set up 
this information in the system, proceed directly with the TDF 
(or Application) File Format procedure in this chapter.

The TDF layout and the TDF import translation object can be downloaded 
using the COMMERCE:Library facilities. Remember that once you 
download the translation object, it must be registered with 
GENTRAN:Director.

In addition, you must establish correct outbound relationships for all trading 
partners who will receive this data. During the process of establishing an 
outbound relationship, you should specify the name of the TDF translation 
object as the Import translation object for the outbound relationship.

The TDF file must contain a header record for every document in the input 
file. This header record is used by the system to determine what type of 
document is being translated and also identifies the trading partner. This 
header can be in one of two formats: Basic TDF Header Format or Extended 
TDF Header Format.

"�6�
����

For more information, see the �Registering (Installing) a New Translation 
Object� section in the Using Translation Objects chapter of this guide. For 
procedural information, see the �Creating a New Outbound Relationship� 
section in the Using Partners chapter.
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(��
�������� The limitation imposed on you if you choose to use the Basic TDF Header 
format is that you can only establish one outbound relationship per trading 
partner for each transaction set to be imported.

;���

This is the default format that is loaded for the product.

=����
"�4��
�%����

This format requires that the following fields are loaded correctly into the 
header record:

=���� $���
������

Transaction Set ID
Columns 1 through 6 (6 characters, 
left justified, space-filled)

This field should contain the Transaction Set ID of 
the document to be imported. The Transaction Set 
ID is defined in the TDF translation object and the 
information can be obtained by viewing the 
translation object.
Reference
For additional information, see the Using 
Translation Objects chapter in this guide. 

Record Tag
Columns 7 through 17 (11 
characters, zero-filled)

This field identifies the record as a TDF header 
record and should be filled with eleven zeroes 
(�0�).

Partner ID
Columns 57 through 71 (15 
characters, left justified, space-
filled)

This field is used to identify the trading partner. 
The value used in this field should correspond 
exactly with the value coded as the partner's 
Application Code in the Partner Editor (on the 
Partner Definition - New dialog box).
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(��
�������� The Extended format of the TDF Header record is not completely 
compatible with the Basic version, but it can easily be formatted with minor 
modifications from existing programs that create TDF files. This format 
allows you greater flexibility when establishing your outbound relationships 
because you have the ability to set up multiple outbound relationships for the 
same transaction set and the same trading partner. If you test a new version 
of a document with an existing trading partner, this header format can make 
that process much easier.

;���

If you are developing a new TDF interface program, we strongly suggest that 
you use the Extended TDF Header format.

=����
"�4��
�%����

This format requires that the following fields are loaded correctly into the 
header record:

=���� $���
������

Transaction Set ID
Columns 1 through 6 (6 characters, 
left justified, space-filled)

This field should contain the Transaction Set ID of 
the document to be imported. The Transaction Set 
ID is defined in the TDF translation object and the 
information can be obtained by viewing the 
translation object.
Reference
For additional information, see the Using 
Translation Objects chapter in this guide.

Record Tag
Columns 7 through 17 (11 
characters, zero-filled)

This field identifies the record as a TDF header 
record and should be filled with eleven zeroes 
(�0�).

Continued on next page
���������	
��
�
���
��	���������
�����	�� ��������� � � &



�������	��01��������$=�7�
��
�=�
%
�
Partner ID
Columns 57 through 71 (15 
characters, left justified, space-
filled)

This field is used to identify the trading partner. 
The value used in this field should correspond 
exactly with the value coded as the partner's 
Application Code in the Partner Editor (on the 
Partner Definition - New dialog box).

Version ID
Columns 114 through 125 (12 
characters, left justified, space-
filled)

This field is used to identify the EDI standard 
version of the document to be translated. This is 
defined in the TDF translation object. The 
information can be obtained by viewing the 
translation object.
Reference
For additional information, see the Using 
Translation Objects chapter in this guide.

Standard
Column 143 (1 character)

This field is used to identify the EDI standard of 
the document to be translated. This is defined in 
the TDF translation object. The information can be 
obtained by viewing the translation object.
Reference
For additional information, see the Using 
Translation Objects chapter in this guide.

Continued on next page

=���� $���
������
� � ' ��������� ���������	
��
�
���
��	���������
�����	��



�������	��01��������$=�7�
��
�=�
%
�
Test/Production Code
Column 189 (1 character)

This field is used to identify whether to select a test 
or production trading partner relationship for 
translation (selected by clicking the ADVANCED>> 
button on the Outbound Relationship dialog box). 
STOP
We suggest that you always use production 
outbound relationships unless you are otherwise 
instructed by customer support.
If you determine that you want to use the Extended 
TDF Header Format, all you have to do is register 
the extended System Import TDF translation 
object. This file is located in the translation objects 
directory as TDFHDRX.TPL. 
Reference
For information on registering translation objects, 
see the Using Translation Objects chapter in this 
guide.
STOP
Once the extended System Import TDF translation 
object (TDFHDRX.TPL) is registered, files 
containing the Basic TDF headers will not be 
processed correctly.
If the extended System Import TDF translation 
object was registered by mistake or you want to go 
back to using the Basic TDF header format, 
register the Basic System Import TDF translation 
object. This file is located in the translation objects 
directory as TDFHDR.TPL.
Reference
For information on registering translation objects, 
see the Using Translation Objects chapter in this 
guide.
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�5�
5��, GENTRAN:Director TDF Integration enables you to create an import or 
export translation object so that you can use TDF files with 
GENTRAN:Director. In addition, you can use TDF Integration to create a 
detailed report on the TDF layout of any EDI standard.

!
�����
� Use the following procedure to launch the GENTRAN:Director TDF 
Generator. For additional information, see your GENTRAN:Director TDF 
Integration Installation card.

���� *�����

1 From the GENTRAN:Director Programs sub-menu, select 
GENTRAN Director TDF Generator.
System Response
The GENTRAN:Director - TDF Integration dialog box is 
displayed. 

2 Click Next>.
System Response
You are prompted to determine whether you want to create a 
TDF translation object or a TDF Record Layout Report. 

3 Select the appropriate radio button, and click Next>. 
�.���%�"�������

The TDF Integration guides you through the creation 
process. 
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(��
�������� When the system is shipped, it is assumed that all of your imported files will 
be placed in the IMPORTS sub-directory and that all of the import formats 
will be TDF. If this is true for your company, continue with the TDF (or 
Application) File Import procedure later in this chapter.

Before you import a file, you must designate its file name and path, and 
associate that filename and path with a registered System Import translation 
object. To do this, you use the Imports tab of the GENTRAN:Director 
System Configuration dialog box. 

!
�����
� To associate an import file name and path with the registered translation 
object that you want to use during the import process, complete the 
following steps:. 

����
*�����

1 From the GENTRAN:Director program group, select 
GENTRAN:Director Configuration.
System Response
The System Configuration dialog box is displayed. 

2 Select the Imports tab.
System Response
The Imports tab is displayed. 

3 In the File Path text box, enter the 
drive:\directory\subdirectory\file name of the file that you 
want to import, or click BROWSE to search for the file. 
Note
The default TDF setting is *.TDF and the default translation 
object is System Import TDF. If you enter a filename, 
wildcards may be used. Paths must use mapped drive 
letters; UNC paths are not valid. 

Continued on next page
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4 Do the following:
! Select a translation object from the Translation Objects 

drop-down list.
! Click OK. 

System Response
The file is associated with the translation object that will be 
used during the import process.
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!
�����
� To import a TDF (or application) file, complete the following steps.

����
*�����

1 From The Desk, select WorkSpace.
System Response
The WorkSpace dialog box is displayed. 

2 Click IMPORT.
System Response
! The Application Files to Import dialog box is displayed.
! The system imports the documents into the WorkSpace. 

The document(s) either have an �OK� status indicating 
that the document(s) were successfully read and 
compliance checked or, �Not OK� indicating the 
document(s) failed compliance checking. You may not 
send non-compliant documents. Either delete those 
documents and re-process them from the TDF (or 
application data file), or correct the documents in the 
Document Editor if you have Data Entry translation 
objects for them.

Reference
For more information on correcting the documents in the 
Document Editor, see the Using Documents chapter in this 
guide. 

3 Select the file or files to be imported and click OK.
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(��
�������� To export data to a TDF (or application) file, an Export translation object for 
the transaction set must be loaded into the system, registered, and set up as 
the Export translation object. 

"�6�
����

For information on translation object registration, see the Using Translation 
Objects chapter in this guide.

!
�����
� To export information to a TDF (or application) file, complete the following 
steps:

���� *�����

1 From The Desk, select the In Documents, ?In Documents, 
or InDrawer.
System Response
A dialog box is displayed. 

Continued on next page
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2 Do the following:
! Select the document or documents that are to be 

exported. To highlight a group of documents, click the 
first document, press SHIFT, and click the last 
document. To highlight several documents that are not 
adjacent to each other, press and hold CTRL while 
clicking each document.

! Click EXPORT.

System Response
The Select Export Method dialog box is displayed.
Valid options are:
! Export to Single File - all the documents selected will 

be converted to TDF (if TDF files) or converted to data 
(if application data files), and written to a single file.

! Export to Default Files - the documents will be written 
to the files designated in the partner inbound 
relationship.

! Select File by Document - the system prompts you for 
the new file names.
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 A

F(��$���%���� A browser containing a list of documents received by the system but that 
failed compliance checking, or that do not have an identifiable partner or 
transaction set.

F����$���%���� A browser containing a list of documents that were imported into the system 
but are invalid.


�+��,����%��� The term used to indicate the ANSI 997 functional acknowledgment, the 
EDIA 999 acceptance/rejection advice, and the EDIFACT CNTRL.


�+ A function that enables you to manually change the status of documents in 
the Out Drawer to �Ack�d� (acknowledged).

*(*� Automotive Industry Action Group.The standards-setting group for the 
automotive industry. The standards form a subset of the ANSI X12 standard. 

*;* Article Numbering Association.

*;�( American National Standards Institute. ANSI sets standards for many 
products and services, such as safety glasses and battery capacities. The 
ANSI X12 committee is the chief EDI standards-setting organization for the 
United States.


�����
������.���% Computer systems, outside of EDI, designed to fulfill specific business 
functions. Some of these include accounting, purchasing, materials control, 
human resources, and shipping.


�������� A function that enables you to view system audit log information.

�
�,��
 A window that displays a list of items, such as documents (transaction sets), 
interchanges, or translation objects. A document browser displays only 
documents.
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����+ Term indicating that you should position your cursor on top of the 
designated item and press and release your primary mouse button. The 
primary mouse button is the button you access with your index finger, 
regardless of whether you are utilizing right-handed or left-handed mouse 
operation.

��%%����
�����

�������

Everything sent and received to/from one telephone number in one 
continuous period of connection. This could include sending two or three 
interchange envelopes to a network, each for a different trading partner.

��%%����
��
 The GENTRAN:Director communications software. The Communicator 
enables you to send, receive, resend, establish communication port 
definitions, establish communication profiles, establish communication 
scripts, and view and delete communication sessions.

��%���
�� Term indicating that the document conforms to the EDI standards as defined 
by the translation object.

��%��������
�


���%���

A simple data element that belongs to a composite data element. Component 
data elements are also called sub-elements.

��%��������
�


���%���

A data element that is made up of multiple component elements.

���. A function that enables you to copy one or more documents from the Out 
Drawer to the Workspace.

�
�
�5��,�,����,� The following are data-view windows in the GENTRAN:Director: Audit 
Log, Document Tracking, Interchange Tracking, raw data-view of an 
interchange, raw data-view of a document.

��6
��� A predefined value � programs use these built-in values unless you 
specifically override them.
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$��+D��	� A graphic representation of the GENTRAN:Director that provides you with 
a quick and easy way to access some of its most commonly used browsers, 
functions, and subsystems. You can click the appropriate part of The Desk 
any time you need to access a browser, function, or subsystem represented 
there. The browsers you can access are In Documents, ?In Documents, 
Workspace, Out Documents, ?Out Documents, Interchanges, In Drawer, and 
Out Drawer. Each browser icon displays a graphic representation of paper if 
the document location contains documents. The Desk also allows you to 
access the Partner Editor subsystem, the Help system, the Process Control 
function (clock icon), and the Send/Receive functions (phone icon). It also 
allows you to quit GENTRAN:Director (EXIT/door icon).

You can turn the display of The Desk off by clicking The Desk on the View 
menu. This toggles the display of The Desk �on� and �off.� A checkmark 
next to that item means it is �on.�

��
������1� A dialog box (or dialog) containing additional information or options that 
you need to act on. If you specify any options, you can select a button to 
execute the command. Some dialog boxes display warnings or messages 
indicating why a requested task cannot be accomplished. If the dialog box 
has a title bar, you can move it to another location on your desktop.

To close a dialog box, double-click the Control menu box or select Close 
Active Window from the File menu.

����%��� One transaction set containing actual data and treated as a single entity. The 
amount of data does not affect whether something is a document or not, only 
the fact that it is treated as a single entity. For example, regardless of whether 
a purchase order contains one item or ten thousand, if it is one purchase 
order, it is one document.

If a trading partner sends you a communication containing 10 purchase 
orders, you have received 10 documents. If the communication contained 15 
invoices, you have received 15 documents.

�����������+ This indicates that you should position your cursor on top of the designated 
item and quickly press and release your primary mouse button twice. The 
primary mouse button is the button you access with your index finger, 
regardless of whether you are utilizing right-handed or left-handed mouse 
operation.

0*;* International Article Numbering Association, Brussels, Belgium.
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0$( Electronic Data Interchange. The process by which companies can exchange 
business documents directly from application to application by computer, 
without paper documents being produced.

0$(���
��

� The rules, or standard, for turning a business document into an EDI 
document.

0$(* The Electronic Data Interchange Association, formerly known as the 
Transportation Data Coordinating Committee (TDCC). 

0$(=*�� Electronic Data Interchange for Administration, Commerce, and Transport.

���%��� The smallest piece of usable information defined by the standards. Examples 
might include a quantity, unit price, or description.

An individual element can have somewhat different meanings depending on 
context. Therefore, elements are normally not considered to have useful 
meaning until they are combined into segments.

The three types of data elements are illustrated in the following table:

��5����� A way of separating information in transmissions for ease of processing. 
Each envelope contains a header segment and a trailer segment, which 
separate the envelope from other envelopes and provide information about 
the contents of the envelope.

The three levels of envelopes are illustrated in the following table:

$
�
�0��%��� $�6�������

Simple data element A single piece of information defined by the 
standards.

Composite data 
element

A data element that is made up of multiple 
component elements.

Component data 
element

A simple data element that belongs to a 
composite data element. Component data 
elements are also called sub-elements.

0�5����� $�6�������

Transaction Set Each transaction set, or business document, is 
contained within a transaction set envelope.

Continued on next page
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�1��
� A function that enables you to write a document or documents to an external 
file for processing by another application. There must be a system export 
translation object for the document or a partner-specific export translation 
object for the document.

6��� A function that enables you to find specified text in the active data-view 
window.

6�������
���
��� A group of transaction sets that the standards-setting body, such as ANSI, 
has defined as fitting together with other related transaction sets. An 
example might be a Functional Group defined as containing all purchasing 
transaction sets.

�%��
� A command that enables you to import data from an external application file. 
Depending on the content of the file, the system may prompt you for partner, 
transaction, or translation object information.

(��$���%���� A browser containing a list of documents that the system received, but that 
have not yet been processed by the user. Once the documents are processed, 
meaning printed or exported, they are transferred to the In Drawer.

Functional Group An envelope containing related business 
documents. The standards define which 
transaction sets should be placed together into a 
functional group envelope.

Interchange 
Envelope

All material being sent to one trading partner in 
one communication. Interchange Envelope is the 
term used by ANSI. EDIA uses the term 
Transmission Envelope to refer to this level of 
envelope. Since we use the term transmission for 
other uses, we refer to Interchange Envelope 
only.

Note
A communications session could easily include a 
number of interchange envelopes. For this 
reason, the standards-setting bodies are 
considering a fourth level of envelope to cover an 
entire communications session.

0�5����� $�6�������
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(��$

,�
 A browser containing a list of documents that were received and processed.

����
�	
��� Contains all the functional groups of documents, or transaction sets, sent 
from one sender to one receiver in the same transmission.

(���
�	
����

�
�,��
 A browser that enables you to view a hierarchical list of all the interchanges 
that were sent or received. The Interchanges browser can always be 
accessed. It contains status information about the interchanges, such as 
whether or not a functional acknowledgment was received and the status of 
that acknowledgment. This browser also enables you to access the 
documents within the interchanges. 

�
��� Descriptions of information. They can be almost anything on a translation 
object that is not an element, a keyword title, or an information indicator. 
They can also be things used as information dividers, such as a line of 
dashes.

%��� A list of items from which you can choose. Each item represents a 
command. Unavailable items on a menu are dimmed to inform you they are 
disabled.

%�����

 Contains the list of menus for the application.

%�5� A function that enables you to move a document or group of documents 
either from the In Documents or ?In Documents to the In Drawer or from the 
?Out Documents to the Workspace.

���,�
+ A service, such as COMMERCE:Network, that accepts and holds 
transmissions from companies until it is convenient for a trading partner to 
accept them. It is also known as a Third Party Network or Value-Added 
Network (VAN). 

�$0��0 The Organization for Data Exchange by Tele-Transmission in Europe.

����$���%���� A browser that contains a list of documents ready to be sent. After the 
documents are successfully sent, they are automatically transferred to the 
Out Drawer.

����$

,�
 A browser that contains a list of documents that were successfully sent out 
by the system.
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�

���
 Another firm with which your company trades documents. Also referred to 
as a trading partner.

!

���
�0����
 A function that enables you to define, edit, and delete all partner information 
for your company and all of your trading partners.

���� A function that enables you to move compliant documents from the 
Workspace to the Out Documents.

�
���6���� A default value for a particular element on a data entry translation object. 
You can change the value as necessary.

�
��� A command that enables you to print an unformatted or formatted version of 
the selected documents using the print translation object set up in the partner 
relationship for those documents, or print a summary list of the documents.

�
������ The result of data received from a trading partner passing through a print 
translation object. You do not have to actually print the data. The printout 
could be to a file on your hard disk.


����5� A function that enables you to manually initiate a communications session to 
receive data from your trading partner.


������ A function that enables you to create a turnaround document, using the Turn 
Around translation object in the partner relationship, in response to one or 
more selected documents in the In Drawer.


�����������
����. An organization that develops and updates standards for EDI 
communications. These organizations include ANSI, EDIA, AIAG, UCS, 
and VICS.

���%���� A number of elements combined to communicate useful data. For example, a 
catalog price segment might consist of elements for item description, 
volume, price, and lead time. By themselves, none of these elements would 
communicate useful information. Together, they provide the information 
necessary for someone to tell if the item is what they want, or whether the 
price is reasonable. Segments are defined by the EDI standards. A number of 
segments together form a transaction set.
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.
���� A function that enables you to manually start a communications session to 
send data to your trading partner. Only selected documents are enveloped 
and sent. If no documents are selected, ALL documents are sent. 
Successfully sent documents are moved to the Out Drawer.

�����C���� A function that enables you to display a list documents currently queued to 
be sent.

��� See Transaction Set.

��
� A function that enables you to sort the list of documents in a document 
browser into one of the following sequences: partner/type/name, partner/
name/type, or type/partner/name.
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.
��
��� A document�s or interchange�s processing stage, indicated in the �Status� 
box. Refer to the following table for additional status information. 

. 

?In Documents

NotOK
All documents in the ?In Documents have this 
status. This code indicates one of the 
following:
! The document failed to comply with the 

EDI standard. If this is the cause of the 
error, the errors are indicated on a 
translator report associated with the 
document. Despite the fact that the 
document is not fully compliant, it is 
eligible for further processing.

! The received document could not be 
associated with a specific trading partner. 
If this is the case, the partner listed for the 
document in question is �Unknown.� To 
associate this document and the other 
documents received in the interchange 
with a partner, attach the documents from 
the Interchanges browser.

! A suitable trading relationship or 
translation object could not be associated 
with the document. Detailed information 
concerning what information was used to 
locate the relationship and/or the 
translation object is listed in the audit log. 
To correct this problem, a valid 
relationship must be established using the 
Partner Editor and a valid export, print, or 
turn around translation object must be 
defined for that relationship.

Continued on next page
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! A major error occurred while processing 
the interchange, functional group, or 
transaction level enveloping structures. 
This error may include header and trailer 
control numbers that do not match, an 
invalid trailer control count, or a control 
number sequence checking error. If any 
of these errors occur, they are listed on 
the translator report for the interchange 
containing the documents.

?Out Documents

NotOK
This code indicates that the document does 
not comply with the EDI standard definition. 
The errors that are causing the compliance 
failure can be determined by viewing the 
translator report for the document.

In Documents

OK
All documents in the In Documents have a 
status of �OK.� These documents are fully 
compliant and are eligible for further 
processing.

In Drawer

OK
This code indicates that the documents are 
fully compliant with the EDI standard and are 
eligible for further processing.

Continued on next page
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NotOK
This code indicates one of the following:
! The document failed to comply with the 

EDI standard. If this is the cause of the 
error, the errors are indicated on a 
translator report associated with the 
document. Despite the fact that the 
document is not fully compliant it is 
eligible for further processing.

! The received document could not be 
associated with a specific trading partner. 
If this is the case, the partner listed for the 
document in question is �Unknown.� To 
associate this document, and the other 
documents received in the interchange 
with a partner, attach the documents from 
the Interchanges browser.

! A suitable trading relationship or 
translation object could not be associated 
with the document. Detailed information 
concerning what information was used to 
locate the relationship and/or the 
translation object is listed in the audit log. 
To correct this problem, a valid 
relationship must be established using the 
Partner Editor and a valid export, print, or 
turn around translation object must be 
defined for that relationship.

! A major error occurred while processing 
the interchange, functional group, or 
transaction level enveloping structures. 
This error may include header and trailer 
control numbers that do not match, an 
invalid trailer control count, or a control 
number sequence checking error. If any 
of these errors occur, they are listed on 
the translator report for the interchange 
containing the documents.

Continued on next page
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Interchanges The Interchanges browser contains graphics 
that represent the interchange process status, 
interchange network status, interchange, 
group, document acknowledgment status, and 
document compliance status. When you 
highlight an entry in the Interchanges 
browser, an explanation of the status codes 
for that line is displayed in the 
GENTRAN:Director status bar.

Interchange Process Status

Received   
Indicates that the interchange was received by 
the system

 
Sent 
 Indicates that the interchange was 
successfully transmitted to the appropriate 
partner.

Ready to Send 
Indicates that an attempt was made to send 
this interchange, but the communication 
session was not successful. This interchange 
is sent during the next appropriate 
communication session.

Queued 
Indicates that the document is queued to send.

Hold  Indicates that the document is on 
�hold,� i.e., is not sent.

Continued on next page
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Overdue 
Indicates that the interchange is waiting to be 
reconciled with an inbound functional 
acknowledgment but has exceeded the 
number of hours by which that 
acknowledgment is deemed late.

Send Failed 
 Indicates that the send attempt failed due to 
an error during the communications process.
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Interchange Network Status

On Network 
Blue dish indicates that the interchange was 
successfully delivered to a value-added 
network. (To obtain this status using 
COMMERCE:Network you must have your 
mailbox configured to receive the 20 report in 
data format).

Network Warning 
Yellow dish indicates that the interchange was 
delivered to a value-added network and the 
network detected non-critical errors in the 
data. The data is available to be picked up by 
the designated trading partner. (To obtain this 
status using COMMERCE:Network you must 
have your mailbox configured to receive the 
20 report in data format).

Network Error 
Red dish indicates that the interchange was 
delivered to a value-added network and the 
network detected critical errors in the data. 
The data is not available to be picked up by 
the designated trading partner. (To obtain this 
status using COMMERCE:Network you must 
have your mailbox configured to receive the 
20 report in data format).

Picked Up 
Green dish indicates that the interchange was 
successfully delivered to a trading partner via 
a value-added network. (To obtain this status 
using COMMERCE:Network you must have 
your mailbox configured to receive the 70 
report in data format).

Continued on next page
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Transmitted to third-party network Black 
dish indicates that the interchange was 
transmitted to a third-party network.

Interchange, Group, and Document 
Acknowledgment Status

Waiting  Indicates that the interchange is 
waiting to be reconciled with an inbound 
functional acknowledgment.

Overdue  Indicates that the interchange is 
waiting to be reconciled with an inbound 
functional acknowledgment but has exceeded 
the number of hours by which that 
acknowledgment is deemed late.

Rejected  Indicates that the interchange was 
acknowledged by your partner and there were 
errors. The interchange was rejected by your 
partner.

Acknowledged  Indicates that the 
interchange was acknowledged by your 
partner and there were no errors.

Acknowledged with Errors  Indicates that 
the interchange was acknowledged by your 
partner and there were errors. It was accepted 
by your partner in spite of the errors.

Partially Acknowledged  Indicates that the 
interchange was successfully received by the 
trading partner and some of the documents 
within the interchange were accepted or 
accepted with errors and other documents 
within the interchange were rejected.

Continued on next page
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Document Compliance Status

OK  
This code indicates that the documents are 
fully compliant with the EDI standard and are 
eligible for further processing.

NotOK  
Red �thumbs down� indicates that this code 
indicates one of the following:
! The document failed to comply with the 

EDI standard. If this is the cause of the 
error, the errors are indicated on a 
translator report associated with the 
document. Despite the fact that the 
document is not fully compliant it is 
eligible for further processing.

! The received document could not be 
associated with a specific trading partner. 
If this is the case, the partner listed for the 
document in question is �Unknown.� To 
associate this document, and the other 
documents received in the interchange 
with a partner, attach the documents from 
the Interchange browser.

! A suitable trading relationship or 
translation object could not be associated 
with the document. Detailed information 
concerning what information was used to 
locate the relationship and/or the 
translation object is listed in the audit log. 
To correct this problem, a valid 
relationship must be established using the 
Partner Editor and a valid export, print, or 
turn-around translation object must be 
defined for that relationship.

Continued on next page
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! A major error occurred while processing 
the interchange, functional group, or 
transaction level enveloping structures. 
This error may include header and trailer 
control numbers that do not match, an 
invalid trailer control count, or a control 
number sequence checking error. If any 
of these errors occur, they are listed on 
the translator report for the interchange 
containing the document.

Duplicate
Yellow �thumbs down� indicates that the 
document has the same name as another 
document on the system.

Out Documents

OK
This code indicates that the document is fully 
compliant with the EDI standard. Documents 
with this status can be sent.

Out Drawer

Sent
This code indicates that the document was 
successfully transmitted to the appropriate 
partner.

Waiting
This code indicates that the document is 
waiting to be reconciled with an inbound 
functional acknowledgment.

Overdue
This code indicates that the document is 
waiting to be reconciled with an inbound 
functional acknowledgment, but has exceeded 
the number of hours by which that 
acknowledgment is deemed late.

Continued on next page
���������	
��
�
���
��	���������
�����	����������� � � �)



�����

.
Ack�d
This code indicates that the document was 
acknowledged by your partner and there were 
no errors.

AckErr
This code indicates that the document was 
acknowledged by your partner and there were 
errors, but it was accepted by your partner in 
spite of the errors.

Reject
This code indicates that the document was 
acknowledged by your partner and there were 
errors. The document was rejected by your 
partner.

~Ack
This status is only displayed if there were no 
acknowledgments expected for this document 
and either the group or the interchange was 
partially acknowledged. If your partner is 
going to issue partial acknowledgments at the 
interchange or group level, he/she should also 
indicate acceptance or rejection at the 
transaction level.

OnNet
This code indicates that the document was 
successfully delivered to a value-added 
network. To obtain this status using 
COMMERCE:Network, you must have your 
mailbox configured to receive the 20 report in 
data format.

PickedUp
This code indicates that the document was 
successfully delivered to a trading partner via 
a value-added network. To obtain this status 
using COMMERCE:Network, you must have 
your mailbox configured to receive the 70 
report in data format.

Continued on next page
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NetWarn
This code indicates that the document was 
delivered to a value-added network and the 
network detected non-critical errors in the 
data. The data is available to be picked up by 
the designated trading partner. To obtain this 
status using COMMERCE:Network, you 
must have your mailbox configured to receive 
the 20 report in data format.

NetErr
This code indicates that the document was 
delivered to a value-added network and the 
network detected critical errors in the data. 
The data is not available to be picked up by 
the designated trading partner. To obtain this 
status using COMMERCE:Network, you 
must have your mailbox configured to receive 
the 20 report in data format.

Send Queue

Queued
This code indicates that the document was 
successfully interchanged in preparation for 
sending, but the interchange was not 
transferred correctly to your partner. The 
interchange is automatically sent in the next 
communication session with this partner.

Ready to Send
Indicates that a document is ready to send but 
a mailbox message has not yet been created 
for the data.

Send Failed
Indicates that the send attempt failed due to 
an error during the communications process.

Continued on next page
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 The status bar of an application window defines information about a 
selection, command, or process. It also defines Menu Bar items as the user 
highlights each item, and indicates any current keyboard-initiated modes for 
typing. For example, CAP for the �Caps Lock� key or NUM for the �Num 
Lock� key.

�$�� See EDIA.

�

���
����������� A predesigned layout set up to ensure that input or output for a particular 
transaction set exists and is presented in a usable fashion. You must specify 
which translation objects are used by each partner relationship.
Inbound Translation Objects:
Turn Around: A translation object used when a document is received, to 
create the natural response document that contains as many elements from 
the received document as possible.
Export File: A translation object that indicates when a document is 
received, it is exported to a specified file format.
Print: A translation object used to print documents.
Outbound Translation Objects:
Import: A translation object used to import data from an application file.
Print: A translation object used to print documents.
Data Entry: A translation object used to enter data into the Document 
Editor facility.

�	�
���

�.����,�
+ See Network.

�������

 Part of an application window containing the name of the application and 
enables you to move the window to another position on your desktop.

Workspace

OK
A code indicating that the document is fully 
compliant with the EDI standard. Documents 
with this status can be posted to the Out 
Documents and sent.

NotOK
A code indicating that the document does not 
comply with the EDI standard definition. You 
can determine the errors that are causing the 
compliance failure by viewing the translator 
report for the document.
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 Contains buttons that graphically represent commands available in the Menu 
Bar. This function displays tracking information for a single selected 
document.

�

�+ Function that displays tracking information for a single selected document.

�"*$*�� � The U. K. standards for EDI that are published by the Article Numbering 
Association (UK) LTD. 

�

������

���
 Another firm with which your company trades documents. Also referred to 
as a partner.

�

��
���������

>����%���?

A business form as defined by the standards. Examples include an ANSI 850 
purchase order or a UCS 880 invoice. The standards define each transaction 
set in terms of the segments and elements that make up the form, the order in 
which they appear, and the relationships among them. This is also known as 
�message� in Europe.

�

��%������ See Communications Session.

�

��%��������	
�� A path an EDI communication could follow, including one company, one 
trading partner, and one or more network services.

��
�

���������%��� A document into which data elements from the source document have been 
automatically transferred using a turnaround map.

��
�

�����%
� A series of instructions that the system uses to create a turnaround document 
(a logical response document to the source) from an inbound (source) 
document, by transferring data from the source document to elements in the 
target document (translation object).

��� Uniform Communications Standard. The standard used by the grocery 
industry.

��!��� This function enables you to move a document previously posted to the Out 
Documents back to the Workspace for further processing.

5�
���� Each standards-setting body updates its standards on a regular basis. Each 
formal update is referred to as a version.

5��, For documents, this function enables you to display the raw EDI data, a 
formatted document using a translation object, or a translator report, 
depending on the format selected. For interchanges, this function enables 
you to display the raw EDI data or a translator report, depending on the 
format selected.
���������	
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�
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�����	����������� � � ��



�����

.
:(�� The Voluntary Inter-industry Communication Standards is the standards-
setting body for the retail industry, a subset of ANSI X12.

2�
+��
�� The Workspace contains a list of outbound �Work in Progress� documents. It 
also contains recently imported or data entry documents.

E�� The ANSI committee that sets and publishes standards for EDI.
� � �� ��������� ���������	
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�
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import G-5
importing

data from TDF files A-3
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